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Preface 

This manual describes the HiCommand® Tuning Manager GUI operations on a client. In this 
manual, HiCommand Tuning Manager is abbreviated to Tuning Manager. 

For details on how to install and set up the software on a server, see the HiCommand Tuning 
Manager Installation Guide. For details on how to install and set up the software on a client, 
see the manual corresponding to the Agent. 

For details on how to manage the software on a server, see the HiCommand Tuning Manager 
Server Administration Guide. 

This manual is intended for the following users: 

� System administrators 

� Storage administrators 

� Application developers 

� System integrators 

� Technology consultants 

� System architects and capacity planners who rely on HiCommand Tuning Manager reports 
and forecasts 

Software Version 

This document revision applies to HiCommand Tuning Manager version 5.5. 

Conventions for Storage Capacity Values 

Storage capacity values displayed by HiCommand Tuning Manager are calculated based on the 
following values: 

1 KB (kilobyte) = 1,024 bytes 
1 MB (megabyte) = 1,0242 bytes 
1 GB (gigabyte) = 1,0243 bytes 
1 TB (terabyte) = 1,0244 bytes 
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2  Chapter 1 Overview of Tuning Manager 

1.1 Managing Networked Storage 

Today’s complex IT environments often include dozens or even hundreds of application and 
database servers and various operating systems connected to terabytes of data, which reside 
on several classes (or tiers) of storage systems. Often the servers and storage are located on 
one or more storage area networks (SANs) connected by SAN switches and/or storage directors 
with hundreds of interconnected switch ports.  

HiCommand Tuning Manager is a real-time software monitor that can view the current state of 
all the host, file system, database, SAN, and storage resources that are being used by an 
application. It lets you contrast data about the monitored resources with an historical view of 
the normal, baseline performance of those resources that were previously stored in the Tuning 
Manager database. The ability to query a historical database for performance and capacity 
trend analysis on each component of the SAN enables you to easily correlate the current 
changes in performance with recent changes to the physical configuration, software, workload, 
or other environmental changes that may be causing changes in an application’s performance. 

The goal of every IT organization is to detect and resolve potential problems before they occur. 
Tuning Manager also enables you to define and continuously monitor and store critical 
performance and capacity thresholds, and send a warning to the proper persons to alert them 
of potential problems before they occur.  

Note: In Tuning Manager, the word “resource” indicates any object monitored by Tuning 
Manager, and the term “metric” indicates any monitored performance or capacity data item. 
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1.2 Tuning Manager Software 

Tuning Manager software is a solution that monitors, reports, and forecasts storage 
performance and capacity in the context of the entire storage network, including hosts, file 
systems, database applications, SAN switches, and the internal disk storage components of all 
tiers of storage systems. Tuning Manager periodically discovers the capacity and performance 
of storage devices, file systems, hosts, databases and network attached storage (NAS) devices. 
It then consolidates, analyzes, and reports on current performance, capacity, utilization, 
historical and future usage trends, and notifies you of any predetermined threshold violations. 
Tuning Manager provides the information you need to make informed decisions and more 
efficiently operate your storage environment while taking the guesswork out of planning and 
budgeting for future growth. Tuning Manager reports, charts, and other metrics help you to: 

� Replace risky guesswork with fact-based decisions 

� Identify all storage systems on the network and their current performance, capacity, and 
utilization 

� Determine how many and what kind of servers exist on your whole network and its 
subnetworks, and the storage they are consuming 

� Determine which storage systems are either under- or over-utilized or under- or 
over-allocated 

� Quantify file systems total capacity, amount used, and amount remaining 

� Detect and prevent capacity shortages with proactive alerts when critical thresholds are 
violated 

� Detect and prevent potential performance bottlenecks with alerts when predetermined 
thresholds are violated 

� Isolate the root cause of application response time problems by monitoring and reporting 
the performance of all components in the path from the host and database application to 
the disk parity group 

� Determine when to acquire additional storage capacity 

� Understand the relationship between the host's file systems, logical devices, and 
corresponding physical storage components 

� Understand the RAID configuration of the storage system associated with a host's file 
systems 
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Tuning Manager collects performance data from the operating systems installed on the servers 
and databases (such as Oracle®) connected to a SAN, as well as from storage subsystems. 
Tuning Manager enables you to display the collected performance data as described below, 
enabling you to easily manage the performance and configuration for each resource in a SAN 
environment: 

� Relate file systems and database tables to ports on the storage subsystems and logical 
devices, and display them collectively (Figure 1.1). 

� Display the performance and capacity summary information as well as reports generated 
from Main Console for the units selected in the tree-like structure (Figure 1.2). 

 

Figure 1.1 Displaying Ports, Disk Subsystems, LUNs, and LDEVs of Databases and File Systems 
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Figure 1.2 The Tuning Manager Resource Tree with Ports Selected 
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1.3 The Tuning Manager System Configuration 

Tuning Manager is actually a series of software components working together to monitor an 
entire network and collect performance data from the various systems. The Tuning Manager 
series consists of Agents that collect the performance data for each monitored resource and 
the Tuning Manager program that manages all the Agents. Figure 1.3 shows an example of the 
system configuration.  

 

Figure 1.3 Example Tuning Manager System Configuration 
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Note: This is one possible configuration. In the simplest configuration, Agent for RAID and the 
Tuning Manager Agents (other than the Agents for databases) can all be installed and running 
on the Tuning Manager server machine. An Agent for a database must always be installed and 
running on the same machine as the database to be monitored. 

The following illustration shows how the different components of Tuning Manager work 
together to collect data. 

 

Figure 1.4 Data Collection Overview 

The Tuning Manager program uses the internal component Collection Manager to accumulate 
the performance data collected from each Agent and uses Main Console and Performance 
Reporter to display data. The role of each component can be summarized as follows:  

Collection Manager. Collection Manager runs in the background on the Tuning Manager server 
and manages the Tuning Manager products and manipulates performance data so that the 
programs function correctly as a comprehensive system. 

Main Console. Collection Manager stores the hourly average value of the performance data 
collected by the Agents in the central repository of Tuning Manager. Main Console displays the 
data accumulated in the central repository as a report according to the specified time frame 
and interval. The Tuning Manager central repository is managed by the relational database 
system HiRDB. 

Main Console displays links to Performance Reporter. 
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Performance Reporter. Performance Reporter displays performance data collected directly 
from the Store databases of each Agent and also provides a simple menu-driven method to 
develop your own custom reports. Performance Reporter reports the performance data 
collected by a specific agent and enables you to display agent-instance level reports and 
customized reports with a simple mouse click. Performance Reporter can analyze and report 
real-time or very recently collected data that is still resident in the local agent’s data store, or 
it can report any past time period by querying the Store databases for historical information. 
Performance Reporter does not connect to HiRDB. 

Agents. Agents run in the background and collect and record performance data. There must be 
a separate Agent for each unit, which includes each platform, application program, and 
database monitored by Tuning Manager. The Tuning Manager agents continually gather 
hundreds of performance metrics and store them in their local database for instant recall if 
needed. Agents enable the Tuning Manager program to collect the performance data of 
monitored objects. The collected data is used to display information about the entire SAN 
environment within Main Console and information about specific resources in Performance 
Reporter. An Agent collects the performance data from a monitored OS, database (such as 
Oracle), or storage subsystem, and stores the performance data into the databases. The 
databases are called Store databases, and each Agent manages a Store database. Collection 
Manager accumulates all the Agent Store database metrics hourly and stores those metrics in 
the central repository of the Tuning Manager program.  

The following lists the different kinds of Agents and their functions: 

Agent for RAID. Collects performance data and configuration information of storage 
subsystems. 

HTM Agent. HTM Agent consists of the following components: 

� Agent for RAID Map. Maps the relation between the servers and storage and collects 
configuration information about the host's file system and the corresponding storage 
subsystem’s resources. 

� Agent for Platform (Windows®, UNIX®). Collects performance data of servers, such as the 
operating status of the OS. 

� Agent for Microsoft® Exchange Server. Collects performance data, such as the message 
transfer status of Exchange Server and the status of sent and received data. 

Agent for SAN Switch. Collects performance data for switches. 

Agent for Network Attached Storage. Collects performance data and configuration 
information about the NAS system. 

Agent for Oracle. Collects performance data of Oracle databases.  

Agent for Microsoft SQL Server. Collects performance data of Microsoft SQL Server databases.  

Agent for DB2®. Collects performance data of DB2 databases. 

Note: A single Tuning Manager program can manage up to 200 Agents, so preparing multiple 
Tuning Manager hosts enables administrators to distribute the Agent-management workload. 
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1.3.1 Distributed Metrics-Repository Architecture 

Tuning Manager has the capability to manage the large-scale infrastructures of storage 
environments because Tuning Manager has a distributed metrics-repository architecture 
consisting of HiRDB for trend-analysis, alerting, and forecasting, and distributed Store 
databases for troubleshooting and deeper analysis. HiRDB stores information about resources, 
summarized metrics, and correlation information. The Store databases store detailed metrics. 

Tuning Manager has two viewers; Main Console, which allows you to view data retrieved from 
HiRDB, and Performance Reporter, which allows you to view real-time data and data retrieved 
from each Store database. The features of each viewer and corresponding database are 
described below.  

1.3.2 Main Console  

Main Console allows you to view data retrieved from the central repository of Tuning Manager 
to effectively find out where a performance bottleneck lies. The main information displayed 
by Main Console is as follows: 

� Performance summaries for each resource (the latest 1 hour average only) 

� Comparisons of performance among resources 

� List of connected resources (correlation between resources) 

� Resource tree (hierarchy) 

� Resource properties 

� Major metrics 

� Direct links to resources 

Main Console is resource-focused (managed-object focused) and helps you find out target 
resources and metrics. Reports and features of reports displayed by Main Console are as 
follows: 

� Summary reports and reports summarizing multiple resources (View of the entire system, 
display of a system overview, comparison analysis, and display of trends) 

� One-click report display by clicking a resource or link 

� Display of the data stored in HiRDB  

� Definition of metrics views, view formats, and time ranges of the data to be displayed is 
not required 

� Display of single records (the range can be specified). You can select from the latest one 
hour, the previous day, previous month, or the previous year.  

� Reports of trends for a single period (latest 1 hour, previous day, previous month, and 
previous year) 
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1.3.3 Performance Reporter 

Performance Reporter allows you to view data retrieved from each Store database to analyze 
resources deeply and in detail. The main information displayed by Performance Reporter is as 
follows:  

� Detailed metrics (e.g. minutely) collected in agents 

� All metrics including those that are not gathered in Main Console 

Performance Reporter is metrics-focused and reports the target metrics in a target resource in 
detail (e.g. minutely). Reports and features of reports displayed by Performance Reporter are 
as follows: 

� Reports for each minute 

� Definition of reports, view format, and selection of the time range of the data to be 
displayed is possible 

� Real-time display of metrics and display of metrics stored in each Store database  

� Capability of displaying a report of all the metrics collected by an Agent 

� Multiple record output (range can be specified). You can select from minutely, hourly, 
monthly, and yearly. 
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1.4 Reviewing the Managed Resources 

The Tuning Manager main window, Main Console, lets you view and analyze the capacity and 
performance of all storage systems and their ports, logical devices, and disk storage groups as 
viewed from the perspective of their associated servers, databases, and file systems. Figure 
1.5 shows an example of the Main Console window displaying Performance Information when 
Hosts is selected.  

 

Figure 1.5 The Tuning Manager Main Console Window when Hosts is selected 

The left side of the Main Console window displays the Resource Tree, a hierarchical display 
with successive levels of detail about your network of servers, its subnetworks, hosts, storage, 
and applications. As you select each level in the tree, the metrics and charts about each 
selected resource and its subresources are displayed in the right side. In the right side, you can 
toggle between Capacity and Performance Information.  

The displayed resources change depending on the selected resource category. Depending on 
the selected categories and resources, any combination of the following resources is 
displayed: Hosts, Subnetworks, Servers, Filesystems, Device Files, Storage, Subsystem, SLPR, 
Ports, CLPR, Logical Disks, Whole Fabric, Fabric, Switch, Switch Port, Oracle, Oracle Instance, 
and Tablespace.  
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The Main Console provides a bi-directional view of the resources on the network. With the 
Resource Tree and the many hyperlinks that are embedded in the Tuning Manager reports you 
can navigate through all of the resources in the network in either direction, up or down, or 
view the capacity or performance of each resource from different perspectives. As an example, 
you can display a Disk Array Group in a particular storage system and then find and display the 
performance and capacity of all of the hosts, file systems, or Oracle instances associated with 
that particular Disk Array Group. Conversely, you can select a host, file system, or an Oracle 
instance, and navigate down to display all of the storage, ports, logical devices, or disk array 
groups associated with that particular host, file system, or Oracle instance. 

1.4.1 I/O Path 

Figure 1.6 shows an example of the I/O path that an application uses to access storage 
resources on a system. Tuning Manager obtains the performance data for each component 
along the path. 

 

Figure 1.6 I/O Path Example 

Figure 1.7 shows some of the corresponding metrics that can be viewed for each resource in 
the example I/O path. Chapter 7 uses this example system to describe a performance 
bottleneck analysis procedure. 
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Figure 1.7 Metrics and Resources  

The bi-directional view provided by Main Console is essential when trying to determine the 
root cause of an application performance problem. For example, when the performance of an 
application on the Oracle application server shown above is slower than expected and you 
need to check if a bottleneck on the storage subsystem is causing the performance problem, 
you can use Tuning Manager to complete the following steps until you find the bottleneck and 
its cause. For a detailed description of the procedures involved in this example, see Chapter 7. 

1. Identify server and device files based on the application name or database name. 

2. Check the I/O performance of the device files, especially the I/O response time. 

3. Determine which side has issues between the server side and switch, storage side. 

4. Check the I/O performance of the storage ports for the device files. 

5. Check the I/O performance of other servers connected to the same storage port.  

6. Determine which server is affecting the performance of the storage port. 

7. Check the I/O performance of the array groups for the LDEV. 

8. Check the I/O performance of other the servers connected to the same array group. 

9. Determine which server is affecting performance of the array group. 

10. Check the I/O performance of the switch ports connected to the server. 

1.4.2 Management Perspectives 

With the bi-directional view provided by the Resource Tree you can navigate through all of the 
resources in the network in either direction, up or down, or view the capacity or performance 
of each resource from different perspectives. All the resources are categorized under five 
perspectives and displayed when Resources is selected in the explorer area; Hosts (Whole 
Network), Storage, Fabric, Application, and NAS/Other Apps. The following sections describe 
the level of analysis provided for each perspective. 
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1.4.3 Hosts Perspective 

As shown in Figure 1.8, Tuning Manager provides hosts analysis at the following resource levels 
listed in descending order from summary to most detailed: Whole Network of Storage Servers, 
Subnetworks of Storage Servers, Servers (Hosts), Filesystems, and Device Files.  

 

Figure 1.8 Hosts Resource Levels 
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1.4.4 Storage Perspective 

As shown in Figure 1.9, Tuning Manager provides storage analysis at the following resource 
levels listed in descending order from summary to most detailed: Storage, Subsystems, Port, 
Logical Disk, and Array Groups. 

 

Figure 1.9 Storage Resource Levels 
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1.4.5 Fabric Perspective 

As shown in Figure 1.10, Tuning Manager provides Fabric analysis at the following resource 
levels listed in descending order from summary to the most detailed: Whole Fabric, Fabric, 
SAN Switch, and Switch Port. 

 

Figure 1.10 Fabric Resource Levels 
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1.4.6 Applications Perspective 

As shown in Figure 1.11, Tuning Manager provides capacity and performance analysis of 
Application (Oracle-related) resources at the following resource levels listed in descending 
order from summary to most detailed: Oracle, Oracle Instance, Tablespaces, and Datafiles. 

 

Figure 1.11 Application Resource Levels 

1.4.7 NASs/Other Apps Perspective 

Tuning Manager provides capacity and performance analysis of Hitachi NAS and other 
applications only on the agent-instance level. NAS and other application resources are only 
displayed in the Resource Tree when a corresponding Tuning Manager Agent program is running 
for the NAS or other application resource. When the resource is selected in the Navigation area, 
Performance Reporter is launched to display the information. 
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1.5 Reviewing the Data Model 

Agents of Tuning Manager continuously monitor hundreds of metrics and collect the metric 
data in records in their Store databases. Each record consists of smaller units called fields. 
Records and fields are collectively displayed in reports and are called the Tuning Manager data 
model.  

Knowledge of the data model is not required when viewing reports generated from Main 
Console but is required when you want to define your own reports. Records are classified into 
three types according to their characteristics. For details about the data model for each Agent, 
see the HiCommand Tuning Manager Hardware Reports Reference, HiCommand Tuning 
Manager Operating System Reports Reference, or HiCommand Tuning Manager Application 
Reports Reference. The record types that are used to collect performance data are predefined 
in each Agent in provided solution sets.  

The record types are as follows: 

� Product Interval record type (abbreviated as PI record type) 

For records of the PI record type, the agent collects performance data for a specified 
interval, such as the number of processes in one minute. You can use these records to 
analyze changes or trends in the system status over time. 

� Product Detail record type (abbreviated as PD record type) 

For records of the PD record type, the agent collects performance data that indicates the 
system status at a specific point in time, such as detailed information about the currently 
active processes. You can use these records to obtain the system status at a particular 
time.  

� Product Log record type (abbreviated as PL record type) 

For records of the PL record type, the agent collects application or log information of a 
database that is being executed on UNIX. Only Agent for Platform (UNIX) can collect 
records of the PL record type. 

Each record name includes the record type abbreviation in the name. For example, the Device 
Detail (PD_DEV) record for Windows is a Product Detail type record that stores performance 
data indicating the status (at a specific point in time) of file system driver and kernel driver 
devices. In the record name, the string in the parentheses (in this example, “PD_DEV”) is the 
record ID. The fields contained in the Device Detail (PD_DEV) record are as follows: Active, 
Depend Group Name, Depend Service Name, Device Name, Device Type, Error Control, Group 
Name, Image Path, Interval, Object Name, Record Time, Record Type, Start Constant, and Tag. 
For a list of all the available metrics and corresponding resources and record IDs, see Appendix 
A. 

You can use Performance Reporter to select specific performance data records and metrics 
from the hundreds of records and metrics available to be displayed in reports displayed with 
Performance Reporter. For details about using Performance Reporter, see section 4.2. 
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1.6 Reviewing the Monitored Metrics 

Tuning Manager collects, stores, and analyzes hundreds of metrics that are available to you for 
display in reports that you can also use to develop customized reports. Most of the metrics are 
available for real-time viewing, historical trending, forecasting, and troubleshooting. For 
details about the available metrics, see Appendix A. Of all the metrics that are continuously 
monitored, Table 1.1 and Table 1.2 list the most important and commonly-used. 

Table 1.1 Server-Centric Metrics 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Device File IO Response Time Avg Disk Secs/Xfer Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Read IOPS Disk Reads/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Write IOPS Disk Writes/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Read Transfer Disk Read Bytes/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Write Transfer Disk Write Bytes/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Logical Disk Not applicable Avg Disk Read Queue 
Length 

Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Write Queue 
Length 

Logical Disk 
Overview(PI_LOGD) 

Not supported 

Server (System) Not applicable Processor Queue 
Length 

System Overview(PI) Not supported 

Table 1.2 Storage-Centric Metrics 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Array Group Disk IOPS Read I/O /sec RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Disk IOPS Write I/O /sec RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Disk Transfer Read Xfer /sec RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Not applicable Write Xfer /sec RAID Group 
Summary(PI_RGS) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Array Group Read Hit Ratio Read Hit I/O Count RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Write Hit Ratio Write Hit I/O Count RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Usage Busy % RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Max Usage Max Busy % RAID Group 
Summary(PI_RGS) 

Not supported 

LDEV Read I/O Response 
Time 

Read Response Rate Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Write I/O Response 
Time 

Write Response Rate Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Disk IOPS Read I/O /sec Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Disk IOPS Write I/O /sec Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Disk Transfer Read Xfer /sec Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Not applicable Write Xfer /sec Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV I/O Response Time Total Response Rate Logical Device 
Summary(PI_LDS) 

Supported 

Port Port IOPS Avg I/O /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Max IOPS Max I/O /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Transfer Avg Xfer /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Max Transfer Max Xfer /sec Port 
Summary(PI_PTS) 

Supported 

Subsystem Write Pending Rate Cache Write Pending 
Usage 

Storage Summary(PI) Supported 

Subsystem Max Write Pending 
Rate 

Max Cache Write 
Pending Usage % 

Storage Summary(PI) Supported 

Subsystem Side File Usage Cache Side File Usage 
% 

Storage Summary(PI) Supported 

Subsystem Max Side File Usage Max Cache Side File 
Usage % 

Storage Summary(PI) Supported 

For definitions of the above metrics and other available metrics, see the Glossary. 
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Each Tuning Manager report contains a table of the metrics data available in the report. All of 
the reports generated from Main Console can be easily modified. Additionally, the Tuning 
Manager report generator, Performance Reporter, provides a simple, menu-driven method to 
develop your own custom reports and analysis by accessing the hundreds of real-time and 
historical metrics in the Agent data stores. Once you understand Tuning Manager’s reporting 
capabilities, you can begin to develop a plan for the ongoing monitoring of your key capacity 
and performance management metrics. 
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1.7 Reviewing the Reports 

Tuning Manager reports can be requested for a current real-time snapshot, any past point in 
time, or as a historical trend analysis over a specified time period. The historical data stored in 
the HiRDB is also used as input for the Tuning Manager reports that forecast future 
performance or capacity trends. All of these reports can be customized and printed or 
exported for use with other software tools.  

Figure 1.12 is an example of the File System Capacity report for all of the servers on the 
network and Figure 1.13 is an example of the File System Capacity report for all of the file 
systems on the “hcmd” server. The columns in each report can be sorted in descending or 
ascending sequence by simply clicking on the column heading so that you can quickly identify 
the file systems with the most or the least capacity available or utilized. As shown in Figure 
1.13, the Favorite Charts area of the Main Console window can display capacity graphs that 
you can select in advance for display whenever the File System Capacity report is displayed. All 
of this data can be exported to a CSV format file for further manipulation by other software 
applications.  

Tuning Manager lets you view the capacity for all of the servers on the network. 

 

Figure 1.12 File System Capacity (Hosts) 
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The subresource view provided by Tuning Manager lets you observe capacity for all the file 
systems on a specific server. 

 

Figure 1.13 File System Capacity subresources 

Note: The displayed time frame and Collection Interval are determined by your current Report 
Window settings. 

The Advanced Information area of Main Console lists the reports that you can display with Main 
Console for each resource. Advanced Information provides a variety of historical and forecast 
reports that access HiRDB that stores collected metrics data acquired hourly from each Agent 
and reported at the time specified in the current Report Window setting. Main Console is also 
used to launch Performance Reporter, which generates reports that directly access real-time 
data and the Store databases of each Agent to display real-time and historical data. When you 
select a report to be displayed with Performance Reporter, it appears in its own browser 
window.  
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1.7.1 Reports Generated from Main Console 

Depending on the selected resource, a combination of the following reports generated from 
Main Console is available in the Advanced Information section of the Main Console window: 

List. List reports enumerate key data for a list of resources. 

Resource Summary. Resource Summary reports display key measures of capacity or 
performance for the current level selected in the Resource Tree. 

Sub-resource Summary. Sub-resource Summary reports display key measures of capacity or 
performance for the resources below the current level selected in the Resource Tree. 

History. History reports enumerate key data collected from a resource for a specified time 
period. 

Forecast. Forecasts predict future values by using data for the resources collected in the Last 
Record, and configured time intervals. 

Figure 1.14 provides an example of a CLPR Performance report, which displays a chart 
indicating the Write Pending Rate. 

 

Figure 1.14 Performance: CLPR Performance 
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Reports generated from Main Console share these attributes when displayed: 

� The time frame and Collection Interval displayed are determined by your current Report 
Window settings. 

� Each report generated from Main Console contains a chart accompanied by a table of the 
underlying metrics data. 

– The metrics data table displays a maximum of 99 rows at a time. When the metrics 
contain more than 99 rows, Tuning Manager displays Next and Previous hyperlinks. 
(Use the Next and Previous hyperlinks to navigate in groups of 99 rows.) 

– Although charts are plotted using raw data, tables of data appearing along with charts 
do make use of rounding to make the display more manageable.   

– When multiple subtables are available for display, you can jump directly to each 
section of the table. Numbered hyperlinks appear for this purpose.  

– Each chart shown in a report generated from Main Console displays a maximum of 8 
resources as individually labeled items. The Tuning Manager charts label all additional 
resources as Other.  

– In the Favorite Charts area, which is between the Sub-resource Summary Information 
area and Advanced Information area of Main Console, you can insert the charts for 
reports that you reference often so that you do not need to select the reports each 
time to display the charts. 
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1.7.2 Reports Generated from Performance Reporter  

Reports displayed with Performance Reporter are available in the Advanced Information area 
of Main Console or when you select Performance Reporter from the Go menu in the Main 
Console task bar at the top of the Main Console window. When you start Performance Reporter 
from the Advanced Information area, the Performance Reporter window is displayed showing 
the top folders in the report folder tree for the selected agent. You can open the folders and 
select the reports to be displayed. When you start Performance Reporter from the Go menu, 
the Performance Reporter main window is displayed without an agent selected.  

Performance Reporter directly collects information from the Store database of an Agent to 
display historical data and directly accesses real-time data to display real-time data. A 
historical report displays data from a specified interval of time. A real-time report displays 
temporarily collected, current data.  

Any of the following three report types can be selected, as appropriate to the analysis 
objectives for the performance data: 

� Historical report (single Agent): This type of report displays one Report window for each 
Agent. When multiple Agents are selected, the report displays as many windows as the 
number of Agents you have selected. 

A single-Agent historical report handles the following record types: 

– Single instance: Records that use a single instance as their evaluation target. A record 
for which only one row is created for one data collection is called a single-instance 
record. 

– Multiple instances: Records that use multiple instances as their evaluation target. A 
record for which multiple rows are created for one data collection is called a 
multiple-instance record. This can be useful, for example, in comparing data in the 
same field in multiple Agents. 

� Historical report (multiple Agents): This type of report displays all selected Agents in a 
single window, regardless of whether a single report or multiple reports are selected. 

� Real-time report (single Agent): Displays current data, temporarily collected, for a single 
Agent. The collected values can be displayed in order, and ranked. Note that past data 
cannot be obtained for display, since it is not stored in the Store database. Real-time 
reports (single Agent) support data from single-instance or multiple-instance records. 

Additionally, for more detailed information you can also display drilldown reports from 
primary reports. For example, you can select a desired date on a daily report and access an 
hour-by-hour report for that date. For details about displaying drilldown reports, see section 
5.3.6.3. 

Note: Some reports displayed with Performance Reporter do not initially show graphs; 
however, you can easily add a graph to a report by copying the report from the provided 
system reports and customizing the report. For details about customizing reports, see section 
5.2. 
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1.7.3 Solution Sets 

Each Tuning Manager Agent provides a solution set containing predefined reports that have 
fields pre-selected for display in the reports. You can use Performance Reporter to select the 
reports from the solution set to define your own reports either by creating new reports or 
customizing the fields displayed in the reports of the solution set. The solution sets facilitate 
the setup for monitoring the operating status of monitored objects. You can customize a 
solution set as appropriate to your environment.  

The reports in the solution set are located in the folders that you open in Performance 
Reporter when you select the Reports tab and then select a folder in System Reports. The 
following example shows the reports available in the Monthly Trend folder of the solution set 
for the Windows Agent. 

 
<Windows> 
 +-- <Operating System> 
     +-- <Monthly Trend> 
     |   +-- CPU Trend 
     |   +-- CPU Trend (Multi-Agent) 
     |   +-- Memory Available Trend (Multi-Agent) 
     |   +-- Process Trend 
     |   +-- Server Activity Summary Trend (Multi-Agent) 
     |   +-- Server Sessions Trend (Multi-Agent) 
    ... 

Each report in the solution set displays information stored in the fields of a record. The fields 
of the record to be displayed are pre-defined for the report in the solution set. For example, 
the System Summary Overview (PI) record stores performance data, taken at specific intervals, 
about the entire system and the CPU Trend report in the solution set for UNIX uses fields of the 
System Summary Overview (PI) record (CPU %, Kernel CPU %, and User CPU %) to display the 
historical data on CPU usage at a specific host on a daily basis over the past month.  

The System Summary Overview (PI) record stores many other metrics in fields and you can 
select those metrics to define your own reports.  For details about the reports in the solution 
sets and the fields in the records provided with each Agent, see the HiCommand Tuning 
Manager Hardware Reports Reference, HiCommand Tuning Manager Operating System Reports 
Reference, or HiCommand Tuning Manager Application Reports Reference. For details about 
how to use a solution set to define a report, see Chapter 5. 
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1.7.4 User-defined Reports 

You can use Performance Reporter and the solution sets provided by each Agent to define your 
own reports displayed with Performance Reporter which collect metrics directly from each 
Agent’s Store database. User reports make it easier to perform comprehensive analysis of the 
operating status of objects being monitored by an Agent.  

Note: Knowledge of the Tuning Manager data model is required when you want to define your 
own reports. For a brief overview of the data model, see section 1.5. For details about the data 
model for each Agent, see the HiCommand Tuning Manager Hardware Reports Reference, 
HiCommand Tuning Manager Operating System Reports Reference, or HiCommand Tuning 
Manager Application Reports Reference. 

Performance Reporter provides a wizard that you can use to define the new reports. The 
wizard provides windows for selecting the type of Report displayed with Performance Reporter, 
the metrics (referred to as fields in the data model) to be displayed in the report, the charts, 
related drilldown reports, and the time period for the data to be displayed in the report. 

For details about defining a user report, see Chapter 5. 
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1.8 Avoiding Performance Problems 

Tuning Manager can monitor thresholds that are set for the data collected by Agents. When the 
collected data reaches a threshold, Tuning Manager issues a warning to a user by sending an 
e-mail or executing a command. The user can take action upon receipt of the warning, and 
prevent problems in operations. 

Tuning Manager provides two types of warnings: alerts and alarms, as follows: 

� Alert: Tuning Manager issues this warning when the data collected by Agents reaches the 
threshold set for report data that can be displayed by Main Console. You can use the Main 
Console GUI to set thresholds and specify how to notify the users. 

For details on alerts, see Chapter 6. 

� Alarm: Tuning Manager issues this warning when the data collected by Agents reaches the 
threshold set for report data that can be displayed by Performance Reporter. You can use 
the CLI to set thresholds and specify how to notify the users. 

For details on alarms, see the HiCommand Tuning Manager Agent Administration Guide. 

1.8.1 About Setting and Using Alarms 

This section gives an overview of how to set and use alarms and gives the general procedure for 
creating and using alarms. For details on alarms, see the HiCommand Tuning Manager Agent 
Administration Guide. 

To set alarms, the following methods are available: 

� Defining a new alarm table and alarms 

This method creates an alarm table appropriate for the system environment and then 
defines alarms. You can add more alarms to the alarm table later. 

� Using an existing alarm table or alarms 

The following methods are available: 

– Using the solution set 

The solution set is a group of preset alarms defining necessary information that is 
provided by each Agent. If the solution set is used, the alarms provided in the solution 
set take effect when the Agent starts. 

– Customizing the solution set 

This method copies the solution set and then customizes the copy as appropriate for 
the system environment. 

– Using an existing alarm table or alarms 

This method copies an existing alarm table or alarms and then customizes the copy. 

To use alarms, you must associate (bind) an alarm table defined by one of the above methods 
to the applicable monitoring Agents. 
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Figure 1.15 shows the general procedures for creating, setting, and using alarms. 

 

Figure 1.15 Procedures for Setting and Using Alarms 
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1.8.2 Using Commands to Set and Use Alarms 

Table 1.3 describes the commands for setting and using alarms. For details on the commands 
for setting and using alarms that are provided by the services of Tuning Manager series 
programs, see the HiCommand Tuning Manager Command Line Interface Guide. 

Table 1.3 Overview of Commands for Setting and Using Alarms 

Phase Command name Description 

Preparations jpcahprp 
update 

� If you want to be notified by email when an alarm event occurs at an Agent, use 
this command to set the email senders. 

� If you want a command to be executed automatically when an alarm event 
occurs at an Agent, use this command to change the Action Handler property 
on the host where the command is to be executed. 

 jpctgprp 
create 

If you want to send an SNMP trap when an alarm event occurs at an Agent, use 
this command to change the Trap Generator property. 

Creating alarms jpcalarm 
export 

Outputs the template of an alarm definition file. If you want to create an alarm 
definition file without using the template, use this command to create an alarm 
definition file by following the syntax rule of an alarm definition file. 

 jpcalarm check Checks whether the contents of the created alarm definition file are valid. 

Using alarms jpcalarm bind Binds an alarm table to an Agent. 

 jpcalarm 
active 

Activates an alarm. 

Other jpcalarm copy Copies an alarm table or an alarm. 

 jpcalarm 
delete 

Deletes an alarm table or an alarm. 

 jpcalarm 
import 

Imports an alarm definition file. 

 jpcalarm 
inactive 

Inactivates an alarm. 

 jpcalarm list Displays definition information of an alarm table and an alarm, or displays binding 
information. 

 jpcalarm 
unbind 

Releases the binding of an alarm table bound to Agents. 

Note: For details about the fields for which alarms are set and the alarms for the solution set, 
see the following manuals: 

� HiCommand Tuning Manager Hardware Reports Reference 

� HiCommand Tuning Manager Operating System Reports Reference 

� HiCommand Tuning Manager Application Reports Reference 
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1.9 Solving Performance Problems 

The Tuning Manager software agents continually gather hundreds of performance metrics and 
store them for instant recall if needed. Chapter 7 explains how Main Console and Performance 
Reporter are used together to view metrics and solve a performance problem.  
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1.10 Planning for System Monitoring 

Figure 1.16 shows the workflow when planning system monitoring with Performance Reporter. 

 

Figure 1.16 Planning How to Monitor Your System with Performance Reporter 

The following steps provide additional details about the tasks that are outlined in Figure 1.16. 
We recommend that you follow this procedure to understand the status and potential 
challenges of a system to be monitored by the Tuning Manager series programs: 

1. Carefully consider the following to gain an appropriate understanding of the detailed 
status and problems of a system to be monitored by Performance Reporter: 

– What areas of the monitored system do you wish to know the status of? 

– What kinds of problems are likely to occur in the monitored system? 

2. Consider which items to monitor. To maintain an understanding of the status and problems 
of a monitored system, determine the items to monitor. For example, when a Windows 
host is used as a shared server, a scarcity of free space on a logical disk drive may cause the 
shared server to run abnormally. In this case, the monitoring item to select would be Ratio 
of free space on logical disk drive. 
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3. Check if the items to be monitored are provided in a solution set. The Tuning Manager 
series programs provide various sets of pre-defined reports called solution sets. Using 
Performance Reporter, solution sets can be displayed as graphs or tables. First, check if 
the item to be monitored is provided in a solution set.  

For details about solution sets, see the chapter that describes solution sets in the 
HiCommand Tuning Manager Hardware Reports Reference, HiCommand Tuning Manager 
Operating System Reports Reference, or HiCommand Tuning Manager Application Reports 
Reference. 

4. Consider which records to collect in order to understand the status of the items to be 
monitored. Increasing the number of records in which performance data is collected may 
adversely affect disk capacity and system performance. When configuring the records to 
be collected, set only items that must be monitored, based on consideration of the 
requirements for collecting performance data, such as required disk capacity and record 
collection interval.  

For an overview of the records, see the chapter that describes the overview of data 
handled in Tuning Manager series programs in the HiCommand Tuning Manager Agent 
Administration Guide. For details about records, see the chapter that describes records in 
the HiCommand Tuning Manager Hardware Reports Reference, HiCommand Tuning 
Manager Operating System Reports Reference, or HiCommand Tuning Manager 
Application Reports Reference. 

5. Consider how to manage the collected records. The disk capacity needed differs depending 
on whether or not the collected records are stored in a Store database and, if so, the data 
recording format, save criteria, and so on. Before estimating system requirements, you 
must consider how the collected records will be managed.  

For information about how to manage collected records, see the chapter that describes 
management of a Store database in the HiCommand Tuning Manager Agent Administration 
Guide. 

6. Estimate system performance, considering the number of records to be collected, how 
they are to be managed, and so on. 

7. Define reports based on the items to be monitored. 

– If a solution set contains settings that match the items to be monitored, use the 
solution set as is. 

– If a solution set contains settings that are similar to the items to be monitored, define 
reports by customizing the solution set to fit the environment being used. 

– If you wish to define new reports optimized for the environment being used, define 
new reports.  

For example, to monitor the ratio of free space on a logical disk drive on a Windows host, 
use the Free Space - Low 10 Logical Drives report in the solution set of Agent for Platform 
(Windows). 

For information about defining and manipulating reports, see chapters that describe 
defining and manipulating reports in this manual. 
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8. Configure the management of the collected records. Specify the following items, based on 
how the collected records will be managed, as considered in step 5. 

– Method to record data in the Store database. 

– Save criteria for the Store database. 

For information about how to perform these settings, see the chapter for CLI commands in 
the HiCommand Tuning Manager Command Line Interface Guide. 

9. Start using Tuning Manager Series programs. 



36  Chapter 1 Overview of Tuning Manager 

1.11 Using Reports to Manage Your System 

1. Begin Performance Reporter operation. 

2. Collect performance data to analyze changes and trends in system status over time. For 
example, using the Free Space - Low 10 Logical Drives report of Agent for Platform 
(Windows), collect performance data for the 10 logical drives of Windows hosts that have 
the least free space. 

3. Display a historical report to understand the status and problems of the monitored device. 
For information about how to display a report, see Chapter 4. 

4. If needed, define and create new reports. 

5. Analyze causes based on displayed reports. 

6. Effectively use the monitoring results. You can use the monitoring results to prevent 
problems on monitored systems before they occur, and to quickly isolate the causes of 
problems that do occur in these systems. 
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1.12 Using the Command Line Interface 

The Tuning Manager command line interface (CLI) provides a simple way to access HiCommand 
Tuning Manager data. Tuning Manager provides access via the Command Line 
Interface-Command line programs suited for operation via a telnet connection over TCP/IP or 
for scripted operations.  

Common ways to use the CLI are: 

� Manually executing the CLI programs at the command line in the operating system. 

� Invoking CLI programs within scripts, macros and development products. Perl, Microsoft 
Visual Basic and Tcl are among the most common tools used for this purpose. Scripts 
enable you to integrate Tuning Manager data and automate reporting. (Examples: 
scheduled execution of scripts, customized reports by parsing/manipulating results.) 

Also, some specific tasks that cannot be executed by using the GUI can be executed by the CLI. 
For example, you can use the jpcasrec update command to connect to an Agent and modify the 
defined information recording methods, such as the collection interval, of the Store database. 
The information to be modified is in an XML-format parameter file specified as a command-line 
argument. You can specify multiple Store database definitions in a single parameter file, and 
modify them all at once. 

To execute a command line program: 

1. Log into the server running HiCommand Tuning Manager. 

2. (Optional) Change the directory to installation-folder-for-Performance-Reporter 
/tools. 

3. Type the desired CLI command. 

Example: 
installation-folder-for-Performance-Reporter/tools/htm-networks -c -u myUser1 -w 
myPassword 

For details about the installation folder for Performance Reporter, see the HiCommand Tuning 
Manager Installation Guide. 

For a complete description of the Tuning Manager CLI commands, see the HiCommand Tuning 
Manager Command Line Interface Guide. 
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1.13 Operating with a Cluster System 

By using a cluster configuration, you can create a highly reliable system that continues to 
operate even in the event of a system failure. As a result, Tuning Manager series programs can 
continue operation and monitoring 24 hours a day. Figure 1.17 shows an example of the 
simplest configuration for a cluster system. 

Note: HTM Agent (Agent for RAID Map, Agent for Platform, or Agent for Microsoft Exchange 
Server) can run on machines in a cluster configuration, but these agents do not fail over. When 
a failover occurs in a cluster system, HTM Agent continues operation on the physical host. 

 

Figure 1.17 Example of a Cluster System 

Two identical environments are set up, with one operating normally as the executing node, 
and the other operating during failure as the standby node.  

For details on running Tuning Manager series programs on a cluster system, see the 
HiCommand Tuning Manager Server Administration Guide, HiCommand Tuning Manager Agent 
Administration Guide, or HiCommand Tuning Manager Installation Guide. 
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1.14 Introducing the Graphical User Interface 

This section describes the window structure, main components, and functions of the GUI 
(Graphical User Interface) that you operate when you use functions provided by Tuning 
Manager. For details on each Tuning Manager function related to the GUI components and the 
operation procedures, refer to the appropriate location of the documents indicated 
throughout the section. 

For operations that the system administrator performs, such as setting Tuning Manager 
components, an interface other than the GUI described here is provided. For details, see the 
HiCommand Tuning Manager Server Administration Guide. 

In addition to the GUI, Tuning Manager also provides a CLI (Command Line Interface). For 
details on how to use the CLI, see the HiCommand Tuning Manager Command Line Interface 
Guide. 

1.14.1 Using the Main Window 

Following is an example of the structure of the Main Window and the functions that you can 
operate in each frame. 

 

Figure 1.18 Components of the Main Window  

Table 1.4 provides a brief description of each frame. 
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Table 1.4 Description of Frames 

Frame Description 

Branding bar area Indicates that the product is of the HiCommand series. For Tuning Manager, HiCommand Tuning 
Manager is displayed. 

Global tasks bar area 
(See section 1.14.2) 

Used for operations such as launching HiCommand Suite applications and displaying Online Help. 

Explorer area 
(See section 1.14.3) 

Consists of the Explorer menu and Dashboard menu. Used for operations such as displaying 
information for the selected item and launching HiCommand Suite applications. 

Application bar area 
(See section 1.14.4) 

Displays the menu for the item selected in the Explorer menu. 

Report area 
(See section 1.14.5) 

Consists of the navigation area and application area. In those areas, information for the item 
selected in the Explorer menu is displayed. 

1.14.2 Global Tasks Bar Area 

The following operations can be performed from the global tasks bar area: 

� Logging out of Tuning Manager (See section 2.3) 

� Launching Performance Reporter or Device Manager (See section 2.6) 

� Launching Online Help 

� Displaying version information (product version, login mode, license information) 

� Displaying the user IDs of currently logged-in users and other information 

1.14.3 Explorer Area 

The explorer area consists of the Explorer menu and the Dashboard menu. From the Explorer 
menu you can access the main functions that Tuning Manager provides. From the Dashboard 
menu, you can launch HiCommand Suite applications. 

1.14.3.1 Explorer menu 

This is the entry for most Tuning Manager functions. Table 1.5 describes the functions 
available and information displayed in the Explorer menu. 
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Table 1.5 Functions Available and Information Displayed in the Explorer Menu 

Explorer menu 
item 

Operable function Displayed information 

Resources This item is for selecting the target resources for 
which reports are displayed. Select this item to view 
the reports on capacity and performance information 
for resources that Tuning Manager monitors. For 
details on the functions used to display reports, see 
section 3.2. 

Clicking this item displays resource categories 
(Hosts, Storages, Fabrics, Applications, and 
NAS/Other Apps) below. If you click one of the 
displayed categories, the resources that Tuning 
Manager currently monitors are displayed in the 
navigation area in tree structure (Resource Tree). In 
the application area, performance information for 
the resource selected in Resource Tree is 
displayed. 

Alerts Select this item to use the alert function. The alert 
function notifies users of system status by sending 
email or executing commands, when a performance 
value or the used capacity for the resource that 
Tuning Manager monitors exceeds the preset 
threshold. For details, see Chapter 6. 

Clicking this item displays Resource Tree in the 
navigation area. In the application area, Alert List for 
the resource selected in Resource Tree is 
displayed. 

Bookmark Select this item to use the bookmark function. You 
can save frequented or important pages as 
bookmark links for later reference. For details, see 
section 3.4. 

Clicking this item displays bookmark folders and 
bookmarks saved directly below the default folder in 
the tree structure in the navigation area. In the 
application area, the list of bookmark folders and 
bookmarks are displayed for the item selected in the 
navigation area. 

Settings Select this item to perform operations such as 
editing a user profile, specifying a threshold value, 
and editing license information. For details on editing 
a user profile and specifying a threshold value, see 
section 2.5. For details on editing license 
information, see the HiCommand Tuning Manager 
Server Administration Guide. 

Clicking this item displays resource categories 
(User Profile, Threshold, and License Info) 
below. Clicking User Profile displays the form for 
editing a user profile in the report area. Clicking 
Threshold displays the form for specifying a 
threshold value. Clicking License Info displays the 
form for editing license information in another 
window. 

Administration This item provides the functions necessary for 
administrators to perform day-to-day operations. 

This item is displayed only when you are logged in 
with Administrator permissions. For details, see the 
HiCommand Tuning Manager Server Administration 
Guide. 

1.14.3.2 Dashboard 

You can launch HiCommand Suite applications from the Dashboard menu. Clicking Go beside 
an installed HiCommand Suite application launches the application. For an application that is 
not installed, Go is displayed in gray and clicking it does not launch the application. 

You can use the Dashboard menu in Single sign-on mode only. You cannot use it in Standalone 
mode. For details on Single sign-on mode and Standalone mode, see the HiCommand Tuning 
Manager Server Administration Guide. 
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1.14.4 Application Bar Area 

The menu for the item selected in the Explorer menu is displayed in the application bar area. 
Table 1.6 describes the menu items displayed in the application bar area and their functions. 

Table 1.6 Items Displayed in the Application Bar Area and Their Functions 

Menu item Function Condition for display 

Alerts Displays the alert list for the resource for which the 
report is displayed.  For details on alerts, see 
Chapter 6. 

Displayed when an item other than NASs/Other 
Apps is selected in the Explorer menu. 

Bookmarks Saves the selected resource or the alert list for the 
resource as a bookmark.  For details on bookmarks, 
see section 3.4.  

Displayed when a resource item other than 
NASs/Other Apps or Alerts is selected in the 
Explorer menu. 

Delete Deletes the bookmark for a resource that does not 
exist. 

Displayed when Bookmark is selected in the 
Explorer menu. 
Note: This item is displayed only when you select, 
from the bookmark list, a bookmark for which the 
corresponding resource does not exist. 

Export Exports the displayed report or alert list to a CSV file. 
For details on how to export reports and alerts, see 
section 3.3. 

Displayed when a resource item other than 
NASs/Other Apps or Alerts is selected in the 
Explorer menu. 

Help Displays Online Help. - 

Print View Prints the displayed report or alert list. For details on 
printing, see section 3.5. 

Displayed when a resource item other than 
NASs/Other Apps or Alerts is selected in the 
Explorer menu. 

Rename Changes the subnetwork name displayed in 
Resource Tree to a more recognizable name. Only 
users with Admin or Manager permissions can use 
this function. For details, see the HiCommand 
Tuning Manager Server Administration Guide. 

Displayed when Subnetwork is selected in the 
navigation area. 

Resources Displays the report for the resource for which the 
alert list is displayed. 

Displayed when Alerts is selected in the Explorer 
menu. 

1.14.5 Report Area 

The report area consists of the navigation area and application area, and displays detailed 
information for the resources that Tuning Manager monitors, and information about alarms and 
bookmarks. Figure 1.19 describes the structure of the report area when Resources is selected 
in the explorer area. 
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Figure 1.19 The Structure of the Report Area 

1.14.5.1 Navigation Area 

Resources and bookmarks for the item selected in the Explorer menu are displayed in the tree 
structure. 

1.14.5.2 Application Area 

Detailed information for the item selected in the navigation area is displayed in the application 
area. Table 1.7 describes the structure of the application area when Resources is selected in 
the explorer area. 
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Table 1.7 Structure of the Application Area 

Area name Description 

Message area Warning and error messages for licenses and polling are displayed. 

Title area Texts such as the title of the application area, path to the resource (Crumb Trail), and monitoring date are 
displayed. For details on how to set the monitoring date, see section 3.1.3. 

Tab area If Resources > Hosts or Resources > Applications is selected in the explorer area, the tabs 
(Performance and Capacity) for switching information to view are displayed. If Alert is selected in the 
explorer area, tabs (View, Define, Action, Bind, and Reset) for operating alert functions are displayed. For 
details, see Chapter 6. 

Summary area Summary information for the resource selected in the navigation area is displayed. 

Information area The area is divided into the following three sections: 
� Sub Resource Section 

Displays information for the resources located directly below the resource selected in the navigation 
area. For example, if Subsystem is selected in the navigation area, the reports for Ports, Array Groups, 
and Logical Disks are displayed in Sub Resource Section. (The displayed report can be switched by 
clicking the tabs.) 

� Favorite Chart 
Displayed if you registered a chart for a detailed report displayed from Advanced Information as a 
Favorite Chart. The information is updated every time the corresponding resource is selected in the 
navigation area. If no chart is registered as a Favorite Chart, this section is not displayed. For details on 
Favorite Chart, see section 3.2.3. 

� Advanced Information 
Tuning Manager provides many reports on historical trends and predictions. In Advanced Information, 
the list of reports available for the resource selected in the navigation area is displayed. If you click the 
link to each report, the chart and the table with basic information are displayed. When the link to 
Performance Reporter is displayed, you can display reports from Performance Reporter by launching 
Performance Reporter. 

1.14.6 Correct Values for Data Entry 

Table 1.8 describes valid values for Tuning Manager tasks when the values are entered by users 
who do not have administrative privileges. For restrictions on values entered by 
administrators, see the HiCommand Tuning Manager Server Administration Guide. 

Table 1.8 Correct Values for Data Entry 

Tuning Manager 
Component 

Entry field Permitted values Maximum field 
length 

Minimum field 
length 

Notes 

Login Form: User ID No restrictions 25 1 Tuning Manager 
checks for a 
valid user ID 
entry. 

 Password No restrictions 25 1 Tuning Manager 
checks for a 
valid password 
entry. 

Edit: (Subnetwork 
Alias) 

Name No restrictions 25 1 - 
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Tuning Manager 
Component 

Entry field Permitted values Maximum field 
length 

Minimum field 
length 

Notes 

Save Bookmark: Name No restrictions 100 1 - 

Edit Bookmark: Name No restrictions 100 1 - 

Create Folder: New Folder No restrictions 100 1 - 

Profile-Account Info Password No restrictions 25 1 If there are no 
entries in 
Password and 
Confirm 
Password, the 
password will 
not be updated. 

 Confirm 
Password 

No restrictions 25 1 If there are no 
entries in 
Password and 
Confirm 
Password, the 
password will 
not be updated. 

 First Name No restrictions 40 1 First character 
must be 
alphanumeric 

 Last Name No restrictions 40 1 same as above 

 Email 0 to 9 
a to z 
A to Z 
_ . @ - 

60 1 Must begin with 
0-9 or a-Z; 
Tuning Manager 
checks for a 
valid email 
address format. 

Profile-Threshold Filesystem 
over capacity 

0 to 9 6 1 Must be greater 
than 0 and less 
than 100. 
Limited to two 
places after the 
decimal. 

Reports-Save Report Name No restrictions 100 1 - 
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Tuning Manager 
Component 

Entry field Permitted values Maximum field 
length 

Minimum field 
length 

Notes 

History Report Period 
Setting 

From year 0 to 9 4 4 Must be 
expressed as a 
4-digit year 
value between 
1970 and the 
current year. 

 From Hour 0 to 9 2 1 Valid values 
range from 0 to 
23. 

 To Year 0 to 9 4 4 Must be 
expressed as a 
4-digit year 
value between 
1970 and the 
current year. 

 To Hour 0 to 9 2 1 Valid values 
range from 0 to 
23. 

 Number of 
Records 

0 to 9 2 1 Valid values 
range from 0 to 
99. 

Alerts-Alert Definition Name No restrictions 100 1 - 

 Occurrences 
During 

0 to 9 3 1 - 

 Intervals 0 to 9 3 1 - 

 Warning 
Condition 

0 to 9 
and period (.) 

10 1 Must begin with 
0 to 9. 
GB/KB: >= 0, 
limited to 2 
decimal places 
%: >0 and <100, 
limited to 2 
decimal places 
Growth %: Any 
number, limited 
to 2 decimal 
places 
DBL: >=0 and 
<100, limited to 
2 decimal places 
Counts: Whole 
number >= 0 

 Critical 
Condition 

Same as above 10 1 same as above 
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Tuning Manager 
Component 

Entry field Permitted values Maximum field 
length 

Minimum field 
length 

Notes 

Alerts-Action 
Definition 

Name No restrictions 100 1 - 

 Email Host Any valid ASCII 
character 

500 1 Email host must 
be accessible 
when defined. 

 Email To 0 to 9 
a to z 
A to Z 
_ . @ - 

500 1 Must begin with 
alphanumeric 
character. 
Tuning Manager 
checks for a 
valid email 
address format. 

 Email 
Message 

Any valid ASCII 
character 

500 0 - 

 User ID No restrictions 500 1 - 

 Password No restrictions 500 1 - 

 SNMP 
Destination 

Any valid ASCII 
character. 

500 1 Must be a valid 
IP address or a 
hostname. 

 SNMP 
Community 

Any valid ASCII 
character, except 
spaces 

500 1 - 

 SNMP 
Message 

Any valid ASCII 
character 

500 0 - 

 Command Any valid ASCII 
character 

500 1 - 

 Command 
Parameters 

Any valid ASCII 
character 

500 0 - 

 Log Message Any valid ASCII 
character 

500 1 - 

Report Window Date Any year between 
1970 and the current 
year 

4 4 - 
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Chapter 2 Logging into Tuning Manager 

This chapter provides information about logging in to Tuning Manager. 

� Logging In (see section 2.1) 

� Setting Your Browser (see section 2.2) 

� Logging Out (see section 2.3) 

� Changing Account Information (see section 2.4) 

� Setting the Threshold (see section 2.5) 

� Launching Other Applications (see section 2.6) 
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2.1 Logging In 

There is no default user account for accessing Tuning Manager. Please see your system 
administrator to obtain your User ID and password. 

1. In the Web browser, enter the URL supplied by the administrator for your site. 

The Title window appears, and then the Login Window appears automatically. 

Note: The URL must be terminated with a slash. (...TuningManager/) 

2. Type your Tuning Manager User ID. 

The method for authenticating a user in Tuning Manager differs depending on the mode. 

– Standalone mode:  
The user is authenticated using the user account registered in the Tuning Manager 
local database. User IDs are not case sensitive. 

– Single sign-on (SSO) mode: 
The user is authenticated using the user account registered in the common database 
for HiCommand Suite applications. 

In this mode, the system administrator configures whether user IDs are to be case 
sensitive. Contact the system administrator to check whether the user IDs are case 
sensitive. 

For details on Single sign-on mode and Standalone mode, see the HiCommand Tuning 
Manager Server Administration Guide. 

3. Type your Password. 

4. Click the Login button on the Login window. 

Notes: 

� You cannot log in to the Tuning Manager GUI through multiple browser windows that you 
opened on a single client machine. Regardless of whether the Tuning Manager you attempt 
to log in to is on a single server or different server, Tuning Manager operations from 
multiple browser windows on the same client machine are not supported. 

� Please contact your administrator if you encounter any messages related to your site 
license. 

� As a security precaution, Tuning Manager will log out users after 30 minutes of inactivity. 
The timeout period is not configurable. 

� If an attempt to log in to Tuning Manager fails, make sure that the Tuning Manager services 
have started, or contact your administrator. For details on how to start the Tuning 
Manager services, see the HiCommand Tuning Manager Server Administration Guide. 

� For details on how to set your browser, see section 2.2. 
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2.2 Setting Your Browser 

The following are the browser versions supported by Tuning Manager: 

� Microsoft Internet Explorer V6.0 or later 

� Mozilla™ 1.7.8.00 or 1.7.12.01 (Solaris only) 

Table 2.1 shows the required browser settings. For details on the items and how to set them, 
refer to the documentation for the applicable browser. 

Table 2.1 Browser Settings 

Item Settings 

 Internet Explorer Mozilla 

Cookies Enable this item. 

File Download Enable this item. Not applicable 

Image Display Enable this item. 

Java Virtual Machine (JVM™) Enable the JVM. 
Note: If the JVM is not installed in your 
version of Windows, you must install 
the program.  

Not applicable 

JavaScript™ Enable this item. 

Languages Set the language you want to use. 
Note: Tuning Manager displays the 
date in a following format, 
corresponding to the language set for 
the browser: 
If English (en_us) is set: MM,dd,yyyy 
For a language other than English: dd 
MM yyyy 

Set the language you want to use. 
Note: 
� Tuning Manager displays the 

date in a following format, 
corresponding to the language 
set for the browser: 
If English (en_us) is set: 
MM,dd,yyyy 
If a language other than 
English: dd MM yyyy 

� Set the same language for the 
browser and the X-terminal. If 
these settings are not the same, 
the character string in the title 
bar may be displayed 
incorrectly. 

Page Cache Specify that the latest information is displayed each time the user accesses a 
page. 

Popup Blocker Disable this item. 
Note: Also make sure that other utilities 
that block pop-up windows are not 
installed. 

Not applicable 

Security Policies Specify Medium as the security level. Not applicable 
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2.3 Logging Out 

You can log out of Tuning Manager in either of the following two ways: 

� In the Global Tasks Bar area, select File and then Logout. 

� In the Global Tasks Bar area, click the Logout button. 

2.4 Changing Account Information 

You can use the User Profile window to edit account information of a logged-in user. 

 

Figure 2.1 Profile Section (in Standalone Mode) 

Note: Account information is editable in standalone mode only. 

Use this form to edit your standalone account information including: 

� Your password 

� First and last name 

� Email address 

To edit a user’s account information: 

1. In the Explorer area, select Explorer, Settings, and then User Profile. 

Tuning Manager displays your account information in the Information area. 

2. Type in the items. 

3. Click Save to store your changed profile. (Or click Reset to abandon changes.) 
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2.5 Setting the Threshold 

You can specify a threshold (a percentage) for the used storage capacity of a filesystem 
monitored by Tuning Manager. 

To set the threshold: 

1. In the Explorer area, select Explorer, Settings, and then Threshold. 

2. Enter the percentage of filesystem capacity that you want to specify as the point at which 
filesystem usage is considered excessive. (Leave this field blank to eliminate monitoring of 
filesystem capacity.) 

Note: This field accepts values from 0 to 100. 
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2.6 Launching Other Applications 

Tuning Manager provides a different user authentication method for the stand-alone mode and 
single sign-on mode. This section describes how to launch other applications in the stand-alone 
mode. 

For details on the single sign-on mode, see the chapter that describes user management in the 
HiCommand Tuning Manager Server Administration Guide. 

2.6.1 Launching HiCommand Suite Applications and Tools 

You can launch the following two HiCommand Suite applications from Main Console: 

� Performance Reporter 

� Device Manager 

Note: To start Device Manager, you must set up the Device Manager login window URL. For 
details on how to perform this procedure, see the chapter describing the tool configuration in 
the HiCommand Tuning Manager Server Administration Guide. 

To launch HiCommand Suite Applications and Tools: 

1. In the Global Tasks Bar area, click Global and then Go. 

All registered HiCommand applications are displayed. 

2. Select the applications you want to launch. 

For example: 

Select Device Manager. 

The Device Manager that you selected is displayed. 

There are two ways of launching Performance Reporter. For details, see section 2.6.2. 
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2.6.2 Launching Performance Reporter 

You can launch Performance Reporter from Tuning Manager in either of the following ways: 

� Launch Performance Reporter by clicking Global and then Go in the Global Tasks Bar area 
of Tuning Manager. 

In this case, Performance Reporter displays the main level, and enables you to move within 
an application. 

� Launch Performance Reporter from the Information area (Advanced Information), with the 
agent specified by Tuning Manager. 

In this case, Performance Reporter displays the Report Tree Selection window of the 
selected agent. If you want to display the Main window when Performance Reporter is 
launched, edit the user.properties file. For details on how to edit this file, see the 
chapter that describes tool configuration in the HiCommand Tuning Manager Server 
Administration Guide. 

2.6.3 Launching Storage Navigator 

Tuning Manager can launch Storage Navigator applications. Before launching a Storage 
Navigator application, ask your administrator if the launch settings for the Storage Navigator 
application have been set. 

To launch a Storage Navigator application: 

1. Choose a resource for which you want to launch the Storage Navigator application in the 
Navigation area. 

If the selected resource is either a subsystem or a subresource of a subsystem that supports 
the Storage Navigator application, a pull-down menu for launching Storage Navigator 
applications will be displayed below the Advanced Information section. 

2. From the pull-down menu, click the menu that you want to launch. 

 

Figure 2.2 Launching Storage Navigator applications 
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Table 2.2 Storage Navigator Commands 

Command Displayed window 

Performance Monitor The Storage Navigator window is displayed with only the Performance Monitor 
function buttons displayed. 

Main 
See Note 

The Main window of Storage Navigator (with the buttons for all the available 
functions) is displayed. This is the window displayed immediately after logging in 
Storage Navigator. 

Login The Login window of Storage Navigator is displayed. 

Note: This menu is only displayed for administrative users. 

Please note that only one window can be displayed at one time when an item Performance 
Monitor or Main is selected from the Storage Navigator menu. However, more than one Login 
window can be launched. 
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Chapter 3 Working with Reports from the Main Console 

Some Tuning Manager reports are displayed by using Main Console, and some are displayed by 
using Performance Reporter. This chapter describes the reports that are displayed by using 
Main Console. 

With Tuning Manager, you can also use the command line interface (CLI) to display reports. For 
details about commands, see the HiCommand Tuning Manager Command Line Interface Guide. 

� Overview (see section 3.1) 

� Generating Reports (see section 3.2) 

� Exporting Reports (see section 3.3) 

� Bookmarking Reports (see section 3.4) 

� Printing Reports (see section 3.5) 
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3.1 Overview 

The Main Console displays the metrics collected by an Agent in formats such as graphs and 
tables. The definitions necessary for displaying the metrics graphically, as well as the graphs 
and tables based on those definitions, are called reports. 

By displaying appropriate reports according to monitored targets, the system performance can 
be analyzed and the storage and filesystems capacities can be monitored. 

3.1.1 Features of Reports Displayed with Main Console 

The reports displayed by using Main Console allow you to perform the following operations: 

� Obtain an overview of the system, perform comparative data analysis, and understand 
trends 

� Display data that is collected hourly 

� Formats of graphs to be displayed and time ranges are fixed 

� Display data stored in the central repository (HiRDB) 

� Display general data collected by the Agent 

� Display data from single-instance records  

� Display detailed information for each report item with a single click 

By analyzing the reports displayed by Main Console, your organization can: 

� Identify storage subsystems on the network. 

� Determine how many storage server hosts exist on your whole network and on its 
subnetworks. 

� Measure storage capacity network-wide and at progressively lower levels of your network. 

� Quantify filesystems, total capacity, amount used and amount remaining. 

� Detect and prevent capacity shortages. 

� Rearrange files and filesystems for effective capacity and performance use. 

� Detect and prevent storage server performance bottlenecks. 

� Determine when to acquire additional storage host capacity. 

� Understand the relationship between the host's filesystems, logical devices and 
corresponding disks. 

� Understand the RAID configuration and the necessary connections (Connected Ports, 
Connected Array Groups, Connected Logical Disks, Connected CLPRs, and Connected 
Subsystems) of the storage device associated with a host's filesystems. 

� Ensure that the logical volumes are configured correctly for the applications accessing 
data stored in the host's filesystems. 
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Note: Tuning Manager cannot provide metrics for certain resources under certain 
circumstances. These are the result of limitations within certain operating systems, software 
and/or hardware. For detailed information, see Appendix A. 

3.1.2 Types of Reports Displayed with Main Console 

For each resource, you can display reports relating to its capacity and performance. The 
following five types of reports are available from the Main Console, to match the purpose of 
the metrics analysis: 

� Resource Summary 

Displays key measures of capacity or performance for the resources at the level selected in 
the Navigation area. 

� Sub-resource Summary 

Displays key measures of capacity or performance for the resources below the level 
selected in the Navigation area. 

� History 

Displays key data that was collected from the resource for a specified time period. 

� Forecast 

Predicts future values by using data that was collected from the resource in the Last 
Record at the configured time intervals. 

� List 

Displays in table format key data about resources. 
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3.1.3 Specifying a Reporting Timeframe 

The Report Window Setting window is used in Tuning Manager to specify a time frame and 
period for reporting purposes. The settings specified in the Report Window Setting window are 
active for the login session, and are applied to reports and charts that are displayed by using 
the Advanced Information hyperlink. 

At the start of each session (a session starts after each new login and ends when you log out), 
default settings are restored in the Report Window Setting window. By default, Last Record is 
selected (Last Record is defined in Glossary) and Time Interval is set to Hourly. If you want to 
analyze other time periods, make sure to specify the settings again in the Report Window 
Setting window after you log in. 

Note: In an environment in which the time zone is set using the GMT + XX:YY format (YY must 
not be zero), Tuning Manager handles the data collected at XX:YY as the data collected at 
XX:00. 

To specify settings in the Report Window Setting window: 

1. In the Title area in the Application area, click the Report Window hyperlink. 

The Report Window Setting window appears. 

2. Select the time: 

Select Last Record, or specify the month, day, year, and time. Specify 24:00 to include all 
possible data points for the specified date. A Data Point is a specified time for when data 
is to be collected, in order to determine the hourly average. 

3. Specify the Period interval. 

4. Click Save. 

A Confirmation window appears. 

5. Click OK. 

The new time interval that is specified in the Report Window Setting window is displayed in 
the Title area. 

Tuning Manager performs a new database filtering operation and refreshes the display for 
your selected resource to conform with your newly specified settings. 

Changing Settings of the Report Windows Setting Window and Moving Resources 

To provide accurate datasets for any settings you specify in the Report Window Setting 
window, Tuning Manager keeps historical data intact. This becomes evident if you move a 
storage-related host on a given day and then request data of an earlier time period. 
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Example: 

a) As a part of network reorganization, your network system administrator moves Server 
1 from Subnetwork A to Subnetwork C on May 1, 2004. (This occurs outside of Tuning 
Manager.) 

b) On June 10, 2004 you load Tuning Manager. April 15, 2004 is the date specified in the 
Report Window Setting window. In this case, Tuning Manager will include Server 1 as 
one of the servers on Subnetwork A. If you change the date in the Report Window 
Setting window to May 15, 2004, Tuning Manager shows Server 1 as a part of 
Subnetwork C. 

3.1.4 Data Rounding Rules and Displayed Values 

When Tuning Manager presents data for daily, weekly and yearly periods, the values are the 
result of aggregating and averaging hourly data. For example, a daily value for Used is the 
average of all hourly data points for a given day.  

� The values displayed are the result of aggregating and averaging of the raw data (for daily, 
monthly, and yearly periods). To obtain the result, Tuning Manager sums the raw hourly 
values and then averages. Then Tuning Manager displays a rounded whole number in table 
displays. This is for presentation purposes only. The database repository stores raw values 
and graphical charts are plotted to those raw values. 

� Many of the measured data items are stored as decimal values but are displayed as whole 
numbers in the Summary area of each window. 

For information on rounding as this affects the behavior of alerts, see section 6.6. 

3.1.5 Data Aggregation Rules and Calculations 

When communications fail for long periods, or an Agent disconnects, or an Agent’s host 
machine is taken offline, data cannot be collected. Even if data is not collected for a long time, 
you can still collect it by using the method shown in section 3.1.5.1. 

Note: Unavailable data can be the result of one or more contributing factors. A resource may 
have been taken offline for maintenance or replacement. Communications may have been 
removed or interrupted. Refer to the HiCommand Tuning Manager Command Line Interface 
Guide. 
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3.1.5.1 Averaging Data for an Individual Resource 

Data monitored by Tuning Manager is commonly recorded on an hourly basis.  

When daily values are displayed, these are aggregated from the hourly data points collected 
during the 24-hour period.  

Averaging operations work as follows: 

1. Each available hourly value is aggregated for that resource. 

2. The aggregate of the hourly values is then divided by the number of available data points. 
(Any anticipated hourly periods remaining uncollected are not included in the divisor.) 

Goal: 

If for any reason, one or more hours are not available for summing, the averaged value is 
not diluted by including unavailable data points in the sum or divisor. 

Example: 

Server B is taken offline for 3 hours on Tuesday. To obtain the day's free capacity on Server 
B, Tuning Manager sums up free capacity values for each of Tuesday's 21 available hourly 
data points and then divides that total by 21.  

 

Figure 3.1 Example Aggregation Formula for One Day Interval (Free Space) 

3.1.5.2 Aggregation After Startup 

Tuning Manager is subject to a configurable ceiling on the initial data collection period. At 
startup, Tuning Manager will collect all available agent data within that maximum time period. 

This data collection ceiling is only a factor if agents have been running for a time period that 
exceeds the Tuning Manager startup collection maximum. When you startup Tuning Manager 
under those circumstances, earlier time periods will not be collected. Therefore uncollected 
agent data are not included in the aggregated data. 
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3.1.5.3 Summarizing and Aggregating Sub-resource Data 

At each level of the Navigation area, Tuning Manager displays summary values for its 
sub-resources. (The subnetwork values are summations of its servers, and the server values are 
summations of its filesystems.) 

1. Calculate hourly aggregate values for the parent resource (for each attribute):  

Aggregate the hour's value for all sub-resources to create a parent value. 

2. Assemble all hourly parent values:  

Repeat previous step for each hour in the time period. 

3. Calculate the parent's aggregate value for time period:  

Aggregate all hourly parent resource values across all time periods. 
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3.2 Generating Reports 

From the Main Console, you can perform the following tasks with the displayed reports: 

� Change the order of data in the Device File column by changing the sort order of data in 
the I/O Response Time column (descending order)  

� Register the graphs that are often viewed to Favorite Charts for ongoing display 

� Change the display conditions to display the past history data and the forecast data 

� Display the information used to determine whether the cause of the performance 
bottleneck originated from the server or storage. 

3.2.1 Displaying Reports with Main Console 

To display a report: 

1. In the explorer area, choose the Explorer menu and then Resources. Then select the 
resource for which you want to display reports. 

Information about the top level resource appears in the Report area. 

2. In the tree in the Navigation area, select the level you want to expand. 

Information about the selected level appears in the Application area. 

3. In the Tab area, choose the Performance or Capacity tab. 

Table 3.1 lists the information displayed in each area. 

Table 3.1 Area Names in the Application Area and Displayed Information 

Area name Displayed information 

Summary area This area displays a table that summarizes the primary values about 
the resource level selected in the resource tree. 
This information is useful as an overview of resources. 

Information area (Sub-resource Section) This area displays a table showing the basic information about the 
resources at the level lower than that of the resource for which 
information is displayed in the Summary area. 
This information is useful as an overview of the resources at the next 
lower level.  Sorting the table allows you to find the resource that has 
a particular value. 

Information area (Advanced Information) This area displays a list of reports in which historical trends and 
forecast values are displayed. Clicking the link for each report 
displays graphs and the basic information table. 
This information is useful for viewing details about a resource, or 
information about the servers or storage connected to the resource. 

4. In Advanced Information, select the report which you want to display. 

A report type is set for each report shown in Advanced Information. These types are 
described in Table 3.2. 
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Table 3.2 Report Types 

Report type Description 

Resource Summary Displays key measures of capacity or performance for the resources 
at the level selected in the Navigation area. 

Sub-resource Summary Displays key measures of capacity or performance for the resources 
below the level selected in the Navigation area. 

History Displays key data that was collected from the resource for a specified 
time period. 

Forecast Predicts future values by using data that was collected from the 
resource in the Last Record at the configured time intervals. 

List Displays in table format key data about resources. 

The display of reports in Advanced Information can be changed as required. The display type 
that can be changed differs depending on whether the report is related to performance or to 
capacity. Table 3.3 shows the display types that can be changed for each report. 

Table 3.3 Display Types That Can Be Changed for Each Report 

Report type Display types that can be changed 

 Changed using a tab Changed using a hyperlink 

Performance IOPS � IOPS 
� Read IOPS 
� Write IOPS 

 Transfer � Transfer 
� Read Transfer 
� Write Transfer 

Capacity Capacity � Capacity 
� Used 
� Free 

� Bar-Graph 
� Pie-Graph 

Note: The display of some reports cannot be changed. 
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3.2.2 Sorting Data Tables 

Advanced Information reports consist of a chart with an accompanying data table.  

� To sort the data by a column other than the default column, click the column heading. 

� To toggle the sort order from ascending to descending, click the column heading again. 

Every table can be sorted. The column which controls the current sort displays an arrow. 

� An upward arrow on a column indicates the table is sorted ascending on that column.  

� A downward arrow on a column indicates the table is sorted descending on that column.  

Note: Data can be sorted on only one column at any time.  

3.2.3 Displaying a Favorite Chart 

This section describes the Favorite Charts display. 

� You can save many Advanced Information charts for routine display.  

� If you save a chart, it appears in Favorite Charts in the Information area for that particular 
resource. Tuning Manager reloads these charts every time you select that particular 
resource in the Navigation area. 

� All eligible charts display a Save hyperlink. 

� Displaying Favorite Charts by clicking Favorite Charts in the Information area enables you 
to edit and print reports, and export data. 

Note: Favorite Charts does not appear in the Information area until you have saved at least 
one Advanced Information report. 
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3.2.3.1 Adding a Favorite Chart 

Favorite Charts are Advanced Information graphs saved for ongoing display in Application 
Area. 

If you save a chart, it appears in Favorite Charts in Information Area for that particular 
resource. Tuning Manager reloads these charts every time you select that particular resource 
in Navigation Area. 

Note: All eligible charts display a Save hyperlink.  

To save a chart: 

1. In Advanced Information in the Information area, select the information for which you 
want to display an Advanced Information report. 

2. Click Save. 

Tuning Manager displays a window where you specify the description for a chart. 

3. Type in a chart description. This will appear as a caption below the chart when it appears 
in Favorite Charts in the Information area. 

4. Click Save. 

The confirmation window appears. 

5. Click OK to close the confirmation window. 

The saved chart appears in Favorite Charts in the Information area. 

Notes: 

– The tables accompanying charts are saved with your current sort settings. For more 
information on sorting, see section 3.2.2. 

– When you register a report to Favorite Charts, the date and time that was specified in 
the Report Window Setting window is assigned to the report. Even if you change the 
settings in the Report Window Setting window later, the display for the report saved in 
Favorite Charts will not be updated. 

– Favorite Charts does not appear in the Information area until you have saved at least 
one Advanced Information report. 
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3.2.3.2 Deleting a Favorite Chart 

To remove a chart from Favorite Charts in the Information area: 

1. In Navigation Area, select the desired level to display the charts that you want to delete. 

2. In Favorite Charts in the Information area, click Edit. 

The Delete Saved Reports window appears. 

3. For each report you want to remove from Favorite Charts, select its checkbox.  

4. Click Submit. 

A confirmation dialog box appears. 

5. Click OK to confirm deletion. 

3.2.4 Setting Display Conditions for History Reports 

The first time you request a history report in a session, Tuning Manager uses the settings in the 
Report Window Setting window to determine the last possible ending point and time interval. 
When you edit the history report, you can alter the following values: 

� Interval 

� Time frame 

– Relative method: select a finite number of intervals. The history report is created by 
using past data that is collected based on the interval settings specified in the Report 
Window Setting window. For more information, see section 3.1.3. 

– Absolute method: specify a start date/time and ending date/time. 

To edit a history report: 

1. Display the report. 

2. Click Edit. 

The dialog box for editing report parameters appears. 

3. Specify a time interval. 

4. Determine whether to use the absolute or relative method for the time frame: 

– For the absolute method, specify the starting and ending dates/times 

– For the relative method, specify the Time Interval setting in the Report Window 
Setting window (that is, the last possible time period you want to appear in the report), 
and then specify the last number of records (Last n records).  

5. Click Update (or click Cancel to cancel the changes). 

The report is regenerated and the window refreshes. 

Note: By changing the settings for any history report you are setting the defaults for any other 
history reports you request during this session. (You may again edit reports to change settings 
as necessary.) 
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3.2.4.1 History Report Defaults 

When you invoke the History Editing dialog box for the first time in a session, these are the 
defaults: 

� History use data collected in the Last Record defined in the Glossary. 

� History reports are dependent on the interval setting specified in the Report Window 
Setting window. If the interval is currently set to Hourly, then your history report will use 
Hourly data. 

� If you are viewing a forecast you have previously customized (edited) and saved to 
Favorite Charts, this report has been saved with your customizations (and not with the 
application-defined defaults). 

� If you have customized a History report at any time during a session and you display an 
unsaved History report, that newly displayed History will inherit the customization settings 
of your most recently customized History. 

3.2.4.2 Sub-resource History Reports 

If you are using the relative method of specifying history records for a sub-resource history 
report, the Last Record is the latest record time posted within the group of sub-resources. 

Your network may be reorganized and updated after you have saved reports. Tuning Manager 
behaves as follows when you add resources to the network some time after you save a 
sub-resource report: 

� If a report requires you to specify the sub-resources you want included (as in a 
sub-resource history report), the report will not incorporate newly introduced 
sub-resources.  

To report including the newly introduced sub-resource(s): 

– Delete the obsolete report. See section 3.2.3.2. 

– Move the Navigation area to the appropriate parent resource level, then open the 
specified report.  

– Edit the report including the new resource(s).  

– Save the report. See section 3.2.3.1. 

� For sub-resource reports that do not require you to specify the sub-resources, the report 
will display data for the newly added resource(s) on subsequent viewings. 
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3.2.5 Setting Display Conditions for  Forecast Reports 

When the Forecast editing dialog box is invoked for the first time in a session, the default 
values are used: 

� Forecasts use data collected in the Last Record defined in the Glossary and recent time 
intervals to project future values. 

� Forecasts use retrospective historical data moving back from Last Record for projecting 
future values.  

� Forecasts are dependent on the interval setting specified in the Report Window Setting 
window. If the interval is currently set to Hourly, then your forecast will use Hourly data. 

Note: If you are viewing a forecast you have previously customized (edited) and saved, this 
report has been saved with your customizations (and not the application-defined defaults). 

When editing a report, you can change the following values: 

� Time interval 

� History 

� Forecast starting point 

� Forecast 

� Forecast accuracy 

To edit a Forecast report: 

1. Display the report. 

2. Click Edit. 

The dialog box for editing report parameters appears. See Figure 3.2. 

3. In the Time Interval field, specify a time interval. 

4. In the History field, specify how many data points (records in the Tuning Manager's 
database) should be used as a historical sample (the basis for building a forecast). 

5. To determine the Starting from data point: 

– Select Last Record defined in the Glossary or Absolute Start Date/Time. 

– If you select Absolute Start Date/Time, then fill in values for the date and time of a 
period available in the Tuning Manager database. This date will be used as the most 
recent historical point from which the forecast will be projected. 

6. In the Forecast field, specify how many records to be included in the forecasted period. 

Note: Good forecasts depend on a reasonable historical sample. At a minimum, a forecast 
should be based on 3 history data intervals. For the best possible results, specify a higher 
number of history intervals. We recommend maintaining a history-to-forecast interval 
ratio of at least 4:1. (Example: If you are seeking two forecast periods, specify at least 
eight history intervals.) 

7. Specify the Confidence Level. 
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8. Click Update.  

The report is regenerated and the window refreshes. 

Note: When you customize (edit) a forecast, you are setting the values that will appear in 
any non-customized forecasts you request during this session. You may edit subsequent 
forecasts to change settings as necessary. 

If you want multiple forecasts to share the same customizations, request each forecast and 
then save each one. 

 

Figure 3.2 Edit Dialog Box for a Forecast 

3.2.6 Analyzing Whether Performance Bottlenecks Exist on the Host or Array 

Tuning Manager provides a method of analyzing whether performance bottlenecks exist on the 
host or array. The objective of analyzing host and array performance is to determine, based on 
the I/O Response Time, whether a deterioration in system performance is being caused by the 
host or by the array. 

As shown in Figure 3.3, two checkpoints are provided on the I/O path. The I/O Response Time 
values obtained at the checkpoints are compared in the window. 
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Figure 3.3 System Model Diagram 

By comparing the values shown in Table 3.4, you can determine which part of the system is 
causing a deterioration in system performance. 

Table 3.4 Performance Deterioration Patterns and Their Causes 

Checkpoint Cause of performance deterioration 

I/O Response 
Time (Host) 

I/O Response 
Time (Array) 

 

Fast Fast Group A (Server environment including the CPU and LAN) 

Slow Fast Group B (SAN environment including switches and ports) 

Slow Slow Group C (storage subsystem environment) 

Figure 3.4 shows an example of the window displayed for analyzing host and array 
performance. 
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Figure 3.4 Window for Analyzing Host and Array Performance 

The window for analyzing host and array performance is displayed for the following layers in 
the resource tree: Server, Filesystem Folder, Filesystem, Device File Folder, and Device File. 
This window does not apply to alerts. 
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Table 3.5 shows the information displayed for each layer. 

Table 3.5 Displayed Information by Layer 

Layer Records to be displayed 

Server Information about all the device files that exist on the server and about the logical 
devices connected to the device files 

Filesystem Folder Information about the device files that make up all the file systems that exist on the 
server and about the logical devices connected to the device files 

Filesystem Information about the device files that make up a file system and about the logical 
devices connected to the device files 

Device File Folder Information about all the device files that exist on the server and about the logical 
devices connected to the device files 

Device File Device file information and information about the logical devices connected to the 
device file 

The purpose of specifying settings in the Historical Report Window Setting window is to: 

� compare the I/O response times of the host and the array. 

� obtain values with past average values. 

3.2.6.1 Setting intervals for calculating average values 

When specifying settings in the Historical Report Window Setting window, you can set intervals 
for calculating average values. 

To specify settings in the Historical Report Window Setting window: 

1. In the Title area in the Application area, click the Historical Report Window hyperlink. 

The Historical Report Window Setting window appears. 

2. Select Enter absolute time (see Note) if you want to use a date range, or select Or, enter 
last N records if you want to use the number of records. When specifying the: 

– Enter absolute time setting, enter the start date and end date that you want to 
compare. 

– Or, enter last N records setting, enter the number of records that you want to 
compare with each other. 

Note: On the pull-down menu, select a year from 1970 to the current year, a month from 
Jan to Dec, a day from 01 to the last day of the month, and a time from 00 to 23. If you do 
not select Enter absolute time, the current time is displayed. If you select Enter absolute 
time, the previous setting is displayed. 

3. Click the Update button. 

Click the Cancel button to close the Historical Report Window Setting window. 

The settings specified in the Historical Report Window Setting window are now set. 
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3.2.6.2 Displaying Output Results 

The output results are displayed as the Host/Array Correlation tab in the information area 
(Sub-resource section) when the resource is Server, Filesystem Folder, Filesystem, Device File 
Folder, or Device File. 

Calculations of Historical Response Time and Delta values 

Figure 3.5 shows the calculations when a number of records are specified. Figure 3.6 shows the 
calculations when a period is specified. 

 

Figure 3.5 Calculations When a Number of Records are Specified 
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Figure 3.6 Calculations When a Period is Specified 

� The date specified in the Report Window Setting window may be a date that is earlier than 
the date specified in the Historical Report Window Setting window. In this case, also use 
the same calculation to obtain the delta value. 

� Tuning Manager uses the following calculations when the total number of records N is 
obtained from the period or from the number of records specified in the Historical Report 
Window Setting window. 

a) When all N data items exist 

Historical Response Time = ∑(data1 to dataN) / N 

b) When M of N data items exist, but L data items are missing 

Historical Response Time = ∑(data1 to dataN) / M (Nonexistent data is ignored.) 

c) When there is no data 

Historical Response Time = n/a 

� When the Report Window link in the Main window is clicked and the time period is then 
changed in the Report Window Setting window, the range shown for the specified number 
of records (Last N records) changes as shown in Figure 3.7. 
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Figure 3.7 Relationship Between Report Window Settings and Number of Records 
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3.3 Exporting Reports 

Tuning Manager exports reports to a CSV format file. This ASCII file format is suitable for use in 
widely available spreadsheet applications, such as Microsoft Excel, and desktop database 
programs. 

The CSV data which is obtained by the export function will be output in the UTF-8 character 
set. 

3.3.1 Example CSV Output 

� The first row displays the column heading of the original data table. 

� Every following row in a CSV file represents a new row in the source data table. 

� Each row displays the data items in the same sequence (column order) as the displayed 
table. 

� Each item in a row is delimited by a double quote character. 

� Each row is terminated by a new line. 

� The last row in a data table includes an extra new line. 

� Each value in a row (except the last item) is followed by a comma. 

An Advanced Information report displays this data table: 

 

Figure 3.8 Example Data Table in Advanced Information Report 
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An export operation creates an ASCII file that includes the following output: 

  
Port Performance : SLPR0,,,,,,, 
"Report Date: 09 26,2005 18:00",Span: Hourly,,,,,, 
Port,Port IOPS,Port Min IOPS,Port Max IOPS,Port Transfer(KB) 
USP(55014):CL1-A,30,40,60,"40,960.00" 
USP(55014):CL1-B,40,50,70,"51,200.00" 
USP(55014):CL1-C,50,60,80,"61,440.00" 
USP(55014):CL1-D,60,70,90,"71,680.00" 
USP(55014):CL1-E,70,80,100,"81,920.00" 
USP(55014):CL1-F,30,40,60,"40,960.00" 
USP(55014):CL1-G,40,50,70,"51,200.00" 
USP(55014):CL1-H,50,60,80,"61,440.00" 
USP(55014):CL2-G,60,70,90,"71,680.00" 
USP(55014):CL2-H,70,80,100,"81,920.00" 

 CSV files are easily imported into popular spreadsheet programs.  

 

Figure 3.9 CSV Imported Into Microsoft Excel 

3.3.2 Exporting Resource Summary Reports 

To export a Resource Summary report: 

1. In the Application Bar area, click the Export button. 

The dialog box for saving a file appears. 

2. Save the CSV file in an appropriate location. 
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3.3.3 Exporting Advanced Information Reports 

To export an Advanced Information data table: 

1. Display an Advanced Information report. 

2. Click Export. 

The web browser displays a file saving dialog box. 

3. Specify a file name. 

4. Submit the file saving dialog box. 

Note: When exporting Forecast report data, Tuning Manager only includes the forecasted data 
points. For data on the historical sample, generate the corresponding historical report. 

 

Figure 3.10 The Export Hyperlink 
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3.4 Bookmarking Reports 

Use the Bookmark feature to save frequently used Tuning Manager pages as links for future 
access. Tuning Manager saves them in its own bookmark list. 

You cannot copy or move saved bookmarks to other folders. 

3.4.1 Adding a Bookmark Folder 

1. In the explorer area, select Explorer and then Bookmarks. 

2. Click the bookmark folder expand icons as necessary to open the level where you want to 
insert a new bookmark folder. 

The bookmark tree opens. 

3. Navigate as necessary to the folder that will serve as the container for the new folder. 

4. Click the hyperlink for the containing folder. 

5. Click New Folder. 

6. Type in the name for the new folder. 

7. Click Save to retain the new folder name. (Or click Cancel to abandon.) 

3.4.2 Registering a Bookmark 

To register a new bookmark: 

1. In the Application Bar area, click the Bookmark button. 

Bookmark Setting appears in the Application area. The root of the Bookmark Tree is 
displayed by default. 

2. If you want to save a new bookmark in a subfolder, click the icons as necessary to change 
the folder level. 

Note: To add bookmark folders, see section 3.4.1. 

3. Type a phrase to uniquely describe this page in the Save bookmark as field. (Maximum 
length: 100 characters.) 

4. Click Save to add this bookmark to the list. 

The Confirmation window indicates success. 

5. Click Close to close the Confirmation window. 
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3.4.3 Accessing a Bookmark 

To access a bookmarked information page: 

1. In the explorer area, select Explorer and then Bookmarks. 

The Bookmark tree is displayed in Navigation Area and the Bookmark list appears in the 
Application area. 

2. Click the icons to expand nodes in the Bookmark tree until the desired bookmark folder is 
opened. 

The bookmarks contained in the desired bookmark folder are displayed in the Navigation 
area. 

3. Click the hyperlink for your chosen bookmark. 

The bookmarked page is displayed in the Report area. 

Even if you click the Bookmark link in the Application area, the bookmarked page is 
displayed in the Report area. 

3.4.4 Changing the Name of a Bookmark 

To change the description for a bookmark you previously saved: 

1. In the explorer area, select Explorer and then Bookmarks. 

The Bookmark tree appears in the Navigation area. The top-level node of this tree is 
Bookmarks. 

2. Click the icons to expand nodes in the Bookmark tree as necessary to display bookmark 
folders and the bookmarks they contain. 

3. Click the folder hyperlink for the folder holding the bookmark you want to edit. 

The Bookmark list for that folder appears in the Application area. 

4. Click the Rename link. 

A Bookmark Setting window appears with the current bookmark description. 

5. Type a replacement phrase to uniquely describe this page in the Save bookmark as field. 
(Maximum length: 100 characters.) 

6. Click Save to add this bookmark to the list. (Or click Cancel to abandon this bookmark.) 

7. Click Close to close the Confirmation window. 
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3.4.5 Deleting a Bookmark 

To delete a bookmark you previously saved: 

1. In the explorer area, select Explorer and then Bookmarks. 

The Bookmark tree appears in the Navigation area. The top-level node of this tree is 
Bookmarks. 

2. Click the icons to expand nodes in the Bookmark tree as necessary to display bookmark 
folders and the bookmarks they contain. 

3. Click the folder hyperlink for the folder holding the bookmark you want to delete. 

The Bookmark list for that folder appears in the Application area. 

4. Click Delete. 

A confirmation dialog box appears requesting your confirmation. 

5. Click OK to confirm deletion. (Or click Cancel to abandon changes.) 

If you clicked OK, the Bookmarks List no longer displays the deleted bookmark. 

3.4.6 Deleting a Bookmark Folder 

1. In the explorer area, select Explorer and then Bookmarks. 

2. Click the bookmark folder expand icons as necessary to open the level where you want to 
insert a new bookmark folder. 

The bookmark tree opens. 

3. Navigate as necessary to the level that contains the folder you want to delete. 

4. Click the hyperlink for the containing folder. 

5. In the Application area, click the Delete hyperlink for the folder you want to remove. 

A confirmation dialog box appears. 

6. Click OK to delete the folder. (Or click Cancel to abandon.) 
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3.5 Printing Reports 

To print a report displayed in the Main Console, use either of the following methods: 

� Click the Print View button in the Application Bar area. 

Use this when printing Summary area or Information area (Sub-resource Section) reports. 

� Click the Print hyperlink in the Advanced Information Report window. 

Use this when printing Advanced Information reports.  
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Chapter 4 Working with Reports from Performance Reporter 

Some Tuning Manager reports are displayed by using Main Console, and some are displayed by 
using Performance Reporter. This chapter describes the reports that are displayed by using 
Performance Reporter. 

With Tuning Manager, you can also use the command line interface (CLI) to display reports. For 
details about commands, see the HiCommand Tuning Manager Command Line Interface Guide. 

� Overview (see section 4.1) 

� Generating Reports (see section 4.2) 

� Exporting Reports (see section 4.3) 

� Bookmarking Reports (see section 4.4) 

� Printing Reports (see section 4.5) 
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4.1 Overview 

Performance Reporter displays the performance data collected by an Agent in formats such as 
graphs and tables. The definitions necessary for displaying this data graphically, as well as the 
graphs and tables based on those definitions, are called reports. 

4.1.1 Features of Reports Displayed with Performance Reporter 

The reports displayed by using Performance Reporter allow you to perform the following 
operations: 

� Analyze trends and performance in detail 

� Display detailed data by the minute 

� Specify display formats of graphs and change time ranges 

� Display data from the local Agent’s data store (the Store database) for historical reports  

� Display all data collected by an Agent 

� Display data from single-instance records or multiple-instance records 

4.1.2 Types of Reports Displayed with Performance Reporter 

Performance Reporter can display both historical reports and real-time reports. A historical 
report displays data from a specified interval of time. A real-time report displays temporarily 
collected, current data. 

Any of the following three report types can be selected, as appropriate to the analysis 
objectives for the performance data: 

� Historical report (single Agent): This type of report displays one Report window for each 
Agent. When multiple Agents are selected, the report displays as many windows as the 
number of Agents you have selected. A single-Agent historical report handles the following 
record types: 

– Single instance 
Records that use a single instance as their evaluation target. A record for which only 
one row is created for one data collection is called a single-instance record. 

– Multiple instances 
Records that use multiple instances as their evaluation target. A record for which 
multiple rows are created for one data collection is called a multiple-instance record. 
This can be useful, for example, in comparing data in the same field in multiple 
Agents. 

� Historical report (multiple Agents): This type of report displays all selected Agents in a 
single window, regardless of whether a single report or multiple reports are selected. 
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� Real-time report (single Agent): Displays current data, temporarily collected, for a single 
Agent. The collected values can be displayed in order, and ranked. Note that past data 
cannot be obtained for display, since it is not stored in the Store database. Real-time 
reports (single Agent) support data from single-instance or multiple-instance records. 
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4.2 Generating Reports 

This section describes how to generate reports that are displayed by using Performance 
Reporter. 

For details about how to start Performance Reporter, see section 2.6.2. 

4.2.1 Displaying Reports with Performance Reporter 

1. In the Navigation frame, choose the Agents tab. The Agent hierarchy is displayed. 

2. In the Navigation frame, select the desired Agent from the Agent hierarchy. 

3. In the Method frame, choose Display Report. 

4. From the report hierarchy, choose the name of the report you wish to display (see Figure 
4.1). 

If you start Performance Reporter by specifying an Agent in the Main Console, the Performance 
Reporter Main window displays the report hierarchy, so you can skip steps 1-3. 

 

Figure 4.1 Performance Reporter Main Window After Specifying a Report 
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4.2.2 Displaying Historical Reports 

An historical report uses performance data that is stored in the Agent’s Store database. To 
display an historical report, you must have specified Log = Yes in the jpcasrec update command 
so that the performance data to be displayed in the report will be stored in the Store database. 
Since Log = No is set by default for historical reports stored in the Advanced folder for a 
solution set, you must change the setting to display these reports. 

For details about the jpcasrec update command, see the HiCommand Tuning Manager 
Command Line Interface Guide. For details about operating and managing the Store database, 
see the HiCommand Tuning Manager Agent Administration Guide. 

4.2.3 Displaying Real-time Reports 

A real-time report, indicating the current states of monitoring targets, uses the performance 
data collected by the Agent each time a report is displayed. This performance data is not 
stored in the Store database. For this reason, you do not need to make settings for storing 
performance data in the Store database. For details about the commands, see the HiCommand 
Tuning Manager Command Line Interface Guide. 

Note: Performance Reporter can display a maximum of 32,767 instances in real-time reports. 

4.2.4 Changing Report Displays 

When a report is displayed, you can change the data collection period and filter conditions that 
were set during report definition. You use the Show Options tab in the Report window to 
change report display conditions. 

To change report display conditions: 

1. From the Performance Reporter Main Window, select the desired report. This will open the 
Report window, Report tab. The Report tab is the default view. Select the Show Options 
tab. 

2. Change conditions as desired, and then select OK. The new conditions are applied, and the 
Report window is displayed again. 

The display conditions displayed in the Show Options tab differ depending on whether the 
report is a historical report or real-time report. 
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4.2.5 About Report Display Formats 

Performance Reporter can display reports in various formats: 

� Column graph (see section 4.2.5.1) 

� Stacked column graph (see section 4.2.5.2) 

� Bar graph (see section 4.2.5.3) 

� Stacked bar graph (see section 4.2.5.4) 

� Pie graph (see section 4.2.5.5) 

� Line graph (see section 4.2.5.6) 

� Area graph (see section 4.2.5.7) 

� Stacked area graph (see section 4.2.5.8) 

� List (see section 4.2.5.9)  

� Table (see section 4.2.5.10) 

4.2.5.1 Column Graphs 

A column graph is appropriate for checking the status of each instance or Agent at given 
intervals. The initial display shows the data collected most recently. 

The X axis represents the instance, and the Y axis represents the usage status of the target 
resource. When multiple fields are set, each instance is shown separately on the X axis. For a 
single-instance report, each bar indicates a field set for display. For a multiple-instance 
report, a group of bars indicates an instance, and each bar shows the field(s) set for display. 

 

Figure 4.2 Sample Column Graph (Multiple-Instance Report) 
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4.2.5.2 Stacked Column Graphs 

A stacked column graph is appropriate for setting multiple fields for display and displaying the 
fields for each instance as a stacked bar. 

The X and Y axes are the same as for a column graph. If only one field is set, the graph becomes 
a column graph. 

Note: In a stacked column graph, the fields are stacked even if they do not represent related 
data. 

 

Figure 4.3 Sample Stacked Column Graph 

4.2.5.3 Bar Graphs 

The display characteristics for a bar graph are the same as for a column graph. 

 

Figure 4.4 Sample Bar Graph 
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4.2.5.4 Stacked Bar Graphs 

The display characteristics for a stacked bar graph are the same as for a stacked column graph. 

 

Figure 4.5 Sample Stacked Bar Graph 

4.2.5.5 Pie Graphs 

A pie graph is appropriate for displaying the value of each data field that is collected as a 
percentage of the total. For a single instance, only one circle is displayed. For multiple 
instances, each instance is indicated by a separate circle.  

Note: A pie graph does not account for the relationship among the fields. 

 

Figure 4.6 Sample Pie Graph Showing Multiple Instances 
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4.2.5.6 Line Graphs 

Line graphs are best suited for viewing changes in values over time for one Agent with a single 
instance. The X axis represents time, and the Y axis represents the usage status of the target 
resources. It is also possible to specify multiple Agents or multiple instances, but you can only 
define one field. 

 

Figure 4.7 Sample Line Graph (Multiple fields, Single Instance) 

 

Figure 4.8 Sample Line Graph (Single field, Multiple Instances) 
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4.2.5.7 Area Graphs 

An area graph is used to represent data value changes over time. The display characteristics 
are the same as for a line graph.  

 

Figure 4.9 Sample Area Graph 

4.2.5.8 Stacked Area Graphs 

The display characteristics for a stacked area graph are the same as for a line graph. Note that 
the stacked areas do not account for the relationship among the fields. 

 

Figure 4.10 Sample Stacked Area Graph 
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4.2.5.9 Lists 

Lists enable display of field values for each Agent or instance, and are especially appropriate 
for displaying multiple Agents or multiple instances. To display the information of another 
Agent or instance within the same data group, click the page navigation button displayed on 
the left side of the frame. To display the information of other data groups, click the data group 
navigation button on the Report window menu bar. Items in blue indicate that there is a 
drill-down report available for that item. 

Figure 4.11 shows a sample list. 

 

Figure 4.11 Sample List 

4.2.5.10 Tables 

A table is useful for viewing changes in field values over time. The default view is 20 lines of 
data in sorted order per page, which can be modified by changing the displayCountPerPage 
value in config.xml (see the chapter that describes setup of Performance Reporter in the 
HiCommand Tuning Manager Server Administration Guide for more information on 
config.xml). To view additional lines, click the page scroll button at the top right of the table. 
The Date and Time field is added as the first and last columns of a table. 

 

Figure 4.12 Sample Table 
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4.2.6 Directly Accessing Reports with Performance Reporter 

Launching Performance Reporter by clicking Global and then Go in the Global Tasks Bar area of 
Tuning Manager is called Context-Launch. 

To start Performance Reporter:  

In the Global Tasks Bar area, select Global and then Go. 

The Go menu has the submenus listed in Table 4.1. 

Table 4.1 Submenus of the "Go" Global Menu 

Submenu Description 

Performance Reporter Launches Performance Reporter. 

Device Manager Launches Device Manager. 
This submenu is not displayed in SSO mode because the Report Windows of other 
HiCommand products are displayed on the Dashboard. 

4.2.6.1 Stopping Performance Reporter 

To close the Main window of Performance Reporter and open a Report window, choose Exit 
from the Menu-bar frame of the Main window. 

If the Report Tree Selection window was started from the Main console, choose Cancel to close 
the window. The Report Tree Selection window also closes when a Report window is displayed, 
or when the user logs out from the Main Console. 

If one or more report windows do not close when you close the Main window, you can close 
them individually by selecting Close. Report windows may stay open if you: 

� are displaying more than 10 report windows 

� are opening any report windows (including drilldown reports) when the Performance 
Reporter Main window is closed 

� have launched more than one instance of Performance Reporter 

� entered a URL in the Main window 

� used the browser’s Refresh button 

Note: Even when there are fewer than 10 windows displayed, auto-refresh processing will be 
slow if auto-refresh is run for multiple real-time reports. In such cases, auto-refresh processing 
may also stop because the processing time exceeds the limit. 
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4.2.6.2 Starting Performance Reporter 

To start Performance Reporter, do the following: 

1. Start the Main Console. For information about starting the Main Console, see section 2.1. 

2. From the Main Console, open the Performance Reporter Main window or the Report Tree 
Selection window. 

You can then display a report by selecting it from among those listed in the Main window or the 
Report Tree Selection window. For information about starting the Report Tree Selection 
window from the Main console, see section 2.1. 

Note: If an error message is displayed when Performance Reporter is started from the Main 
Console, confirm that the Performance Reporter services are running. If they are not running, 
you need to start them manually. For details about starting and stopping the services, see the 
sections describing the starting and stopping of services in the HiCommand Tuning Manager 
Server Administration Guide. 

4.2.6.3 Starting with an Agent Specified 

Launch Performance Reporter with an Agent specified when you want to access information 
collected by a particular Agent.  

 

Figure 4.13 Performance Reporter Main Window, Agent Specified 
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4.2.6.4 Starting without an Agent Specified 

Launch Performance Reporter (without specifying an Agent) when you want to: 

� access information about a product that is not supported by the Main Console 

� reference information not specific to a particular Agent, such as information about the 
entire network. 

 

Figure 4.14 Performance Reporter Main Window, Agent Not Specified 

The Performance Reporter Main window opens as a separate window. You can open only one 
Performance Reporter Main window at a time. If you attempt to restart Performance Reporter, 
you overwrite the current window; no new window opens. 
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4.3 Exporting Reports 

Performance Reporter can export reports as CSV format files. The CSV data which is obtained 
by 'Export' function will be output in UTF-8 character set. 

4.3.1 Example CSV Output 

� CSV data is output as Data Header 1, Data Header 2, and Data. Data Header 1 consists of a 
line space, the report name, and a line space. Data Header 2 consists of either the column 
headings or the value set for a particular field. Data is displayed as one output row per 
record.  

� The character set is determined by the setting in characterCode in config.xml. 

� The linefeed code is set in lineSeparator in config.xml (for details about config.xml 
settings, see the chapter that describes Performance Reporter setup in the HiCommand 
Tuning Manager Server Administration Guide). 

� The end-of-file code is <EOF>. 

� The item delimiter is a comma. If a data value includes a comma (,), a quotation mark (“) 
or a linefeed code, the entire data value must be enclosed in quotation marks (“ “). 

� The date is displayed in the default format set by the locale or as specified in 
selectFormat of config.xml (for details about config.xml settings, see the chapter 
that describes Performance Reporter setup in the HiCommand Tuning Manager Server 
Administration Guide). 

For details about config.xml settings, see the HiCommand Tuning Manager Server 
Administration Guide. 

 

Figure 4.15 Sample CSV Output for System Overview (Text) 
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Figure 4.16 Sample CSV Output for System Overview (Table) 

4.3.2 Exporting Reports 

Use the GUI or the jpcrpt command to export a report. For details about the command, see 
the HiCommand Tuning Manager Command Line Interface Guide. 

To export a report using the GUI: 

1. Display the report that is to be output to a file. The Export link is displayed in the menu 
bar.  

2. Click the Export link in the report window. The file download screen is displayed.  

3. Name the file, then save it. The default file name is Export.csv. 
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4.4 Bookmarking Reports 

With Performance Reporter, you can bookmark a report and perform short-term display of 
reports. You can use a bookmark to display reports in fewer steps and simultaneously display 
reports for different Agents, and reports with different report definitions. This section 
provides an example in Windows to show how to bookmark a report and how to perform 
operations for the folders, bookmarks, and bookmarked reports that you create. 

You bookmark reports using the Bookmark Registration window. Figure 4.17 shows the 
Bookmark Registration window. 

Note: We recommend that you bookmark no more than 10 reports. 

 

Figure 4.17 Sample Bookmark Registration Window 

The Bookmark Registration window lets you specify the following settings: 

� The Refresh link updates the displayed information. 

� The Type a name of the bookmark field lets you specify the name of the bookmark. 
Values specified can be from 1 to 64 characters. 

� The Bookmarks button ( ) displays a hierarchy of bookmark folders, bookmarks, and 
bookmarked reports. 

� The name-of-bookmark-folder ( ) displays a list of stored bookmarks. 

� The bookmark-name ( ) displays a list of bookmarked reports. 

� The report-name ( ) displays a list of reports. report-name is displayed as report-name 
@ agent-name. If multiple Agents exist, their names are displayed separately by commas. 

� The New Folder button creates a new folder and displays the Bookmark Folder Creation 
window. 
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4.4.1 Registering a Report in a New Bookmark 

To create a new bookmark for a report: 

1. Click the Bookmark link in the common menu of the Report window. The Bookmark 
Registration window is displayed, with Bookmarks selected in the bookmark hierarchy. 

2. To create a new folder for storing bookmarks, click the New Folder button. The Bookmark 
Folder Creation window is displayed. 

3. Below Create a new bookmark folder, enter the name of the folder in Name. You can 
specify from 1 to 64 characters. 

4. Click the OK button. The Bookmark Registration window reappears. The Level A folder is 
selected in the bookmark hierarchy. 

5. In Type a name of the bookmark, enter the name of the report bookmark. 

6. Click the OK button. The bookmark for which Bookmark A was entered in Type a name of 
the bookmark is created in the Level A folder. The report is registered in the created 
bookmark Bookmark A. 

4.4.2 Registering a Report in an Existing Bookmark 

To register a report in a previously created bookmark: 

1. In the common menu of the Report window, click the Bookmark link. The Bookmark 
Registration window appears, with Bookmarks selected in the bookmark hierarchy. 

2. Click the bookmark in which you want to store the report. The clicked bookmark is 
selected. The “Add to bookmark ‘bookmark-name’” is displayed. 

3. Click the OK button. The report is registered in the bookmark. 

4.4.3 Refreshing a Report in a Bookmark 

To refresh a report registered in a bookmark: 

1. Click the Bookmark link in the common menu of the Report window. The Bookmark 
Registration window is displayed, with Bookmarks selected in the bookmark hierarchy. 

2. Click the report within the bookmark that you want to refresh. The clicked report is 
selected. The “Report ‘registered-report-name’ is updated.” is displayed. 

3. Click the OK button. A message box confirms the refresh. 

4. To refresh the selected report, click the OK button.  
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4.4.4 Working with Bookmark Folders 

You can perform the following folder operations in the Bookmarks tab of the Navigation frame 
in the Main window: 

� Adding a bookmark folder 

� Changing the names of a bookmark folder 

� Deleting a bookmark folder 

Figure 4.18 shows the Bookmarks tab of the Navigation frame in the Main window. 

 

Figure 4.18 Bookmarks tab 

The following text describes the items displayed in each frame of the Main window: 

Navigation Frame 

� Refresh updates the displayed information. 

� The Bookmarks button ( ) displays a hierarchy of bookmark folders, bookmarks, and 
bookmarked reports. 

� The name-of-bookmark-folder button ( ) displays a list of stored bookmarks. 

� The bookmark-name button ( ) displays a list of bookmarked reports. 

� The report-name button ( ) displays a list of reports. report-name is displayed as 
report-name@agent-name. If multiple Agents exist, their names are displayed separately 
by commas. 

Method Frame 

The methods displayed in the Method frame differ, depending on the object selected. For 
details, see the explanation for each operation. 

Information Frame 

The windows displayed in the Information frame differ, depending on the selected 
method. For information about these windows, see the explanation for each operation. 
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4.4.5 Adding a Bookmark Folder 

To add a folder to a bookmark: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click Bookmarks or a folder within to which you want to add a 
folder. The clicked folder is selected. 

3. Select the New Folder method in the Method frame. The New Folder window is displayed 
in the Information frame. 

4. Enter the name of the folder in New name of the bookmark folder. 

5. Click the OK button. A folder is added to the bookmark hierarchy of the Navigation frame. 

4.4.6 Changing the Name of a Bookmark Folder 

To change the name of a folder: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the folder in Bookmarks whose name you want to change. 
The clicked folder is selected. 

3. In the Method frame, select the Rename method. The Rename window is displayed in the 
Information frame. The current name of the folder is displayed in Current name of the 
bookmark folder. 

4. Enter the new name for the folder in New name of the bookmark folder. 

5. Click the OK button. The name of the selected folder is changed. 

4.4.7 Deleting a Bookmark Folder 

When you delete a bookmark folder, you also delete the folders, bookmarks, and reports 
within the folder. 

To delete a folder: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the folder in Bookmarks that you want to delete. The 
clicked folder is selected. 

3. In the Method frame, select the Delete method. A message box confirms the deletion. 

4. To delete the selected folder, click the OK button. The selected folder is deleted. 
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4.4.8 Report Bookmark Operations 

You can perform the following operations for bookmarks, in the Bookmarks tab of the Main 
window of Performance Reporter. 

� Accessing a Bookmark 

� Changing the name of a bookmark 

� Deleting a bookmark 

� Displaying the properties of a bookmark 

4.4.9 Accessing a Bookmark 

To display a bookmarked report: 

1. Select the Bookmarks tab in the Navigation frame of the Main window. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the bookmark containing the report you want to display. 
The clicked bookmark is selected. 

3. In the Method frame, select the Display Report method. The report registered in the 
bookmark is displayed in the Report tab of the Report window. 

4.4.10 Changing a Bookmark Name 

To change the name of a bookmark: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the bookmark in Bookmarks or in the bookmark folder 
whose name you want to change. The clicked bookmark is selected. 

3. In the Method frame, select the Rename method. The Rename window is displayed in the 
Information frame. The current name of the bookmark is displayed in Current name of the 
bookmark. 

4. Enter the new name for the bookmark in New name of the bookmark. 

5. Click the OK button. The name of the selected bookmark is changed. 
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4.4.11 Deleting a Bookmark 

To delete a bookmark and its associated reports: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the bookmark in Bookmarks or in a bookmark folder 
whose you want to delete. The clicked bookmark is selected. 

3. Select the Delete method in the Method frame. A message box confirming deletion is 
displayed in the Information frame. 

4. If you want to delete the selected bookmark, click the OK button. The selected bookmark 
is deleted. 

4.4.12 Displaying Bookmark Properties 

To display the properties of a bookmark: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the bookmark whose properties you want to view. The 
bookmark is selected.  

3. In the Method frame, select the Properties method. The Properties window is displayed in 
the Information frame (see Figure 4.19). 

 

Figure 4.19 Properties Window 
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Following are descriptions of the items that are displayed in the Properties window: 

Bookmark Name 

Displays the name of the bookmark. 

Registered report 

Registered report name 

Displays “report-name @ agent-name” for the name of the report registered in the 
bookmark. If there are multiple Agents, the Agent name is divided by commas and is 
displayed. 

Original report name 

Displays the name of the report registered in the bookmark. 

Bound agents 

Displays the name of the Agent for the report registered in the bookmark. If there are 
multiple Agents, the Agent name is displayed every other line. 

Conditional expression 

Displays the condition expressions of the report registered in the bookmark. 

4.4.13 Working with Bookmarked Reports 

You can display reports and delete reports in the Bookmarks tab of the Main window of 
Performance Reporter. 

4.4.13.1 Displaying a Report 

To display a report: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the report that you want to display. The clicked report is 
selected. 

3. In the Method frame, select the Display Report method. The selected report is displayed 
in the Report tab of the Report window. 

You can also change the display conditions in the Show Options tab of the displayed Report 
window to refresh a bookmarked report, and re-register a report under a different name. 
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4.4.13.2 Deleting a Report 

To delete a report: 

1. In the Navigation frame of the Main window, select the Bookmarks tab. The bookmark 
hierarchy is displayed. 

2. In the bookmark hierarchy, click the report that you want to delete. The clicked report is 
selected. 

3. In the Method frame, select the Delete method. A confirmation message is displayed in the 
Information frame. 

4. To delete the selected report, click the OK button. The selected report is deleted. 

Note: When you delete the last report registered in a bookmark, the bookmark is also deleted. 
In this case, a message box confirming the deletion is displayed. 

4.5 Printing Reports 

Clicking the right mouse button in the frame of the Report window to select Print displays the 
Print Setup dialog box. The Print Setup dialog box differs depending on the OS or printer 
driver. 
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Chapter 5 Creating User-defined Reports 

Main Console and Performance reporter display reports that are predefined by Tuning Manager. 
Performance Reporter can display user-defined reports as well. You can use Performance 
Reporter to create the user-defined reports. 

This chapter describes how to create user-defined reports with Performance Reporter. 

� Defining Reports Using a Solution Set (see section 5.1) 

� Defining Reports Using Commands (see section 5.2) 

� Defining Reports Using the Report Wizard (see section 5.3) 

� Performing Operations to Define Reports (see section 5.4) 

� Displaying Reports (see section 5.5) 

� Displaying Report Properties (see section 5.6) 

� Setting and Changing Report Display Conditions (see section 5.7) 

� Deleting a User-defined Report (see section 5.8) 

� Example of Creating a New Report (see section 5.9) 

� Example of Customizing a Solution Set (see section 5.10) 

� Example of Creating a New Report with an OR Filter Condition (see section 5.11) 

� Example of Creating a Line Graph (Single field, Multiple Instances) (see section 5.12) 
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5.1 Defining Reports Using a Solution Set 

A solution set is a collection of reports and alarms that are ancillary to each Agent, and for 
which all necessary information has already been defined. When using a solution set, you can 
display pre-defined reports without defining any reports. If you want to display a report other 
than the reports defined in a solution set, define the report. You can also define a report by 
customizing a solution set. For an example of customizing a solution set, see section 5.10. 

Note: If you are using an agent with a version lower than 5.0, part of the graph display may be 
distorted. If this occurs, you need to create a customized solution set.  
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5.2 Defining Reports Using Commands 

To display a report, you must first define the display format and display conditions for that 
report. You define reports in Performance Reporter in either of two ways; by using the Report 
Wizard or by using commands. 

When you use commands, you define a report by specifying the XML parameter file of the 
report definition information in the jpcrdef create command argument. 

The following describes how to use commands to define a report. 

To use commands to customize a solution set: 

1. In XML format, create a parameter file that specifies items such as the name of the report 
definition for the target solution set and the folder. Use the jpcrdef output command to 
output the report definition information to an XML parameter file. For details on the 
jpcrdef output command format, an example of coding the parameter file, and parameter 
details, see the HiCommand Tuning Manager Command Line Interface Guide. 

2. Edit the output parameter file. You can specify an edited parameter file in the jpcrdef 
create command arguments to define a report. 

To use commands to create a new report: 

1. Create a parameter file that defines the information needed for the reports you will 
create. 

2. Specify the created parameter file in a jpcrdef create command argument to define a new 
report. For details on the jpcrdef create command format, an example of coding the 
parameter file, and parameter details, see the HiCommand Tuning Manager Command 
Line Interface Guide. 
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5.3 Defining Reports Using the Report Wizard 

The Report Wizard leads you through the steps for defining reports. To define a report using 
the Report Wizard: 

1. Open the Main window of Performance Reporter. 

2. Define a report folder. 

3. Start the Report Wizard. 

4. Define the name and type of the report. 

5. Define the fields displayed in the report. 

6. Define the display conditions for the fields in the report. 

7. Define the display information for the report. 

8. Define the display format for the report. 

9. Define the drilldown reports. 

The definitions for steps 4 through 9 above are performed in the windows of the Report Wizard. 
The items displayed on each screen, as well as the flow from screen to screen, depend on the 
settings performed during report definition. Figure 5.1 shows how to use the Report Wizard to 
define a report. 

 

Figure 5.1 Using the Report Wizard to Define a Report 
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Figure 5.2 shows the Report Wizard window. 

 

Figure 5.2 Report Wizard Window 

The following list describes the items displayed in each frame. 

Navigation Frame 

� The Refresh link updates the displayed information. 

� The User Reports ( ) area displays a hierarchy of the user-created folders and reports. 
You can create folders and reports within User Reports. 

� The System Reports ( ) area displays a hierarchy of the folders and reports for the 
solution set. 

� The name-of-directory-containing-report ( ) displays the names of the report folders, in 
alphabetical order. When you select a folder, a list of the reports contained is displayed. 

� The report-name( ) displays a list of reports. 

Method Frame 

� The Delete link deletes the folder. 

� The New Folder link defines a new folder. 

� The New Report link defines a new report. When you choose this, the Report Wizard is 
displayed in the Information frame. 

� The Rename link changes the name of the folder. 

Information frame 

The window displayed in the Information frame differs, depending on the method selected 
and contents specified. For information about these windows, see the explanation for each 
definition. 
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5.3.1 Defining a Report Folder 

To define a new folder in which reports are stored: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. Click User Reports, or a folder within in which you want to store reports. The clicked 
folder is selected. 

3. In the Method frame, choose the New Folder method. The New Folder window is 
displayed in the Information frame. 

4. In New name of the folder, enter the name of the folder. For example, to create a new 
folder named Htmprsvr, enter the information in Figure 5.3. 

5. Click the OK button. The defined folder is added. 

 

Figure 5.3 Example of a Setting in the New Folder Window 

5.3.2 Starting the Report Wizard 

To use the Report Wizard to define a report: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click the folder in which you want to store the defined report. The 
clicked folder is selected. 

3. In the Method frame, choose the New Report method. The New Report > Name and Type 
window is displayed in the Information frame. 
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5.3.3 Defining the Name and Type of a Report 

To define the name and type of the report: 

1. Set the information about the report name and type, in the New Report > Name and Type 
window. For example, when using Agent for Platform (Windows) and the version 4.0 data 
model to define a real-time report of the processes with the ten highest CPU usage ratios, 
make settings as shown in Figure 5.4. 

2. Click the Next > button. The New Report > Field window is displayed. 

 

Figure 5.4 Example of Settings for the New Report > Name and Type Window 

Following are descriptions of the window’s elements: 

Report Name 

Specify the report name. Values specified can be from 1 to 64 characters. 

Product 

Select the type of the agent (product) for setting up the report. If several data model 
versions are installed for one product, select the appropriate one for version of the data 
model used. 

Report Type 

Select the type of the report. Realtime (Single Agent) is selected by default. The 
selectable items are as follows: 

� Realtime (Single Agent) 

– Select this to display a real-time report of performance data by a single agent. 

� Historical (Single Agent) 

– Select this to display a historical report of performance data accumulated by a single 
agent. 
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� Historical (Multiple Agents) 

– Select this to display in one window a historical report of performance data 
accumulated by multiple agents. When this report is to be created, you cannot select 
multi-row records (multi-instance records) in the New Report > Field window. 

Next > 

The New Report > Field window is displayed. You can click this when both Report name 
and Product are specified. 

Finish 

The settings are saved, and the New Report > Name and Type window closes. You can click 
this only when Report name and Product are specified and the New Report > Field window 
has changed to the New Report > Name and Type window. 

5.3.4 Defining the Fields Displayed in a Report 

You define the fields displayed in the report using the New Report > Field window. The records 
and fields defined here differ, depending on each agent. For information about the records and 
fields for each agent refer to the manual for each agent. 

To define the fields in the report: 

1. In the Record of the New Report > Field window, select the records that you want to 
display. The fields for the records selected in All fields are displayed. 

For example, in Agent for Platform (Windows), to define a real-time report of the 
processes with the ten highest CPU usage ratios, set the following three fields for the 
Process Detail (PD) record: 

– PID (ID_PROCESS) 

– Program (INSTANCE) 

– CPU % (PCT_PROCESSOR_TIME) 

Figure 5.5 shows an example of settings for the New Report > Field window. 

2. In All fields, click the fields you want to display in the report. The clicked fields are 
selected. You may select multiple fields simultaneously. 

3. Click the   button. The fields selected in All fields are displayed in Selected fields. 
Once fields are set in Selected fields, you can clear any fields that you do not wish to 
select by selecting the fields in Selected fields, and clicking the  button. 

4. Click the Next > button. The New Report > Filter window is displayed. 
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Figure 5.5 Example of Settings for the New Report > Field Window 

Following are descriptions of the window’s elements: 

Record 

Select the records that you want to report. 

Below Record, the record type (single-row record or multi-row record) is displayed. 
Single-row record refers to a single-instance record, and multi-row record refers to 
multi-instance records. 

If Historical (Multiple Agents) is selected for Report type in the New Report > Name and 
Type window, only a single-row record can be selected in Record. 

Description button 

Displays a description of the record belonging to the product defined in the report, in the 
Record Description window.�You can only click this when the description file for the 
product defined in the report is set up. 

All Fields 

Displays a list of fields for the selected record. You can use the Shift key or Ctrl key to 
select multiple fields. 

This is blank by default. 

  

Adds the fields selected in All fields to Selected fields. 

  

Clears the fields selected in Selected fields. 
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Selected Fields 

Displays a list of the fields selected to be displayed in the report. This is blank by default. 

  

Shifts the field selected in Selected fields to the field above it. 

  

Shifts the field selected in Selected fields to the field below it. 

< Back 

The New Report > Name and Type window is displayed. 

Next > 

The New Report > Filter window is displayed. You can click this when Selected fields 
contains a field. 

Finish 

The settings are saved, and the New Report > Field window closes. You can click this when 
Selected fields contains a field. 

5.3.5 Defining the Display Conditions for Fields in a Report 

You define display conditions for fields in the report using the New Report > Filter window. You 
can also specify filter conditions using multiple condition expressions. 

To define display conditions: 

1. Set the information necessary to define the condition expression. For example, in Agent 
for Platform (Windows), to define a real-time report of the processes with the 10 highest 
CPU usage ratios, set the following conditions as filters for the Process Detail (PD) record: 

– When the value of the PID (ID_PROCESS) field is not 0: 

Figure 5.6 shows an example of a setting for the New Report > Filter window. 

2. Click the Next > button. 

– If Realtime (Single Agent) is selected for Report type in the New Report > Name and 
Type window, The New Report > Indication Settings (Real-time) window is displayed. 
Proceed to section 5.3.5.1. 

– If Historical (Single Agent) or Historical (Multiple Agents) is selected for Report type 
in the New Report > Name and Type window, The New Report > Indication Settings 
(Historical) window is displayed. Proceed to section 5.3.5.2. 
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Figure 5.6 Example of a Setting for the New Report > Filter Window 

Following are descriptions of the window’s elements: 

Field 

Select the field to be filtered. By default, no field is selected. 

Condition 

Select the operator that you want to apply to the field. This is blank by default.  

Table 5.1 lists the selectable values. 

Table 5.1 Field Operators 

Value Description 

= The value for Field and the value for Value are the same. 

< The value for Field is less than the value for Value. 

<= The value for Field is less than or equal to the value for Value. 

> The value for Field is greater than the value for Value. 

>= The value for Field is greater than or equal to the value for Value. 

<> The value for Field and the value for Value are different. 

Value 

Specify the value by which the condition expression is evaluated. This is blank by default. 

The specifiable format is shown to the right of Value. The specifiable values vary by the 
field. If Specify when displayed is selected, you do not need to specify anything. 

Specify when displayed 

Select this to specify or change the value for the condition expression when the report is 
displayed. By default, this is not selected. 
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AND 

Select this to use an AND operator to add the condition expression set by Field, Condition, 
Value, and Specify when displayed, to the condition expression displayed in Conditional 
expression. 

OR 

Select this to use an OR operator to add the condition expression set by Field, Condition, 
Value, and Specify when displayed, to the condition expression displayed in Conditional 
expression. 

Add 

Uses an AND or OR operator to add the condition expression set by Field, Condition, 
Value, and Specify when displayed, to the condition expression displayed in Conditional 
expression. When you set the first condition expression, the condition expression is set 
without adding an AND or OR condition. 

Update 

Replaces the condition expression selected in Conditional expression with the condition 
expression set by Field, Condition, Value, and Specify when displayed. You can select 
this when Field, Condition, Value, and Specify when displayed have been set. 

Conditional Expression 

Displays a list of created condition expressions. This is blank by default. 

Simple 

Select this when selecting only one condition expression. This is selected by default, and 
when only one condition expression exists. 

Complex 

Select this to select all condition expressions combined with AND and OR operators. 

AND<-->OR 

Toggles the operator of the condition expression selected in Conditional expression 
between AND and OR. 

Delete 

Deletes the condition expression selected in Conditional expression. If multiple condition 
expressions are selected, a confirmation message box is displayed. 

Delete All 

Deletes all condition expressions for Conditional expression. 

Edit 

Sets the condition expression selected in Conditional expression, in the Field, Condition, 
Value, and Specify when displayed fields, making it editable. 

< Back 
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The New Report > Field window is displayed. 

Next > 

– If Realtime (Single Agent) is selected for Report type in the New Report > Name and 
Type window: 

The New Report > Indication Settings (Realtime) window is displayed. 

– If Historical (Single Agent) or Historical (Multiple Agents) is selected for Report type 
in the New Report > Name and Type window: 

The New Report > Indication Settings (Historical) window is displayed. 

Even when no condition expression is set in Conditional expression, the next screen is 
displayed. In this case, the condition expression is blank. 

Finish 

The condition expression set in Conditional expression is saved, and the New Report > 
Filter window closes. 

When no condition expression is set in Conditional expression, the report is registered 
without a condition expression. 

5.3.5.1 Defining Display Information for Real-time Reports 

The display information for a real-time report is defined in the New Report > Indication 
Settings (Realtime) window. With Realtime (Single Agent) is selected for Report type in the 
New Report > Name and Type window, use the following procedure to define display 
information for a real-time report. 

1. Set the items necessary to define display information. For example, in Agent for Platform 
(Windows), to define a real-time report of the processes with the ten highest CPU usage 
ratios, set the following conditions for the display information of the real-time report for 
the Process Detail (PD) record: 

– Display the data in the report as delta values. 

– For the interval by which to automatically update the report display, set the initial 
value to 60 seconds, and the minimum value to 30 seconds. 

– Display the top ten results, based on the CPU % (PCT_PROCESSOR_TIME) field. 

Figure 5.7 shows an example of a setting for the New Report > Indication Settings 
(Realtime) window. 

2. Click the Next > button. The New Report > Components window is displayed. 
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Figure 5.7 Example of a Setting for the New Report > Indication Settings (Realtime) Window 

Following are descriptions of the window’s elements: 

Specify when displayed 

Select this to set the display settings when the report is displayed. By default, this is not 
selected. 

Indicate delta value 

Select this to display the data in the report as delta values. The data displayed in the 
report differs depending on the following conditions: 

– Whether Indicate delta value is selected or not. 

– Whether delta values are collected for the record fields displayed in the report or not. 

– Whether delta values are collected for the record fields depends on each of the fields. 
For information about whether delta values are collected into delta values and record 
fields, see the chapter on records (listing the fields for each record) in each agent 
manual. 

Table 5.2 explains the correspondence between the conditions and the values displayed in 
the report. In this table, “Yes” means delta values are collected and “No” means delta 
values are not collected. 
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Table 5.2 Conditions and Corresponding Values in Reports 

Indication Delta 
Value Setting 

DeltaAattribute of 
the Field 

Displayed Value 

Checked Yes The difference between the performance data collected previously and 
that recently collected 

Checked No The most recently collected value 

Not checked Yes The cumulative value since collection of performance data started 

Not checked No The most recently collected value 

Refresh interval 

Set the auto-refresh interval for when a real-time report is displayed in the Report 
window. 

Do not refresh automatically 

Select this to prevent the report display from automatically refreshing. By default, this 
is not selected. 

Initial value 

Specify the refresh interval (in seconds), for when the report display is automatically 
refreshed. The default is 60. 

The values that can be specified are integers from the value specified for Minimum 
value to 3,600. 

Minimum value 

Specify the minimum value (in seconds) for the refresh interval after which the Report 
window is displayed. You can change the updating interval when a report is displayed, 
in Refresh interval of the Show Options tab. 

The default is 60. 

The values that can be specified are integers from 10 to 3,600. 

Display by ranking 

Set this to display reports with the data of a certain field in ascending or descending order, 
when multi-row records (multi-instance records) are displayed in reports. 

Field 

Select the field by which the display is determined and the number of higher and lower 
items of data to display is as set in Display number. You can select from Field when 
multi-row records (multi-instance records) are selected for Record, in the New Report 
> Field window. 

Display number 

Specify the number of higher and lower items of data to display. This can be specified 
when a field is selected for Field. The default is 10. The values that can be specified 
are from 1 to 100. 
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In descending order 

Select this to display data in descending order, when multi-row records 
(multi-instance records) are displayed in reports. This can be specified when a field is 
selected for Field. 

< Back 

The New Report > Filter window is displayed. 

Next > 

The New Report > Components window is displayed. 

Finish 

The settings are saved, and the New Report > Indication Settings (Realtime) window 
closes. 

5.3.5.2 Defining Display Information for Historical Reports 

The display information for a historical report is defined in the New Report > Indication 
Settings (Historical) window. With Historical (Single Agent) or Historical (Multiple Agents) 
selected for Report type, use the following procedure to define display information for a 
historical report. 

Note: Keep the following in mind when changing the time settings for a server on which the 
Agent is running: 

� When the time of the server on which the Agent is running is set ahead of the current time, 
performance information is not displayed for the period from the time of the change until 
the new time that is set. 

� When the time of the server on which the Agent is running is set behind the current time, 
performance information for the period from the new time that is set until the time of the 
change is displayed as the overwritten data. 

1. Set the items necessary to define display information. For example, in Agent for Platform 
(Windows), to define a report summarizing CPU usage for each minute over the last hour, 
set the following conditions for the display information of the historical report for the 
System Overview (PI) record: 

– Specify the collection period for performance data when the report is displayed. 

– Set the report display interval to 1 hour. 

– Display only the data from the time at which the User CPU % 
(PCT_TOTAL_USER_TIME) fields reached its daily maximum. 

– Set the maximum number of records displayed in a report to 1,440. 

Figure 5.8 shows an example of a setting for the New Report > Indication Settings 
(Historical) window. 

2. Click the Next > button. The New Report > Components window is displayed. 
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Figure 5.8 Example of a Setting for the New Report > Indication Settings (Historical) Window 

The following text describes the items displayed in the New Report > Indication Settings 
(Historical) window. 

Specify when displayed 

Select this to set the display settings when the report is displayed. By default, this is not 
selected. 

Settings for the report display period 

Set the display period for the report. 

Date range 

Select the period for which performance data to be displayed in the report is to be 
collected. Specify when displayed is selected by default. 

Table 5.3 lists the periods that can be selected for performance data collection. 

Table 5.3 Performance Data Collection Periods 

Value Description 

Specify when displayed Specify the period when the report is displayed. 

Within the past hour Display data collected in the past hour. 

Within the past 24 hours Display data collected in the past 24 hours. 

Within the past 7 days Display data collected in the past 7 days. 

Within the past month Display data collected in the past month. 

Within the past year Display data collected in the past year. 
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Report interval 

Select the display interval for the report. 

You can select an interval for Report interval, when a PI record is selected for Record 
in the New Report > Field window. 

Table 5.4 lists the intervals that can be selected for the display interval of the report. 

Table 5.4 Report Display Intervals 

Value Description 

Minute Displays the report at one-minute intervals. 

Hour Displays the report at one-hour intervals. 

Day Displays the report at one-day intervals. 

Week Displays the report at one-week intervals. 

Month Displays the report at one-month intervals. 

Year Displays the report at one-year intervals. 

Peak time 

Set this to display the report only for the time at which the value of a field reached its daily 
maximum. 

Field 

Select the field for which the peak time is to be set, when only data from the time at 
which a certain field reaches its maximum value is displayed. Field can be selected 
when a single-row record (single-instance record) is selected Record in the New 
Report > Field window, and Hour is selected for Report interval. The default is 
(none). 

Maximum number of records 

Specify the maximum number of records to display in the report. The values that can be 
specified are from 1 to 2,147,483,647. However, the limit value when you initially display 
a report is the smaller value that either of maxFetchCount to be specified in 
config.xml or the maximum number of records is effective. 

< Back 

The New Report > Filter window is displayed. 

Next > 

The New Report > Components window is displayed. 

Finish 

The settings are saved, and the New Report > Indication Settings (Historical) window 
closes. 
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5.3.6 Defining the Display Format 

You can select from one of the following three display formats for a report. You can also 
display multiple display formats. 

� Table 

� List 

� Graph 

When Graph is selected as the display format, you can select a type of graph. You can also 
define a drilldown report, when you want to display a detailed report for a record. 

5.3.6.1 Defining the Display Format for a Report 

The display format of a report is defined in the New Report > Components window. 

To define the display format for a report: 

1. Set the information necessary to define the display format of the report. 

For example, in Agent for Platform (Windows), to define a real-time report of the 
processes with the ten highest CPU usage ratios, perform the following settings to display 
as a table a report for each field in the Process Detail (PD) record, and display as a graph 
a report of the CPU % (PCT_PROCESSOR_TIME) field. 

Figure 5.9 shows an example of a setting for the New Report > Components window. 

Note: You can also select multiple items from Table, List, and Graph as the display 
format. 

2. Click the Next > button. When at least one Graph is selected in the New Report > 
Components window, the New Report > Graph window is displayed. When no Graph is 
selected in the New Report > Components window, the New Report > Drilldown window is 
displayed. 

 

Figure 5.9 Example of a Setting for the New Report > Components Window 

Following are descriptions of the window’s elements: 
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Fields 

Displays the field selected in the New Report > Field window. 

Table 

Select this to display the selected field in tabular format, with rows and columns. By 
default, this is selected. 

List 

Select this to display the selected field in list format, with one line each, from the top or 
the list. By default, this is not selected. 

Graph 

Select this to display the selected field in graph format. If the Fields attribute is not a 
number, this cannot be displayed by graph format (N/A is displayed instead). By default, 
this is not selected. 

Display name 

Specify the name to be used as the title and column names for a table, list, or graph. This 
name must be within 24 characters. This is blank by default. If nothing is specified, the 
name of the field is displayed in the report. 

Display key 

Set the field to be used as a key. 

Field 

Select the field to be used as a sort key, when you want to display data sorted in the 
multi-row records (multi-instance records). You cannot specify Field in the following 
cases: 

– If Historical (Multiple Agents) is selected for Report type in the New Report > Name 
and Type window. 

– If Line, Area, or Stacked area is selected for Graph types in the New Report > Graph 
window. 

The default is (none). 

In descending order 

Select this when you want to display data sorted in the multi-row records 
(multi-instance records) in descending order. By default, this is not selected. In 
descending order cannot be set in the following cases: 

– If Historical (Multiple Agents) is selected for Report type in the New Report > Name 
and Type window. 

– If Line, Area, or Stacked area is selected for Graph types in the New Report > Graph 
window. 

By default, this item is not selected. 
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< Back 

– If Realtime (Single Agent) is selected for Report type in the New Report > Name and 
Type window, the New Report > Indication Settings (Realtime) window is displayed.  

– If Historical (Single Agent) or Historical (Multiple Agents) is selected for Report type 
in the New Report > Name and Type window, the New Report > Indication Settings 
(Historical) window is displayed. 

Next > 

– If Graph is selected in the New Report > Components window, the New Report > Graph 
window is displayed.  

– If Graph is not selected in the New Report > Components window, the New Report > 
Drilldown window is displayed. 

Finish 

The settings are saved, and the New Report > Components window closes. 

5.3.6.2 Defining a Graph Type 

If Graph is selected in the New Report > Components window, define the graph types and 
display format in the New Report > Graph window. 

To define the graph types and display format: 

1. Set the information necessary to define the graph type and display format. 

For example, in Agent for Platform (Windows), to define a real-time report of the 
processes with the ten highest CPU usage ratios, perform settings with the following 
conditions to display a graph with a report of the CPU % (PCT_PROCESSOR_TIME) field of 
the Process Detail (PD) record: 

– Set the y-axis to the value of the CPU % (PCT_PROCESSOR_TIME) field. 

– Set the x-axis to the name of the Program (INSTANCE) field, the value of the part 
within the parenthesis of the PID (ID_PROCESS) field. 

– Set the type of graph to a bar graph. 

Figure 5.10 shows an example of a setting for the New Report > Graph window. 

2. Click the Next > button. The New Report > Drilldown window is displayed. 

Note: When not defining a drilldown report, you can click the Finish button to complete 
the report settings. 
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Figure 5.10 Example of a Setting for the New Report > Graph Window 

Following are descriptions of the window’s elements: 

Graph types 

Select the graph types. In the following cases, you cannot select graphs of the Line, Area, 
or Stacked area type: 

– If Historical (Multiple Agents) is selected for Report type in the New Report > Name 
and Type window, and multiple settings are set for Graph in the New Report > 
Components window. 

– If the Display key item is selected in the New Report > Components window. 

– If a multi-row record (multi-instance record) is selected for Record in the New Report 
> Field window, and multiple items are selected for Graph in the New Report > 
Components window. 

The Column is selected by default. The following text describes the selection items. 

Column 

A column graph 

Stacked column 

A column graph in which multiple items are stacked 

Bar 

A bar graph 

Stacked bar 

A bar graph in which multiple items are stacked 

Pie 

A pie graph 
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Line 

A line graph 

Area 

A graph expressing change in data as a surface 

Stacked area 

An area graph in which multiple items are stacked 

Show areas of missing data 

If data is missing, for reasons such as the fact that the agent was not running, you can 
select the Show areas of missing data check box to prevent this data from being 
displayed. You can select this check box when Graph types is set to Line, Area, or Stacked 
area, and the following conditions apply: 

– Historical (Multiple Agents) is selected for Report type in the New Report > Name and 
Type window, and an item is selected for Graph in the New Report > Components 
window. 

– A multi-row record (multi-instance record) is selected for Record in the New Report > 
Field window, and an item is selected for Graph with no item selected for Display key 
in the New Report > Components window. 

Series direction 

Specify whether to have data displayed by row (record) or by column (field). By row is 
selected by default. 

By row 

Select this to have data displayed by row (record). 

By column 

Select this to have data displayed by column (field). 

Axis labels 

Set the x-axis and the y-axis of the report. 

X-axis 

Specify the character string for the title of the x-axis. This is blank by default. 

You can specify a value from 0 to 40 characters. 

Y-axis 

Specify the string for the title of the y-axis. This is blank by default. You can specify a 
value from 0 to 40 characters. 

Data label 

Set the field to be used for the display label of each record. 

Data label1 

Set the field to be used for the display label of each record. 

(none) is selected by default. 

You cannot set Data label1 when one of the following conditions is satisfied: 
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– Realtime (Single Agent) or Historical (Single Agent) is selected for Report type in 
the New Report > Name and Type window. 

– A single-row record (single-instance record) is selected for Record in the New 
Report > Field window. 

– Line, Area, or Stacked area is selected for Graph types in the New Report > Graph 
window. 

The fields displayed differ depending on the type of report. 

– When Realtime (Single Agent) is selected for Report type in the New Report > 
Name and Type window: 

The Record Time field is displayed. When a multi-row record (multi-instance 
record) is selected, the key field is also displayed. 

– When Historical (Single Agent) is selected for Report type in the New Report > 
Name and Type window: 

The Date and Time field is displayed. When a multi-row record (multi-instance 
record) is selected, the key field is also displayed. 

– When Historical (Multiple Agents) is selected for Report type in the New Report > 
Name and Type window, the Date and Time, Agent Host, and Agent Instance 
fields are displayed. 

Data label2 

Set the field to be used for the display label of each record. 

(none) is selected by default. 

You cannot set Data label2 when one of the following conditions are satisfied: 

– Data label1 is not set. 

– Realtime (Single Agent) or Historical (Single Agent) is selected for Report type in 
the New Report > Name and Type window. 

– A single-row record (single-instance record) is selected for Record in the New 
Report > Field window. 

– Line, Area, or Stacked area is selected for Graph types in the New Report > Graph 
window. 

The conditions for the fields displayed are the same as those for Data label1. 

The value selected for Data label2 is displayed in parenthesis following the value 
selected for Data label1. 

< Back 

The New Report > Components window is displayed. 

Next > 

The New Report > Drilldown window is displayed. 

Finish 

The settings are saved, and the New Report > Graph window closes. 
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5.3.6.3 Defining a Drilldown Report 

To display a detailed report of data displayed in a report, define a drilldown report in the New 
Report > Drilldown window. 

Figure 5.11 shows the New Report > Drilldown window. 

 

Figure 5.11 New Report > Drilldown Window 

Following are descriptions of the window’s elements: 

Report drilldown 

Sets up a drilldown report (report level). 

Report 

Displays a list of specified drilldown reports (report level). This is blank by default. 

Add 

Adds a drilldown report to Report. 

Change 

Changes a drilldown report in Report. 

Delete 

Deletes the drilldown report selected in Report. 

Field drilldown 

Sets up a drilldown report (field level). 

Bind 

Sets up a drilldown report (field level) to the field selected in Select. 
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Unbind 

Deletes the drilldown report (field level) for the field selected in Select. When the 
report is deleted, (No report is selected.) is displayed in Report. 

Edit Expression 

Modifies the filter condition expression for when the drilldown report is displayed. This 
can only be selected when a drilldown report (field level) is set up for the field 
selected in Select. 

Select 

Select the desired Field. By default, this is not selected. 

Field 

The fields for which a drilldown report (field level) can be set up are displayed. 

Report 

The drilldown reports (field level) set up for the fields are displayed. 

Conditional expression 

Displays a list of created condition expressions. 

< Back 

– When coming from the New Report > Components window: 

The New Report > Components window is displayed. 

– When coming from the New Report > Graph window: 

The New Report > Graph window is displayed. 

Finish 

The settings are saved, and the New Report > Drilldown window closes. 

There are two kinds of drilldown reports: report-level reports and field-level reports. 
Report-level reports display reports related to a certain report, while field-level reports 
display reports related to each field displayed in a certain report. The following text describes 
how to define each type of drilldown report. 

Defining a Drilldown Report (report level) 

To define a drilldown report (report level): 

1. Click the Add button in the New Report > Drilldown window. The New Report > Drilldown > 
Select Report window is displayed. 

2. Select the drilldown report to link to the report. For example, choose Process Detail. 

Figure 5.12 shows an example of a setting for the New Report > Drilldown > Select Report 
window. 

3. Click the OK button. The drilldown report selected for Report is displayed in the New 
Report > Drilldown window. 

4. Click the Finish button. The New Report > Drilldown window closes, and the settings for 
the report are completed. 
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Figure 5.12 Example of a setting for the New Report > Drilldown > Select Report Window 

Following are descriptions of the window’s elements: 

 User Reports 

Displays a hierarchy of the user-created folders and reports. 

 System Reports 

Displays a hierarchy of the folders and reports for the solution set. 

 name-of-directory-containing-report 

Displays the names of the report folders, in alphabetical order. When you select a folder, 
a list of the reports contained to the selected folder is displayed. 

 report-name 

Displays a list of reports. 

Refresh 

Updates the displayed information. 
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Defining a drilldown report (field level) 

To define a drilldown report (field level): 

1. From Field, choose the field to which you want to link the drilldown report. 

2. Click Select. 

3. Click Bind button. The New Report > Drilldown > Select Report window is displayed. 

4. Select the drilldown report to link to the field. 

5. Click the OK button. The drilldown report is displayed, as selected for Report in Field 
drilldown in the New Report > Drilldown window. 

6. To set the condition expression when the selected field is displayed, click the Edit 
Expression button. The New Report > Drilldown > Edit Conditional Expression for Drilldown 
window is displayed. 

7. Set the condition expression for the drilldown report. 

For example, to display a drilldown report showing the processes that have a higher CPU 
usage rate than those displayed in the Report window, set the condition expression as 
follows: 

CPU % > CPU % 

The CPU % on the left indicates the CPU usage rate shown in the drilldown report. This is 
specified in the first Field of the New Report > Drilldown > Edit Conditional Expression for 
Drilldown window. 

The CPU % on the right indicates the CPU usage rate shown in the Report window based on 
which the drilldown report is displayed. This is specified in Field, in Select value or field. 

Figure 5.13 shows an example of a setting for the New Report > Drilldown > Edit 
Conditional Expression for Drilldown window. 

8. Click the OK button. The condition expression is set, and the New Report > Drilldown 
window is displayed. The set condition expression is displayed in Conditional expression, 
in Field drilldown. 

9. Click the Finish button. The New Report > Drilldown window closes, and the settings for 
the report are completed. 
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Figure 5.13 Example of a Setting for the New Report > Drilldown > Edit Conditional Expression for 
Drilldown Window 

Following are descriptions of the window’s elements. For information about items that are not 
explained here, see the New Report > Filter window description in section 5.3.5. 

Description button 

A description of the fields belonging to the record of the drilldown report is displayed in 
the Field Description window. You can only click when the description file for the product 
defined in the report is set up. 

Select value or field 

Value check box 

Select this to specify a value in the Value text box. By default, this is selected. 

Value text box 

Specify a value for comparison. This is blank by default. The specifiable values vary by 
field. If Specify when displayed is selected, you do not need to specify anything. 

Specify when displayed 

Select this to specify the value of the condition expression when the report is 
displayed. By default, this is not selected. 

Field check box 

Select this to specify or change the field for comparison. 

By default, this is not selected. 
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Field drop-down list 

Select the field for comparison. Nothing is selected by default. The fields displayed 
differ depending on the type of report.  

– When Realtime (Single Agent) is selected for Report type in the New Report > 
Name and Type window, the Record Time field is displayed. When a multi-row 
record (multi-instance record) is selected, the Instance field is also displayed. 

– When Historical (Single Agent) is selected for Report type in the New Report > 
Name and Type window, the Date and Time field is displayed. When a multi-row 
record (multi-instance record) is selected, the Instance field is also displayed. 

– When Historical (Multiple Agents) is selected for Report type in the New Report > 
Name and Type window, the Date and Time, Agent Host, and Agent Instance 
fields are displayed. 
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5.4 Performing Operations to Define Reports 

This section uses an example in Windows to explain how to perform the following two types of 
operations: 

� Operations for a report folder 

You can add a folder, change the name of a folder, and delete a folder, under User Reports 
in which user-defined reports are stored. To organize user-defined reports, perform these 
operations. 

� Operations for a report definition 

For user-defined reports, you can copy a report, edit a report definition, change the name 
of a report, and delete a report. By performing these operations, you can copy and edit a 
report definition to create another report definition, or you can change or delete the name 
of a report to organize reports.   

These operations start from when the Main window of Performance Reporter is opened. 

5.4.1 Operations for a Report Folder 

You can perform the following folder operations in the Reports tab of the Main window of 
Performance Reporter: 

� Adding a report folder (see section 5.4.1.1) 

� Changing the name of a report folder (see section 5.4.1.2) 

� Deleting a report folder (see section 5.4.1.3) 

� Copying a Report between folders (see section 5.4.1.4) 

5.4.1.1 Adding a Report Folder 

To add a folder: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click User Reports or the folders within in which you want to add 
a folder. The clicked folder is selected. 

3. In the Method frame, choose the New Folder method. The New Folder window is displayed 
in the Information frame (see Figure 5.14). 

4. In New name of the folder, enter the name of the folder. 

5. Click the OK button. A folder is added to the report hierarchy in the Navigation frame. 
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Figure 5.14 New Folder Window 

5.4.1.2 Changing the Name of a Report Folder 

To change the name of a folder: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click the folder, within User Reports, whose name you want to 
change. The clicked folder is selected. 

3. In the Method frame, select the Rename method. The Rename window is displayed in the 
Information frame (see Figure 5.15). The current name of the folder is displayed in 
Current name of the folder. 

4. Enter the new name of the folder in New name of the folder. 

5. Click the OK button. The name of the selected folder is changed. 

 

Figure 5.15 Rename Window 

5.4.1.3 Deleting a Report Folder 

Deleting a folder also deletes the folders and reports contained in that folder. To delete a 
folder: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click the folder, within User Reports, that you want to delete. The 
clicked folder is selected. 

3. In the Method frame, select the Delete method. A message box confirming deletion is 
displayed in the Information frame. 

4. To delete the selected folder, click the OK button. The selected folder is deleted. 



  HiCommand Tuning Manager User's Guide 141 

5.4.1.4 Copying a Report between Folders 

To copy a report between folders: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click the folder containing the report you want to copy. The 
clicked folder is selected, and a list of the reports and folders within is displayed. 

3. In the list of reports, click the report you want to copy. The clicked report is selected. 

4. In the Method frame, choose the Copy method. The Copy window is displayed in the 
Information frame, as is the report hierarchy of the copy destination (see Figure 5.16). 

5. Click the folder of the copy destination or User Reports. The clicked folder of the copy 
destination or User Reports is selected. 

6. Click the OK button. The selected report is copied to the copy destination folder or to User 
Reports. 

 

Figure 5.16 Copy Window 
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5.4.2 Operations for a Report Definition 

You can perform the following operations for report definitions, in the Reports tab of the Main 
window of Performance Reporter: 

� Editing a report definition (see section 5.4.2.1) 

� Changing the name of a report (see section 5.4.2.2)  

Note: For information about copying a report, see section 5.4.1.4. For information about 
deleting custom reports, see section 5.8. 

5.4.2.1 Editing a Report Definition 

To edit a report definition: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click the folder containing the report whose definition you want to 
edit. The clicked folder is selected, and a list of the reports and folders within is displayed. 

3. In the list of reports, click the report whose definition you want to edit. The clicked report 
is selected. 

4. In the Method frame, choose the Edit method. The Report Wizard is displayed in the 
Information frame. For information about the items displayed in each window of the 
Report Wizard. 

5. Once the settings are complete, click the Finish button. The changes will take effect. 

Note: When re-selecting Report type or Record, you will need to perform the settings again 
for filter conditions, display settings, and other items. 
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5.4.2.2 Changing the Name of a Report 

To change the name of a report: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click the folder, in User Reports, containing the report whose 
name you want to change. The clicked folder is selected, and a list of the reports and 
folders within is displayed. 

3. In the list of reports, click the report whose name you want to change. The clicked report 
is selected. 

4. In the Method frame, select the Rename method. The Rename window is displayed in the 
Information frame (see Figure 5.17). The current name of the report is displayed in Current 
name of the report. 

5. Enter the new name for the report in New name of the report. 

6. Click the OK button. The name of the selected report is changed. 

 

Figure 5.17 Rename Window 

5.4.2.3 Exporting a Report Definition 

Performance Reporter provides the jpcrdef output command for exporting report definitions. 
You can use the exported data as a backup of report definitions. 

For details on the jpcrdef output command, see the HiCommand Tuning Manager Command 
Line Interface Guide. 

5.4.2.4 Importing a Report Definition 

With Performance Reporter, you can import a report definition by specifying the definition 
information output by the jpcrdef output command as the input source for the jpcrdef create 
command. If you export the server data whose report definition is already defined, and import 
it to another server, you can omit the report definition. For details on the jpcrdef create 
command, see the HiCommand Tuning Manager Command Line Interface Guide. 
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5.5 Displaying Reports 

This section describes the procedures for displaying reports, displaying drilldown reports, and 
printing displayed reports. You can open reports in either of the following ways: 

� from the Main window: 
In the Global tasks bar area, click Go then Performance Reporter.  

� from the Report Tree Selection window: 
In the Information area (Advanced Information) of the Report area, click the link preceded 
by "Performance Reporter. 

5.5.1 Displaying Primary Reports 

You can display reports from the Main window or from the Report Tree Selection window. 

To display reports from the Main window: 

1. In the Main window navigation frame, choose Agents. The agent hierarchy is displayed. 

2. Select one or more Agents in the Performance Reporter Main Window. 

3. Choose Display Report in the Main window method frame. A list of reports for the selected 
Agent is displayed in the information frame. 

4. Choose the report to be displayed from the list of report names. Reports are displayed on 
the Report tab. 

To display reports from the Report Tree Selection window, select the name of the report you 
want to display from the list of reports. The report is displayed in the Report tab of the Report 
window. 

If you specify a single-agent historical report or a single-agent real-time report for multiple 
agents, a separate Report window is displayed for each agent. If you specify a multi-agent 
historical report for multiple agents, one Report window with data for all agents is displayed. 

Note: With a historical report for multiple agents, if data could be acquired for at least one 
agent, but not for one or more of the other agents, no error is displayed. If data could not be 
acquired for any agents, an error is displayed. 
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Figure 5.18 Report Window, Report Tab Sample Report 

The following describes each display item: 

Common menu 

Bookmark 

Displays the Bookmark Registration window. 

Description 

Displays a description of the records and fields, in a separate window. 

Close 

Closes the Report window. 

Check boxes 

Graph 

Select this box to display data in a graph. This box cannot be selected if graph data is 
not set in the report definition or if there is no applicable data. 

List 

Select this box to display data in a list. This box cannot be selected if list data is not set 
in the report definition or if there is no applicable data. 

Table 

Select this box to display data in a table. This box cannot be selected if table data is 
not set in the report definition or if there is no applicable data. 
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Displays the first data or data group. 

 

Displays the previous data or data group. 

 

Displays the next data or data group. 

 

Displays the last data or data group. 

Drop-down list of drilldown reports 

This is a list of drilldown reports. This list is displayed if drilldown reports (report level) are 
defined. 

Link menu 

Display Report 

Displays the drilldown reports selected in the drop-down list of drilldown reports. This 
is not displayed if there are no drilldown reports. 

Refresh 

Fetches the data again and refreshes it. 

Export 

Outputs the data, which is acquired for displaying a report, as a file. This is not 
displayed if there is no data acquired and for a real-time report during automatic 
updating. 

Stop 

Stops auto-refresh for a real-time report. 

Graph 

A graph is displayed. For an overview of graphs, see the description of graphs in section 
4.2.5. 

Zoom Ratio 

Enlarges the displayed graph. You can select 100%, 200%, 400%, 600% or 800% for the 
zoom percentage. You can enlarge the display to the optimal size when the data of 
multiple agents or multiple instances is acquired and the size of the displayed graph is 
small. 

List 

A list is displayed. If you click the name of a field displayed as a link, a drilldown report 
(field level) is displayed. For details on the list, see the description of the list in section 
4.2.5. 

Table 5.5 shows the buttons that are used for moving pages in the list. 
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Table 5.5 Navigation Buttons for the List Page 

Button Description 

 Displays the first agent or instance data in the same data group. 

 Displays the previous agent or instance data in the same data group. 

 Displays the next agent or instance data in the same data group. 

 Displays the last agent or instance data in the same data group. 

Table 

A table is displayed. If you click the name of a field displayed as a link, a drilldown report 
(field level) will be displayed. For an overview of tables, see the description of tables in 
section 4.2.5.10. 

Table 5.6 Navigation Links for the Table Page 

Link Description 

First Displays the first page. 

Previous Displays the previous page. 

Next Displays the next page. 

Last Displays the last page. 

5.5.2 Displaying Drilldown Reports 

Drilldown reports are called from a parent report. You can display drilldown reports by 
defining them to be displayed in the Report Wizard (see section 5.2). You can also use the 
command line to define a report definition specifying that drilldown reports are to be 
displayed. Each drilldown report is displayed in a separate window from the parent report. 
When you close the parent window, you also close all drilldown report windows.  

Display conditions for drilldown reports 

There are three types of display conditions that are used to display drilldown reports: 

� Filter conditions defined for the parent report for displaying drilldown reports 

� Filter conditions defined for a drilldown report for displaying drilldown reports (parent 
report conditions take precedence if there is a conflict) 

� Show Options conditions defined for a drilldown report as Specify-When-Displayed 
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Displaying a drilldown report (report level) by specifying the report name 

When there are report-level drilldown reports, the report window’s menu bar displays their 
names on a drop-down list, together with the Display Report link. To display a report-level 
drilldown report, select the name of the desired drilldown report from the drop-down list, and 
then click the Display Report link. If there are no report-level drilldown reports, the menu bar 
does not contain the list or the Display Report link. The number of drilldown reports will 
depend on the parent report. 

Figure 5.19 shows the menu bar in the Report window when a list is displayed. 

 

Figure 5.19 Menu Bar in the Report Window 

When a parent report, which is the drilldown source, is a historical report (multi-agent), the 
drilldown reports of all the agents inherited from the parent report are displayed. Also, when 
multiple agents are selected and the drilldown report is a historical report (single agent) or 
real-time report (single agent), a dialog box is displayed to confirm that multiple Report 
windows should be opened. 

Displaying a drilldown report (field level) from a report area 

You can display a related drilldown report (field level) by clicking a graph, list, or table in the 
Report window. 

The following sections describe how to display a drilldown report (field level) from a graph, 
list, or table. 

Displaying a drilldown report (field level) from a graph area 

You can click a graph area to display a drilldown report (field level). To do so, you need to 
define the drilldown report to be displayed in the report definition. Figure 5.20 shows an 
example of a graph area from which a drilldown report can be displayed. 

 

Figure 5.20 Example of a Graph Area from which a Drilldown Report can be Displayed  
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Displaying a drilldown report (field level) from a list of item names 

Click the desired item name on the list to display a field-level drilldown report. The listed item 
names that can be selected are displayed as links. Figure 5.21 shows an example of list item 
names displayed as links. 

 

Figure 5.21 Example of List Names Displayed as Links 

Displaying a drilldown report (field level) from a table 

Click the desired table value to display a field-level drilldown report. The table values that can 
be selected are displayed as links. Figure 5.22 shows an example of table values displayed as 
links. 

 

Figure 5.22 Example of Table Values Displayed as Links 

When drilldown reports are displayed from the report area, the information that is inherited in 
drilldown reports from a parent report depends on the combination of report types. Tables 5.7 
and 5.8 show which information is inherited from a parent report for a drill-down report. 
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Table 5.7 Information Inherited From Multi-Agent Parent Report 

Drilldown Report Multiple Agents (Historical Report Only) Single Agent 

Data collection 
interval 

Date and Time information of the clicked data line. For a historical report, same as that to the left. 
For a real-time report, no information is inherited. 

Agent type The agents of the clicked graph area, list page, or 
table line. 

The agent selected after displaying the parent 
report. 

Report interval Report definition of the drilldown report. 
When changed by the Specify-when-displayed 
setting: the value after the change was made. 

For a historical report, same as that to the left. 
For a real-time report, no information is inherited. 

Table 5.8 Information Inherited From Single-Agent Parent Report 

Drilldown Report Multiple Agents (Historical Report Only) Single Agent 

Data collection 
interval 

Date and Time information of the clicked data line. For a historical report, same as that to the left. 
For a real-time report, no information is inherited. 

Agent type The agent selected when displaying the parent report (see Note) 

Report interval Report definition of the drilldown report. When 
changed by the Specify-when-displayed setting: the 
value after the change was made 

For a historical report, same as that to the left. 
For a real-time report, no information is inherited. 

Note: For single-agent drilldown reports, instances are not inherited automatically even when 
the parent report and drilldown report are both multiple instances. If the instances must be 
inherited, it is necessary to set the field value by specifying the field values in the drilldown 
condition settings of the parent report. 

Displaying a drilldown report (automatic settings) by specifying a time item 

When a table is displayed, the Date and Time field, Record Time field for the real time 
report, is added as the first and last columns. If the report target record is PI record and the 
data collection interval is defined in units other than minutes, it is possible to select a Date 
and Time field or Record Time field time, and display an appropriate automatic-settings 
drilldown report. Figure 5.23 shows an example of the Date and Time field displayed as a link. 
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Figure 5.23 Example of a Table Displaying the Date and Time Field as a Link 

The automatic-settings drilldown report displayed by specifying a time item has the same 
report definition as the parent report; however, Start time in the drilldown report will be the 
value of the selected Date and Time or Record Time, and Report Interval will be one more 
level detailed than the parent report. For example, Report Interval of the drilldown report 
will be Minute if Report Interval of the parent report is Hour. 

Note: Only historical reports can display drilldown reports from time items. 
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5.6 Displaying Report Properties 

The Report window’s Properties tab allows report definition information to be displayed. By 
displaying the properties, you can check the filter conditions for the report, the data 
collection period for the report, the auto-refresh interval for data displayed in the report, and 
other information.  

Figure 5.24 shows the Report window’s Properties tab. 

 

Figure 5.24 Report Window, Sample Properties Tab 

Following are descriptions of the window’s elements: 

Name and type 

Report name 

Shows the report name (up to 64 characters). 
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Product 

Displays the product name. When multiple Agent data model versions correspond to 
one product in the used environment, product-name (version) is displayed in Product. 

Report type 

Displays the report type (Realtime (Single Agent), Historical (Single Agent), or 
Historical (Multiple Agents)). 

Field 

Record 

Displays a selected record ID. 

All fields 

Displays all fields belonging to the selected record. 

Selected fields 

Displays the fields that were selected for display in the report. 

Conditional expression 

Conditional expression 

Displays over multiple lines as a list the condition expressions set as a filter for the 
report. If no filter is set, then nothing is displayed. If setting conditions are unified, 
parentheses “(  )” express the unification. 

Indication settings (Historical) 

Specify when displayed 

This check box determines whether the Show Options tab is to be displayed when the 
report is displayed. 

Maximum number of records 

Displays the maximum record count that has been set. 

Settings for the report display period 

Date range 

Displays the display target interval for the report. The Date range values are 
Specify when displayed/Within the past hour/Within the past 24 hours/Within 
the past 7 days/Within the past month/Within the past year. 

Report interval 

Displays the data collection interval for the report. The Report interval values are 
Minute/Hour/Day/Week/Month/Year. 

Peak time 

Field 

Displays the contents of the peak time collection field when this characteristic is 
set. If this characteristic is not set, the display shows (none). 
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Indication settings (Realtime) 

Specify when displayed 

This check box determines whether the Show Options tab is to be displayed when the 
report is displayed. 

Indicate delta value 

This check box determines whether delta values are displayed or not. 

Do not refresh automatically 

This check box determines whether real-time report is auto-refreshed or not. 

If selected: Do not perform auto-refresh. 

If not selected: Perform auto-refresh. 

Initial value 

Displays the auto-refresh interval (in seconds) for data displayed in the report. 

Minimum value 

Displays the minimum auto-refresh interval (in seconds) for data displayed in the 
report. 

Display by ranking 

Field 

Displays the name of the field set. This is displayed when there are multiple 
instances for the data used for the report. If this characteristic is not set, the 
display shows (none). 

Display number 

Displays the number of ranked items to display. This is displayed when there are 
multiple instances for the data used for the report. If this component is not set, 
the display is blank. 

In descending order 

Displays whether the ranking display is in descending order. This is displayed when 
there are multiple instances for the data used for the report.  

If selected: Descending order 

If not selected: Ascending order 

Components 

Fields 

Displays the field names. 

Table 

This check box determines whether the applicable field is to be displayed in a table. 

List 

This check box determines whether the applicable field is to be displayed in a list. 
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Graph 

This check box determines whether the applicable field is to be displayed in a graph. If 
a field is not a numeric field, N/A is displayed because it is not possible to display its 
data in a graph. 

Display name 

If this component is set, the display name setting is displayed. Up to 24 characters can 
be displayed. If this component is not set, the display is blank. 

Display key 

Field 

If this component is set, the value of the display key field is displayed. If this 
component is not set, the display shows (none). 

In descending order 

This component sets whether the displayed key values are to be listed in 
descending or ascending order: 

If selected: Descending order 

If not selected: Ascending order 

Graph 

Graph types 

Displays the type of graph to be displayed: 

– Column 

– Stacked column 

– Bar 

– Stacked bar 

– Pie 

– Line 

– Area 

– Stacked area 

Series direction 

Displays whether the graph series is by row or by column: 

– By row 

– By column 

Show areas of missing data 

This check box displays whether to show a break in a graph when displaying a part with 
missing data. 

– If checked: Display the data with a break in the graph. 

– If not checked: Do not display a break in the graph. 
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Axis labels 

– X-axis 

If this property is set, the X-axis label is displayed. Up to 40 characters can be 
displayed. If this property is not set, the display is blank. 

– Y-axis 

If this property is set, the Y-axis label is displayed. Up to 40 characters can be 
displayed. If this property is not set, the display is blank. 

Data label 

– Data label 1 

If this property is set, Data label 1 is displayed. Up to 40 characters can be 
displayed. If this property is not set, the display shows (none). 

– Data label 2 

If this property is set, Data label 2 is displayed. Up to 40 characters can be 
displayed. If this property is not set, the display shows (none). 

Drilldown 

Report drilldown 

– Report 

A drilldown report whose report name is specified is displayed. This report can 
display up to 64 characters. If this report is not set, the display shows a blank 
space. 

Field drilldown 

– Field 

This report displays field names related to field-level drilldown reports. 

– Report 

This report displays report names related to field-level drilldown reports. If this 
property is not set, the display shows (No report is selected.). 

– Conditional expression 

This report displays display conditions related to field-level drilldown reports. The 
condition expressions set as a filter for the report are displayed over multiple lines 
in a list. If no filter is set, nothing is displayed. If setting conditions are unified, 
parentheses “(  )” express the unification. 

Notes: 

� The property display contents are the report definition information, not the display setting 
information. Therefore, even if the display conditions are changed from the Show Options 
tab, the property display information does not change. 

� For information about using the Report Wizard to define a report, see section Error! 
Reference source not found.. For information about entering commands for a report 
definition, the supported commands, and the command syntax, see the HiCommand 
Tuning Manager Command Line Interface Guide. 
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5.7 Setting and Changing Report Display Conditions 

You can set or change report display conditions at either of two times: when you define a 
report, and when you display a report. 

� Setting Conditions at Report Definition 

The display conditions set when you define a report are registered permanently in the 
Performance Reporter system. These conditions are not affected by such operations as 
opening and closing windows, or starting and shutting down the system. Such display 
conditions are registered permanently until the jpcrdef delete command is used to delete 
them from the Performance Reporter system. 

� Setting Conditions at Report Display 

You can use the Report window, Show Options tab to set or change the display conditions 
for a particular report. These settings are effective only while a report is being displayed 
in that window. Once you close that window or open another window, the display 
conditions revert to the default for that report.  

If you want to set the report display conditions every time reports are displayed, we 
recommend that you make an appropriate specification for displaying the Show Options tab in 
the definition of the report. 

5.7.1 Setting Conditions at Report Definition 

You can define the report display conditions by using the Report Wizard, or by using the 
jpcrdef create command. 

The display conditions set when you define a report are registered permanently in the 
Performance Reporter system. These conditions are not affected by such operations as opening 
and closing windows, or starting and shutting down the system. Such display conditions are 
registered permanently until the jpcrdef delete command is used to delete them from the 
Performance Reporter system. 

For information about using the Report Wizard to define a report, see section Error! 
Reference source not found.. For details on the commands, see the HiCommand Tuning 
Manager Command Line Interface Guide. 
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5.7.2 Setting Conditions at Report Display 

You can use the Report window, Show Options tab to set or change the display conditions for 
a particular report. These settings are effective only while a report is being displayed in that 
window. Once you close that window or open another window, the display conditions revert to 
the default for that report.  

For the Show Options tab to be displayed at the time of initial display of a Report window, 
make an appropriate specification in the definition of the report. The actual Window that will 
be displayed depends on the combination of report definition items. 

There are three types of Show Options tabs, depending on the report definition information.  

To set the data collection period or collection interval, set the report definition as follows: 

� To define a report using the Report Wizard, select Specify when displayed in Indication 
Settings, or select Specify when displayed for Date range in Indication Settings for the 
historical report. 

� To define a report using commands, set the specify when displayed attribute to TRUE or 
omit the date-range subelement when you set the indication-settings parameter. 

When you specify these settings for report definition, the Show Options tab is displayed, as 
shown in Figure 5.25. 

 

Figure 5.25 Setting the Data Collection Period or Collection Interval with a Report Displayed 

The Settings for the report display period box allows you to set the parameters for the 
report. 

– Date range displays the display target interval for the report. The options are: Specify 
when displayed, Within the past hour, Within the past 24 hours, Within the past 7 days, 
Within the past month, or Within the past year. 
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– Start time allows you to specify the beginning of the range of reports. If you enter a 
value, the date range will change to Specify when displayed. The display format 
specified for Start time changes, depending on the combination of the date format 
and the Report interval value set in config.xml. Table 5.9 lists the display formats. 

– End time allows you to specify the end of the range of reports. The values are the 
same as for the start time. The display format specified for End time changes, 
depending on the combination of the date format and the Report interval value set in 
config.xml. Table 5.9 lists the display formats. 

– Report interval allows you to specify the interval. Available options for a PI record 
are: Minute, Hour, Day, Week, Month, or Year. The value of the report interval 
changes depending on the Date range setting. 

Specify when displayed -> Hour 

Within the past hour -> Minute 

Within the past 24 hours -> Hour 

Within the past 7 days -> Day 

Within the past month -> Week 

Within the past year -> Month 

� The Maximum number of records field allows you to specify the maximum record count. 
The value specified in maxFetchCount in config.xml is an upper limit. 

� The Peak time box allows you to display the report that contains the largest reported 
number for the selected field in a 24-hour period.  

� The Field selection list only appears when a record is a single instance and the Report 
interval setting is Hour.  

The following interface elements are not shown in Figure 5.25, but may also be visible: 

� The Filter selection lets you specify a condition expression up to 2,048 bytes long, using 
integers, decimal values, or character strings. The display format specified for Start time 
and End time changes, depending on the combination of the date format and the Report 
interval value set in config.xml. Table 5.9 lists the display formats. 

� The Indicate delta value selection lets you display delta values for the real-time report. If 
this is selected and the attribute of the field set does not support delta values, the delta 
value will not be displayed and the obtained values will be displayed as-is. 

� The Do not refresh automatically selection lets you prevent auto-refresh from being 
performed for the real-time report. When this is not selected, data is collected 
automatically from the agent, and auto-refresh is performed for the real-time report. 

� The Refresh interval selection lets you specify an auto-refresh interval for the real-time 
report. Values range from the Minimum value to 3,600. The default value is the value of 
Initial value. 
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� Display by ranking 

– Field 

From the list, select the field for which the display for the real-time report should be 
ranked. 

– Display number 

Specify an integer from 1 to 100 for the number of ranked items to display for the 
real-time report. 

� The In descending order selection lets you collect and display the data for the real-time 
report in descending order. 

� The OK button displays the report if all required fields are filled. 

Table 5.9 Display Formats for Start Time and End Time 

Report Interval 
Value 

Date Format 
[dd MM yyyy] 

Date Format 
[MM dd yyyy] 

Date Format 
[yyyy MM dd] 

Minute [dd MM yyyy HH:mm] [MM dd yyyy HH:mm] [yyyy MM dd HH:mm] 

Hour [dd MM yyyy HH:00] [MM dd yyyy HH:00] [yyyy MM dd HH:00] 

Day [dd MM yyyy] [MM dd yyyy] [yyyy MM dd] 

Week [dd MM yyyy] [MM dd yyyy] [yyyy MM dd] 

Month [MM yyyy] [MM yyyy] [yyyy MM] 

Year [yyyy] [yyyy] [yyyy] 

Note: In Table 5.9, “dd” indicates the day, “MM” indicates the month, “yyyy” indicates the 
year. “HH” indicates the hour, and “mm” indicates the minute. 

To set the data filter conditions while a report is being displayed, use the following procedure: 

� To define a report using the Report Wizard, select Specify when displayed in the Filter 
settings. 

� To define a report using commands, specify the record - condition-expression - 
expression parameter. Then, specify TRUE in the Specify-when-displayed attribute of 
the expression parameter. The hyphens in this expression indicate the hierarchy when you 
are defining reports. The description record - condition-expression means to specify 
condition-expression in the record subelement. 

When you perform the above settings for report definition, the Show Options tab is displayed 
as shown in Figure 5.26. 
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Figure 5.26 Report Window, Show Options Tab, Setting Data Filter Conditions 

To set the data collection period, collection interval, or filter conditions, use the following 
procedure: 

� To define a report using the Report Wizard: 

– Select Specify when displayed in Indication Settings, or select Specify when 
displayed for Date range in Indication Settings for the historical report. 

– Select Specify when displayed in the Filter settings. 

� To define a report using commands: 

– Specify TRUE in the specify-when-displayed attribute of the indication-settings 
parameter. Alternatively, omit the date-range subelement of the indication-settings 
parameter. 

– Specify the record - condition-expression - expression parameter. Then specify 
TRUE in the specify-when-displayed attribute of the expression parameter.  

The hyphens in the above expressions indicate the hierarchy when you are defining reports. 
The description record - condition-expression means to specify a condition-expression in the 
record subelement. When you apply these settings for report definition, the Show Options tab 
is displayed, as shown in Figure 5.27. 

 

Figure 5.27 Report Window, Show Options Tab, Setting Data Collection, Interval or Filters 
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5.8 Deleting a User-defined Report 

To delete a report: 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. 

2. In the report hierarchy, click the folder, in User Reports, containing the report you want 
to delete. The clicked folder is selected, and a list of the reports and folders within is 
displayed. 

3. In the list of reports, click the report you want to delete. The clicked report is selected. 

4. In the Method frame, select the Delete method. A message box confirming deletion is 
displayed in the Information frame. 

5. To delete the selected report, click the OK button. The selected report is deleted. 
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5.9 Example of Creating a New Report 

Following is an example of creating a new report: Average Response Rate of Device File. 

To create the Average Response Rate of Device File report: 

1. In the Global Tasks bar area of Main Console, click Go and then Performance Reporter. 
The Main window of Performance Reporter is displayed. 

2. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed.  

3. In the Navigation frame of the Main window, click User Reports. 

4. In the Method frame, choose the New Report method. The New Report > Name and Type 
window is displayed in the Information frame. 

5. In Report Name, enter Average Response Rate of Device File. For Product, select 
Windows(5.0). 

6. In Report Type, select Historical (Single Agent), and then click Next. The New Report > 
Field window is displayed. 

7. In Record, select Physical Disk Overview(PI_PHYD). 

8. In All fields, select the following fields: Date and Time, ID, Ave Disk Secs/Xfer, Ave Disk 
Secs/Read, and Ave Disk Secs/Write. Click the Next > button. The New Report > Filter 
window is displayed. 

9. Select the field ID, = for Condition, and Specify when displayed. Click Add, and then 
select AND and Simple. ID = prompt(“”) is displayed in Conditional expression. Click 
the Next > button.  The New Report > Indication Settings (Historical) window is displayed. 

10. Confirm that Specify when displayed is shown for Date range and select Minute for the 
Report interval. 

11. In Maximum number of records, specify 1440. Click the Next > button. The New Report 
> Components window is displayed. 

12. Select the Graph check box for Avg Disk Secs/xfer.  

13. In Display Key, select (none) for Field. Click the Next > button. The New Report > Graph 
window is displayed. 

14. Select Line for the Graph type, and then confirm that By column is selected and that 
(none) is shown for both Data label 1 and Data label 2. Click the Finish button. The 
settings are saved, and the New Report > Graph window closes. 

15. In the Navigation frame of the Main window, click the Agents tab and then select the 
Windows Agent and a subsystem below the Agent. 

16. In the Method frame, select Display Report. The Average Response Rate of Device File 
report is displayed below User Reports.  
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5.10 Example of Customizing a Solution Set 

This section provides an example of customizing a solution set to create a report. The example 
describes how to customize the Port Performance Details report of the RAID solution set to 
create a Port Performance Details report. The report will display a graph that shows average 
transfers per second. 

To customize the Port Performance Details: 

1. In the Global Tasks bar area of Main Console, click Go and then Performance Reporter. 
The Main window of Performance Reporter is displayed. 

2. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. The System Reports area displays a hierarchy of the folders and reports for 
the solution set.  

3. In the Navigation frame of the Main window, in System Reports, click RAID, 
Troubleshooting, Recent Past, and then Port Performance Details. The Port 
Performance Details report is selected. 

4. In the Method frame, choose the Copy method. The Copy window is displayed in the 
Information frame, as is the report hierarchy of the copy destination. 

5. Click the OK button. The Port Performance Details report is copied to User Reports. 

6. In the Method frame, choose the Edit method. The Edit > Name and Type window is 
displayed in the Information frame. 

7. In Report Type, confirm that Historical (Single Agent) is selected, and then click Next. 
The Edit > Field window is displayed. 

8. In Record, confirm that the Port Summary (PI_PTS) record is selected.  

9. In All fields, select the following fields, if not already selected: Port Number, Port Name, 
Max I/O /sec, Min I/O /sec, Avg I/O /sec, Max xfer /sec, Min xfer /sec, Avg xfer /sec. Click 
the Next > button. The Edit > Filter window is displayed. 

10. Select the field Port Name, = for Condition, and Specify when displayed. Click Add, 
and then select AND and Simple. Port Name = prompt(“”) is displayed in Conditional 
expression. Click the Next > button.  The Edit > Indication Settings (Historical) window is 
displayed. 

11. Confirm that Specify when displayed is shown for Date range and Minute for the Report 
interval. 

12. In Maximum number of records, specify 1440. Click the Next > button. The Edit > 
Components window is displayed. 

13. Select the Graph check box for Min xfer /sec.  

14. In Display Key, select (none) for Field. Click the Next > button. The Edit > Graph window 
is displayed. 

15. Select Line for the Graph type, and then confirm that By column is selected and that 
(none) is shown for both Data label 1 and Data label 2. Click the Finish button. The 
settings are saved, and the Edit > Graph window closes. 
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16. In the Navigation frame of the Main window, click the Agents tab and then select the RAID 
Agent and a subsystem below the Agent. 

17. In the Method frame, select Display Report. The Port Performance Details report is 
displayed below User Reports.  

18. Click the Port Performance Details report. 

19. Select the Date range, Max records, and Port name, and then click OK. The Port 
Performance Details report will be displayed. 
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5.11 Example of Creating a New Report with an OR Filter Condition 

This section provides an example of creating a new report with an OR filter Condition. The 
example describes how to create an I/O Response Time report that displays a line graph 
showing the I/O Response time trend for a particular device file. The Platform Agent 
(Windows) collects the data about the device file. 

To create the I/O Response Time report: 

1. In the Global Tasks bar area of Main Console, click Go and then Performance Reporter. 
The Main window of Performance Reporter is displayed. 

2. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed.  

3. In the Navigation frame of the Main window, click User Reports. 

4. In the Method frame, choose the New Report method. The New Report > Name and Type 
window is displayed in the Information frame. 

5. In Report Name, enter I/O Response Time. For Product, select Windows(4.0). 

6. In Report Type, select Historical (Single Agent), and then click Next. The New Report > 
Field window is displayed. 

7. In Record, select Physical Disk Overview(PI_PHYD). 

8. In All fields, select the following fields: Avg Disk Bytes/Xfer, % Disk Read Time, % Disk 
Time, % Disk Write Time, Avg Disk Bytes/Read, Avg Disk Bytes/Write, Avg Disk Queue 
Length, Avg Disk Read Queue Length, Avg Disk Secs/Read, Avg Disk Secs/Write, Avg Disk 
Secs/Xfer, Avg Disk Write Queue Length, and ID. I/O Response Time is equivilent to the Avg 
Disk Secs/Xfer field. Click the Next > button. The New Report > Filter window is displayed.  

9. Select the field ID, = for Condition, and Specify when displayed. Click Add, and then 
select AND and Simple. ID = prompt(“”) is displayed in Conditional expression.  

10. Select the field Disk Bytes/sec, >= for Condition, and Specify when displayed. 
Click Add, and then select OR and Simple. ID = prompt(“”) OR Disk Bytes/sec >= 
prompt(“”) is displayed in Conditional expression. 

11. Click the Next > button.  The New Report > Indication Settings (Historical) window is 
displayed. 

12. Select the Specify when displayed check box. 

13. Confirm that Specify when displayed is shown for Date range and Hour for the Report 
interval. 

14. In Maximum number of records, specify 1440. Click the Next > button. The New Report 
> Components window is displayed. 

15. I/O Response Time is equivilent to the Avg Disk Secs/Xfer field. Select the Graph check box 
for Avg Disk Secs/Xfer.  

16. In Display Key, select (none) for Field. Click the Next > button. The New Report > Graph 
window is displayed. 
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17. Select Line for the Graph type, and then confirm that By column is selected. Enter I/O 
Response Time for Y-axis, and then select ID for Data label 1 and (none) for Data label 
2. Click the Finish button. The settings are saved, and the New Report > Graph window 
closes. 

18. In the Navigation frame of the Main window, click the Agents tab and then select the 
Windows Agent and a subsystem below the Agent. 

19. In the Method frame, select Display Report. The I/O Response Time report is displayed 
below User Reports. 
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5.12 Example of Creating a Line Graph (Single field, Multiple Instances) 

This section provides an example of creating a line graph (single field, multiple instances). The 
example describes how to customize the CPU Status (Multi-Agent) report of the Windows 
solution set to create a CPU Status (Multi-Agent) report that displays a line graph  (single field, 
multiple instances) showing CPU usage.  

To customize the CPU Status (Multi-Agent) report to display a line graph (single field, multiple 
instances): 

1. In the Navigation frame of the Main window, select the Reports tab. The report hierarchy 
is displayed. The System Reports area displays a hierarchy of the folders and reports for 
the solution set.  

2. In the Navigation frame of the Main window, in System Reports, click Windows, Operating 
System, Status Reporting, Daily Trend and then CPU Status (Multi-Agent). The CPU 
Status (Multi-Agent) report is selected. 

3. In the Method frame, choose the Copy method. The Copy window is displayed in the 
Information frame, as is the report hierarchy of the copy destination. 

4. Click the OK button. The CPU Status (Multi-Agent) report is copied to User Reports. 

5. In the Method frame, choose the Edit method. The Edit > Name and Type window is 
displayed in the Information frame. 

6. In Report Type, confirm that Historical (Multiple Agents) is selected, and then click Next. 
The Edit > Field window is displayed. 

7. In Record, confirm that the System Overview (PI) record is selected.  

8. In All fields, select the following fields, if not already selected: CPU %, User CPU %, 
Privileged CPU %, and System Calls/sec. Click the Next > button. The Edit > Filter window 
is displayed. 

9. Select the field Agent Host, and = for Condition. Click the Next > button.  The Edit > 
Indication Settings (Historical) window is displayed. 

10. Confirm that Specify when displayed is shown for Date range and Hour for the Report 
interval. 

11. In Maximum number of records, specify 1440. Click the Next > button. The Edit > 
Components window is displayed. 

12. Select the Graph check box for CPU %. (Note that at least one Graph check box must be 
selected to display a graph.  

13. Click the Next > button. The Edit > Graph window is displayed. 

14. Select Line for the Graph type, and then confirm that By column is selected, CPU % is 
selected for Y-axis, and that Agent Instance is shown for Data label 1 and (none) for Data 
label 2. Click the Finished button. The settings are saved, and the Edit > Graph window 
closes. 

15. In the Navigation frame of the Main window, click the Agents tab and then select 
Multiselect, Windows below Products, and multiple agents below Windows. 
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16. In the Method frame, select Display Report. The CPU Status (Multi-Agent) report is 
displayed below User Reports.  
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Chapter 6 Working with Alerts 

The programs of the Tuning Manager series monitor performance data based on thresholds that 
are predefined in Main Console. When performance data values reach the threshold values, 
Main Console notifies the user of the system status by email or execution of a command. These 
notifications are called alerts. A user who receives an alert can prevent operational problems 
by taking appropriate action to improve performance. 

This chapter describes how to set up alerts and provides notes on using alerts. 

� Alertable metrics (see section 6.1) 

� Setting Alerts (see section 6.2) 

� Testing Alerts (see section 6.3) 

� Viewing Alerts (see section 6.4) 

� Editing an Alert Definition (see section 6.5) 

� Notes on Alerts (see section 6.6) 
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6.1 Alertable metrics 

Alerts can be set for some metrics in Main Console, but not others. Table 6.1 and Table 6.2 list 
the capacity and performance metrics for which alerts can be set. 

Table 6.1 Alertable Metrics (Capacity) 

Resource Resource layer Alertable metrics 

Server Server Capacity 

  Device Files 

  Free 

  Free % 

  Growth Rate 

  Imported Filesystems 

  Local Filesystems 

  Used 

 Filesystem Capacity 

  Free 

  Free % 

  Growth Rate 

  Inodes 

  Used 

Application (Oracle) Instance Capacity 

  Data Files 

  Free 

  Free % 

  Growth Rate 

  Tablespaces 

  Used 

 Tablespace Capacity 

  Data Files 

  Free 

  Free % 

  Growth Rate 

  Rollback Segments 

  Sort Segments 
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Resource Resource layer Alertable metrics 

  Used 

 Data file Size 

Table 6.2 Alertable Metrics (Performance) 

Resource Resource layer Alertable metrics 

Server Server IOPS 

  Read IOPS 

  Read Transfer 

  Transfer 

  Write IOPS 

  Write Transfer 

Storage Device file IOPS 

  I/O Response Time 

  Read IOPS 

  Read Transfer 

  Transfer 

  Write IOPS 

  Write Transfer 

 Storage subsystem Array Groups 

  Cache % 

  Cache Capacity 

  Cache Usage 

  Disk IOPS 

  Disk Read IOPS 

  Disk Read Transfer 

  Disk Transfer 

  Disk Write IOPS 

  Disk Write Transfer 

  Logical Disks 

  Max Side File Usage 

  Max Write Pending Rate 

  Port IOPS 

  Port Max IOPS 

  Port Max Transfer 
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Resource Resource layer Alertable metrics 

  Port Min IOPS 

  Port Min Transfer 

  Port Transfer 

  Ports 

  Side File Usage 

  Write Pending Rate 

 Storage port Port IOPS 

  Port Max IOPS 

  Port Max Transfer 

  Port Min IOPS 

  Port Min Transfer 

  Port Transfer 

 Array group Disk IOPS 

  Disk Random IOPS 

  Disk Random Transfer 

  Disk Read IOPS 

  Disk Read Transfer 

  Disk Sequential IOPS 

  Disk Sequential Transfer 

  Disk Transfer 

  Disk Write IOPS 

  Disk Write Transfer 

  I/O Usage 

  Max I/O Usage 

  Read Hit Ratio 

  Write Hit Ratio 

 Logical disk Disk IOPS 

  Disk Random IOPS 

  Disk Random Transfer 

  Disk Read IOPS 

  Disk Read Transfer 

  Disk Sequential IOPS 

  Disk Sequential Transfer 

  Disk Transfer 
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Resource Resource layer Alertable metrics 

  Disk Write IOPS 

  Disk Write Transfer 

  I/O Response Time 

  Read I/O Response Time 

  Write I/O Response Time 

 CLPR Cache Capacity 

  Max Side File Usage 

  Max Write Pending Rate 

  Side File Usage 

  Write Pending Rate 

Fabric Switch Buffer Credit Zero State 

  Input Buffer Full 

  PortModules 

  Ports 

  Received Bytes 

  Received Frames 

  Transferred Bytes 

  Transferred Frames 

 Switch port Buffer Credit Zero State 

  Input Buffer Full 

  Received Bytes 

  Received Frames 

  Transferred Bytes 

  Transferred Frames 

Application (Oracle) Instance IOPS 

  Read IOPS 

  Write IOPS 

 Tablespace IOPS 

  Read IOPS 

  Write IOPS 

 Data file IOPS 

  Read IOPS 

  Write IOPS 
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6.2 Setting Alerts 

The programs of the Tuning Manager series monitor performance data based on thresholds that 
are predefined in Main Console. When performance data values reach the threshold values, 
Main Console notifies the user of the system status by email or execution of a command. These 
notifications are called alerts. A user who receives an alert can prevent operational problems 
by taking appropriate action to improve performance. 

Set alerts in the following order:  

1. define an alert 

2. define an alert action 

3. bind an alert definition and a resource 

4. bind an alert action definition and a resource 

Note: This activity requires Manager or Administrator privileges. 

To set up an alert, follow these steps: 

1. Define: 

Specify the characteristics of the alert including the resource type. See section 6.2.1. 

2. Action: 

Specify the action(s) you want Tuning Manager to take in the case of an alert event. See 
section 6.2.2. 

3. Bind: 

Assign the alert definition and the actions you want performed to a resource. This 
operation is called a bind. See section 6.2.3. 

Note: Allow at least two polling periods for the alert to become effective. 



  HiCommand Tuning Manager User's Guide 177 

6.2.1 Creating an Alert Definition 

Note: This activity requires Manager or Administrator privileges. 

To create a new alert: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Define tab. 

The Alerts list appears. 

3. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

4. Click Add Alert Definition. 

The Alert Setting 1 window is displayed (see Figure 6.1). 

5. Fill in the window as described in Table 6.3.  

6. Click Next to continue (or click Cancel to abandon changes). 

The Alert Setting 2 window appears (see Figure 6.2). 

7. Fill in the items in the window as explained in the Table 6.4. 

Note: The message fields (Warning Condition and Critical Condition) will remain grey 
when you create an new Alert definition. However these fields will display the Alert 
expressions for Warning and Critical levels once you have completed and saved the alert 
definition. Example: Capacity >= 20. 

8. Click Save (or click Cancel to abandon changes). 

 

Figure 6.1 The Alert Setting 1 Window 
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Table 6.3 Alert Definition Fields (First Dialog-Alert Setting 1) 

Field Value 

Alert Name The unique name of the alert. 

User ID The user account responsible for creating the alert (read only). 

Modification Date Last date and time this alert was edited (read only). 

Period of 
Watching 

Always Evaluated When you check this box, this alert condition will be monitored 
constantly. 
Note that the values you specified for From and To are ignored. 
Note: To use damping, check Always Evaluated and 
Damping Enabled. 

 From Restricts alert monitoring to a finite starting time. 

 To Restricts alert monitoring to a finite ending time. 

Damping Damping Enabled When checked, an alert is triggered only when multiple 
instances occur within a finite time frame. 
Note: To use damping, check Always Evaluated and 
Damping Enabled. 

 Occurrence(s) 
During 

The number of times an alert condition occurs before the alert is 
triggered. (See Damping Enabled.) 

 Intervals The number of successive samples to be collected. 
Example: 
If 6 is specified in Occurrence(s) and 10 is specified in Intervals, 
the alert is triggered when the alert condition reaches at least 6 
within the successive 10 samples. 

Data Category The resource type to be monitored: 
� Server 
� Filesystem 
� Device File 
� Storage Subsystem 
� Storage Port 
� Logical Disk 
� Array Group 
� CLPR 
� Oracle Instance 
� Tablespace 
� Data File 
� Switch 
� Switch Port 
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Figure 6.2 The Alert Setting 2 Window 

Table 6.4 Alert Definition Fields (Second Dialog-Alert Setting 2) 

Field Value 

Data Category The resource type to be monitored. (read only). 

Metric Specify the metric to be evaluated for the alert. 

 Server 
� Capacity 
� Used 
� Free 
� Free % 
� Growth Rate 
� IOPS 
� Read IOPS 
� Write IOPS 
� Transfer 
� Read Transfer 
� Write Transfer 
� Local Filesystems 
� Imported Filesystems 
� Device Files 

 Filesystem 
� Capacity 
� Used 
� Free 
� Free % 
� Growth Rate 
� Inodes 
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Field Value 

 Device File 
� IOPS 
� Read IOPS 
� Write IOPS 
� Transfer 
� Read Transfer 
� Write Transfer 
� I/O Response Time 

 Storage Subsystem 
� Port Max IOPS 
� Port Min IOPS 
� Port IOPS 
� Port Max Transfer 
� Port Min Transfer 
� Port Transfer 
� Cache Capacity 
� Cache Usage 
� Disk IOPS 
� Disk Read IOPS 
� Disk Write IOPS 
� Disk Transfer 
� Disk Read Transfer 
� Disk Write Transfer 
� Ports 
� Logical Disks 
� Cache % 
� Array Groups 
� Max Write Pending Rate 
� Max Side File Usage 
� Write Pending Rate 
� Side File Usage 

 Storage Port 
� Port Max IOPS 
� Port Min IOPS 
� Port IOPS 
� Port Max Transfer 
� Port Min Transfer 
� Port Transfer 
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Field Value 

 Logical Disk 
� I/O Response Time 
� Read I/O Response Time 
� Write I/O Response Time 
� Disk IOPS 
� Disk Read IOPS 
� Disk Write IOPS 
� Disk Random IOPS 
� Disk Sequential IOPS 
� Disk Transfer 
� Disk Read Transfer 
� Disk Write Transfer 
� Disk Random Transfer 
� Disk Sequential Transfer 

 Array Group 
� I/O Usage 
� Max I/O Usage 
� Disk IOPS 
� Disk Read IOPS 
� Disk Write IOPS 
� Disk Random IOPS 
� Disk Sequential IOPS 
� Disk Transfer 
� Disk Read Transfer 
� Disk Write Transfer 
� Disk Random Transfer 
� Disk Sequential Transfer 
� Read Hit Ratio 
� Write Hit Ratio 

 CLPR 
� Cache Capacity 
� Max Write Pending Rate 
� Max Side File Usage 
� Write Pending Rate 
� Side File Usage 
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Field Value 

 Oracle Instance 
� Capacity 
� Used 
� Free 
� Free % 
� Growth Rate 
� IOPS 
� Read IOPS 
� Write IOPS 
� Tablespaces 
� Data Files 

 Tablespace 
� Capacity 
� Used 
� Free 
� Free % 
� Growth Rate 
� IOPS 
� Read IOPS 
� Write IOPS 
� Data Files 
� Rollback Segments 
� Sort Segments 

 Data File 
� IOPS 
� Read IOPS 
� Write IOPS 
� Size 

 Switch 
� Received Bytes 
� Transferred Bytes 
� Received Frames 
� Transferred Frames 
� Input Buffer Full 
� Buffer Credit Zero State 
� Ports 
� PortModules 
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Field Value 

 Switch Port 
� Received Bytes 
� Transferred Bytes 
� Received Frames 
� Transferred Frames 
� Input Buffer Full 
� Buffer Credit Zero State 

Operator The comparison operator for evaluating potential alert conditions. 
� = 
� >= 
� <= 
� > 
� < 

Warning The threshold value for triggering a warning alert. (<= 2 decimal places). 
Note: Displayed values do not always indicate that an alert condition has been 
reached. For more information, see section 6.6. 

Critical The threshold value for triggering a critical alert. (<= 2 decimal places) 
Note: Displayed values do not always indicate that an alert condition has been 
reached. For more information, see section 6.6. 

6.2.2 Defining Alert Actions Alerts 

In the event of an alert condition, Tuning Manager can respond with any or all of these actions: 

� Email message 

� SNMP message 

� Execute a command 

� Log a message in EventLog/Syslog 

Notes: 

� By default, the alerts are set up to be displayed in Web Client only without invoking any of 
the above actions. 

� If no email is delivered even though email is set as an alert action, you must set a user 
property file. For details on user property files, see the HiCommand Tuning Manager 
Server Administration Guide. 

� If Tuning Manager is installed on a Solaris server, that server must be configured to enable 
syslog notifications from user applications. For further information, see the HiCommand 
Tuning Manager Server Administration Guide. 
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6.2.2.1 Creating Alert Action Definitions 

To set an alert action definition: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Action tab. 

The Alert Actions list appears. 

3. If you've created an extensive list, click Next or Previous to access other segments of the 
list. When multiple subtables are available for display, you can jump directly to each 
section of the table. Numbered hyperlinks appear for this purpose. 

4. Click Add Action Definition. 

The Alert Action Settings window appears. 

 

Figure 6.3 The Alert Action Settings Window 
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5. Determine which of the actions you want executed upon this alert event. You may specify 
one or more: 

– Email-Sends a message to an SMTP server. 

(You can also specify authentication if your SMTP server requires this. Check the SMTP 
Authentication checkbox and fill in User ID and Password.) 

– SNMP-Creates an SNMP trap. See the Glossary. For information on usage with SNMP 
management applications, see section 6.5.8. 

– Command-Executes an OS-level script or program. 

– EventLog/Syslog-Sends an alert message to the event log or system log. 

(In a Windows environment, the message is sent to the event log. In a Solaris 
environment, the message is sent to /var/adm/message by default.) 

6. Fill in the window with appropriate values. See section 6.2.2.2. 

7. Click Save to add this Action Definition (or click Cancel to abandon this window). 

6.2.2.2 Alert Action Definition Fields 

Table 6.5 Alert Action Settings Fields 

Name Description 

Action Name Unique name for this alert action. 

Data Category From the combo box, select the resource type that triggers the 
alert action. You can select the following resource types: 
� Server 
� Filesystem 
� Device File 
� Storage Subsystem 
� Storage Port 
� Logical Disk 
� Array Group 
� CLPR 
� Oracle Instance 
� Tablespace 
� Data File 
� Switch 
� Switch Port 

Email Email Host SMTP email server host to receive the alert message. 

 Email To This will become the TO field in generated email alerts. 

 Email Message Body of the alert email message. 
Messages can use Alert Message Variables see section 
6.2.2.3. 
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Name Description 

 SMTP 
Authentication 

If your SMTP server requires authentication for submissions, 
check the checkbox and fill in the two login fields: 
� User ID: Specify the SMTP user account name. 
� Password: Specify the password. 

SNMP SNMP Destination Which resource to direct the SNMP notification to. 

 SNMP Community The name of the SNMP grouping. 

 SNMP Message Text message to accompany the alert information in the SNMP 
trap. 
Messages can use Alert Message Variables see section 
6.2.2.3. 

Command Command Path to any desired command to be executed upon an alert 
event. 

 Parameters Argument(s) to the command (if needed). 

EventLog/SysLog EventLog/SysLog Check this checkbox to activate an operating system log entry. 

 Log Message Enter a string with embedded variables to be inserted in the 
operating system log. 
Messages can use Alert Message Variables see section 
6.2.2.3. 
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6.2.2.3 Alert Message Variables 

Tuning Manager can display data values as a part of email messages or SNMP messages. To 
make use of this feature, you embed one or more variables in a message string. At runtime, the 
alert handler substitutes your embedded variable references with the current values. See 
Table 6.6 for the full list. 

� Each variable must be prefixed by two successive % characters. 

� Variables are not case-sensitive. 

� Variables must be followed by at least one space character. 

Example: 

Alert: %%HostName only has %%Free free out of a total capacity of %%Capacity. 

Table 6.6 shows the alert message variables, categorized by resource type. 

Table 6.6 Alert Message Variables Categorized by Resource Type 

Resource Variables (not case sensitive) 

Server � HostName 
� IPAddress 
� OS 
� Memory 
� CPU% 
� Capacity 
� Free 
� Free% 
� IOPS 

� WriteIOPS 
� ReadIOPS 
� Transfer 
� ReadTransfer 
� WriteTransfer 
� GrowthRate 
� LocalFilesystems 
� ImportedFilesystems 
� DeviceFiles 

Filesystem � MountPoint 
� LogicalDevice 
� DiskGroup 
� Capacity 

� Free 
� Free% 
� GrowthRate 
� Inodes 

Device File � Name 
� IOPS 
� ReadIOPS 
� WriteIOPS 

� Transfer 
� ReadTransfer 
� WriteTransfer 
� IOResponseTime 
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Resource Variables (not case sensitive) 

Storage 
Subsystem 

� SerialNumber 
� ProductName 
� VendorID 
� CacheCapacity 
� CacheUsage 
� Cache% 
� PortMaxIOPS 
� PortMinIOPS 
� PortIOPS 
� PortMaxTransfer 
� PortMinTransfer 
� PortTransfer 

� DiskIOPS 
� DiskReadIOPS 
� DiskWriteIOPS 
� DiskTransfer 
� DiskReadTransfer 
� DiskWriteTransfer 
� WritePendingRate 
� MaxWritePendingRate 
� SideFileUsage 
� MaxSideFileUsage 
� Ports 
� ArrayGroups 
� LogicalDisks 

Storage Port � Name 
� Subsystem.SerialNumber 
� Subsystem.VendorID 
� Subsystem.ProductName 
� PortMaxIOPS 
� PortMinIOPS 
� PortIOPS 

� PortMaxTransfer 
� PortMinTransfer 
� PortTransfer 

CLPR � CacheCapacity 
� WritePendingRate 
� MaxWritePendingRate 

� SideFileUsage 
� MaxSideFileUsage 
� Name 

Array Group � Name 
� RaidLevel 
� DiskIOPS 
� DiskReadIOPS 
� DiskWriteIOPS 
� DiskRandomIOPS 
� DiskSequentialIOPS 
� DiskTransfer 

� DiskReadTransfer 
� DiskWriteTransfer 
� DiskRandomTransfer 
� DiskSequentialTransfer 
� ReadHitRatio 
� WriteHitRatio 
� IOUsage 
� MaxIOUsage 

Logical Disk � Name 
� Model 
� Subsystem 
� SerialNumber 
� Subsystem.VendorID 
� Subsystem.ProductName 
� DiskIOPS 
� DiskReadIOPS 
� DiskWriteIOPS 
� DiskRandomIOPS 

� DiskSequentialIOPS 
� DiskTransfer 
� DiskReadTransfer 
� DiskWriteTransfer 
� DiskRandomTransfer 
� DiskSequentialTransfer 
� IOResponseTime 
� ReadIOResponseTime 
� WriteIOResponseTime 
� ArrayGroup.Name 



  HiCommand Tuning Manager User's Guide 189 

Resource Variables (not case sensitive) 

Switch � Model 
� Vendor 
� Name 
� TransferredBytes 
� ReceivedFrames 
� TransferredFrames 
� InputBufferFull 

� SwitchWWN 
� DomainID 
� Ports 
� PortModules 
� ReceivedBytes 
� BufferCreditZeroState 
� FabricName 

Switch Port � PortModule 
� PortNumber 
� PortType 
� PortSpeed 
� PortWWN 
� BufferCreditZeroState 
� ReceivedBytes 
� TransferredBytes 

� ReceivedFrames 
� TransferredFrames 
� InputBufferFull 
� Switch.Name 
� Switch.Model 
� Switch.Vendor 
� Switch.SwitchWWN 
� Switch.FabricName 

Oracle Instance � Name 
� Version 
� Host 
� Capacity 
� Free 
� Usage 
� Free% 

� GrowthRate 
� DataFiles 
� TableSpaces 
� IOPS 
� WriteIOPS 
� ReadIOPS 

Tablespace � Name 
� Capacity 
� Free 
� Usage 
� Free% 
� GrowthRate 

� DataFiles 
� RollbackSegments 
� SortSegments 
� IOPS 
� WriteIOPS 
� ReadIOPS 

Data File � Name 
� Size 

� IOPS 
� WriteIOPS 
� ReadIOPS 

Table 6.7 shows alert message variables that provide names and values: 
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Table 6.7 Alert Message Variables Providing Names and Values 

Type Variables (not case sensitive) 

Data Category Filesystem Server.HostName 
Server.IPAddress 

 Device File Server.HostName 
Server.IPAddress 

 Tablespace OracleInstance.Name 

 Data File TableSpace.Name 
TableSpace.OracleInstance.Name 

Alert Types The metric on which the alert 
is defined 

METRIC 

 Date & Time of the alert DATE 

 The level of alert 
(OK, Warning, Critical) 

LEVEL 

 Alert event threshold THRESHOLD 

 The comparison operator 
against which the threshold is 
measured  
(=, >, <, >=, <=) 

OPERATOR 

 Actual value of the metric 
when the alert occurred 

VALUE 

 

6.2.3 Binding Alerts 

Binding is the final step in setting up an alert. 

The two types of binding for an alert are as follows: 

� Binding to a single resource 

� Using bind propagation (for multiple resources) 

6.2.3.1 Binding to a Single Resource 

To bind an alert to the resource category and action: 

1. Click Explorer and then Alert. 

2. In Resource Tree in the Navigation area, select the correct resource category you want to 
monitor. 

3. In the Tab area, click the Bind tab. 

A list of bound alerts appears. See Figure 6.4. 
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4. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

5. Click Bind Alert. 

The Alert Activation 1 window appears. See Figure 6.5. 

6. Click the radio button for the alert you want to bind. 

7. Click Next. 

The Alert Activation 2 window appears. See Figure 6.6. 

8. (Optional) To view an alert definition, click the hyperlink for the alert name. 

9. Notification type: Specify whether this alert condition will be set to notify repeatedly 
while the condition is met (Always) or one time only (Once Per Condition). See Figure 6.7 

Note: If you choose Once per condition you must manually reset the alert after it has been 
triggered. If you do not reset the alert, there will be no further notifications. For more 
information, see section 6.5.7. 

10. You can choose which actions happen under each of the possible alert states (OK, Critical 
and Warning). 

11. (Optional) To view the definition for your chosen action, click the hyperlink for the Action 
Name. 

12. To assign a given action to a specific state, click the alert state checkbox(es) for the 
actions you want performed. See Figure 6.8. 

13. Click Save to complete activation. (Click Cancel to abandon this operation.) 

The Confirmation window appears. 

14. Click Close to close the Confirmation window. 
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Figure 6.4 List of Bound Alerts 

 

Figure 6.5 The Alert Activation 1 Window 
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Figure 6.6 The Alert Activation 2 Window 

 

Figure 6.7 Selecting the Notification Type 

 

Figure 6.8 Selecting Alert States 

6.2.3.2 Using Bind Propagation (for Multiple Resources) 

When you want to bind multiple resources sharing the same parent, bind propagation is more 
productive than selecting one resource at a time. 
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Example: You want to bind an alert to all filesystems found on all servers on a given 
subnetwork. 

1. Define an alert. See section 6.2.1. 

In this example you would set the Data Category to Filesystem. This will ensure that 
filesystems are being monitored for the alert condition. 

2. Create an alert action. See section 6.2.2. 

3. In the tree in the Navigation area, navigate to the subnetwork level. See Figure 6.9. 

4. Bind the alert definition and alert action. See section 6.2.3. 

Tuning Manager will propagate this binding to all filesystems within that subnetwork. 

Note: If you use bind propagation, you must unbind resources at the same parent level. For 
more information, see section 6.5.2.2. 

 

Figure 6.9 Navigating to the Subnetwork Level in the Resource Tree 
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6.3 Testing Alerts 

This function gives you a way to test the appropriateness of an alert you have already defined 
and bound. You supply values that should either trigger the alert or should fall outside of its 
monitored range. Alerts that are triggered by testing are not displayed in the Alert History. 

Note: Manager or Administrator privileges are required to test alerts. 

To test an alert you have already bound: 

1. Display the Bind window for Alert. 

2. In the Tab area, click the Bind tab. 

The bound alerts list is displayed. See Figure 6.10. 

3. Click Test for the specific alert. 

The Alert Activation Test window is displayed. 

4. Specify a value. This value will be compared to each of the conditions in your alert 
definition. 

5. Click Test. 

The result of the test is displayed in a popup status window. See Figure 6.11. 

6. Click Close to remove the popup window. 

 

Figure 6.10 The Bound Alerts List 

 

Figure 6.11 The Alert Test Status Window 
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6.4 Viewing Alerts 

This section describes how to view alerts. Alerts that have already been reported can be 
displayed in a table format. 

To view an alert: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the View tab. 

The Alerts list is displayed. See Table 6.8 for a description of displayed information. 

Note: Displayed values do not always indicate that an alert condition has been reached. 
For more information, see section 6.6. 

 

Figure 6.12 The Alerts List 

The View Alerts list displays the information described in the Table 6.8. 
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Table 6.8 View Alert Data 

Column Description 

Record Taken The date and time for the occurrence of the alert condition. 

Resource The resource associated with the alert. 

Data Category The resource type responsible for generating the alert: 
� Server 
� Filesystem 
� Device File 
� Storage Subsystem 
� Storage Port 
� Array Group 
� Logical Disk 
� Oracle Instance 
� Tablespace 
� Data File 
� Switch 
� Switch Port 
� CLPR 

Threshold The threshold condition for which the alert was triggered, according to the value in the Status 
field. 
� If the status is Critical, the critical threshold statement is shown. 
� If the status is Warning, the warning threshold statement is shown. 
� If the status is OK, the lowest threshold statement is shown. 

By default, the Warning statement is shown. 
If Warning is not set, the Critical statement is shown. 

Status The status of the resource at the alert time. 
� Red: critical 
� Yellow: warning 
� Green: OK 
Note: Have you configured an alert as once per condition? If a Warning or Critical status has 
been reached, you can reset the agent status. 

Message The value of the metric that triggered the alert in the format metric = value. 
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6.4.1 Sorting the View Alerts List 

To sort the Alerts List, click the column heading for the column you want to sort. 

 

Figure 6.13 Sorting a Column of Alerts 
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6.4.2 Displaying an Alert History 

Note: Displayed values do not always indicate that an alert condition has been reached. For 
more information, see section 6.6. 

Older alert occurrences are deleted in the Tuning Manager database when they fall outside the 
limits of the Alert Retention Period settings of Data Retention in Administration, accessed 
from the Explorer menu. To find out how long your site's database retains data, ask your 
system administrator. 

To display the list of the past alert notifications: 

1. Click Explorer and then Alert. 

2. In the Information area, click the Show Alert History link. 

3. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

4. Click Close to close the window. 

 

Figure 6.14 The Alert History List 

The Alert History window appears. 

 

Figure 6.15 The Alert History Window 
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6.5 Editing an Alert Definition 

You edit an alert definition when you want to: 

� change the set thresholds for alerts 

� modify the actions taken when the value reaches the threshold 

� set a new alert by using an existing alert 

You can edit or copy the set alerts, if needed.  

Note: This activity requires Manager or Administrator privileges. 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Define tab. 

The Alerts list appears. 

3. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

4. Click the hyperlink for the alert you wish to edit. 

The Alert Setting 1 window appears. 

Note: The data category cannot be changed if this alert is currently bound. 

5. Change fields as necessary in this window. Table 6.3 on section 6.2.1. 

6. Click Next. 

The Alert Setting 2 window appears. 

Note: Displayed values do not always indicate that an alert condition has been reached. 
For more information, see section 6.6. 

7. Change fields as necessary in this window. Table 6.4 on section 6.2.1. 

8. Click Save (or click Cancel to abandon changes). 

Note: Defining an alert is similar to adding one. For detailed information, see section 
6.2.1. 
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6.5.1 Editing Alert Bindings 

To edit a bound alert: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Bind tab. See Figure 6.16. 

The Alerts list appears. 

3. Click Edit in Action Links for the alert you want to alter. See Figure 6.17. 

The Alert Activation 2 window appears. See Figure 6.18. 

4. Make the desired changes, then click Save to retain them. 

The Confirmation window appears. 

5. Click Close to continue. 

Note: If an alert was bound through propagation at a higher level, you cannot unbind directly 
at the lowest levels of resource tree impacted by the original binding. You must return to the 
level where you performed the binding. 

You may edit an alert definition at its own resource level (regardless of the level at which you 
bound the alert). 

The Alerts list indicates the origin of the binding. For more information, see section 6.5.2.2. 

 

Figure 6.16 The Bind Link for Alerts 

 

Figure 6.17 The Alerts List 
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Figure 6.18 The Second Alert Definition Window 
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6.5.2 Unbinding Alerts 

6.5.2.1 Unbinding an Alert that is Bound to a Single Resource 

To unbind an alert: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Bind tab. See Figure 6.19. 

A list of bound alerts appears. 

3. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

4. Click Unbind for the Alert Name you have chosen to unbind. See Figure 6.20. 

The Confirmation window appears. 

5. Click Close to close the Confirmation window. 

 

Figure 6.19 The Bind Link for Alerts 

 

Figure 6.20 Unbinding an Alert 



204  Chapter 6 Working with Alerts 

6.5.2.2 Unbinding Propagated Alerts 

If an alert was bound through propagation at a higher level, you can only unbind that alert by 
returning to the originating level of resource tree. When an alert is the result of propagation, 
the Alerts list displays the originating level (see the Remarks column): 

To unbind a propagated alert: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Bind tab. 

3. Click Bind. See Figure 6.21. 

4. In Resource Tree, navigate to the level where the alert was bound. 

5. Click Unbind for the alert. 

A Confirmation window is displayed. 

6. Click OK to proceed with unbinding. (Or click Cancel to abandon unbinding.) 

The Confirmation window appears. 

7. Click Close to close the Confirmation window. 

 

Figure 6.21 The Bind Link for Alerts 

6.5.3 Copying Alerts 

To copy an alert: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Bind tab. 

The Alerts list appears. See Figure 6.22. 

3. To move through the list, click Next or Previous. When multiple subtables are available for 
display, you can jump directly to each section of the table. Numbered hyperlinks appear 
for this purpose. 

4. Click Copy for the alert you wish to copy. 

The Alert Setting 1 window appears with the same settings as the alert you chose. 

5. Change any relevant settings in this window. 

6. Click Next to proceed to the second alert setting window. 

The Alert Setting 2 window appears. 

7. Change any relevant settings in this window. 
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8. Click Save. 

The Information area refreshes to include the newly copied alert definition. 

 

Figure 6.22 The Alerts List 

6.5.4 Deleting Alerts 

To delete alerts: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Define tab. 

The Alerts list appears. 

3. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

4. Click Delete in Action Links for the alert you wish to remove. See Figure 6.23. 

A confirmation window is displayed. 

Note: If the alert is already bound, you must first unbind the alert before deleting it. 

5. Click OK to proceed with deletion. (Or click Cancel to abandon deletion.) 

The Confirmation window appears. 

6. Click Close to close the Confirmation window. 
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Figure 6.23 Deleting an Alert 

6.5.5 Copying Alert Actions 

To copy an alert action: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Action tab. 

The Alert Actions list appears. 

3. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

4. Click Copy for the action you want to duplicate. 

The Action Definition window appears for the action. See Figure 6.24. 

5. Change any relevant settings in this window. For more information, see section 6.2.2.2. 

6. Click Save. 

The Information area refreshes to display the newly added alert action. 
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Figure 6.24 The Action Definition Window for Alerts 

6.5.6 Deleting Alert Actions 

To delete an Alert action: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Action tab. 

The Alert Actions list appears. 

3. To move through the list, click Next or Previous. When multiple subtables are available 
for display, you can jump directly to each section of the table. Numbered hyperlinks 
appear for this purpose. 

4. Click Delete for the action you want to remove. 

The Confirmation window appears. 

5. Click Close to close the Confirmation window. 
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6.5.7 Resetting Alerts 

For alerts with the notification type of Once per condition, you will need to reset alerts 
manually. 

To reset an alert: 

1. Click Explorer and then Alert. 

2. In the Tab area, click the Reset tab. 

The Alert Reset list is displayed. See Figure 6.25. 

3. Click the Reset hyperlink for the Alert you wish to reset. See Figure 6.26. 

The Confirmation window appears. 

4. Click Close to continue. 

 

Figure 6.25 The Alert Reset List 

 

Figure 6.26 Resetting an Alert 
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6.5.8 Receiving SNMP Alerts 

A MIB definition file HTM-NOTIFICATION-MIB.txt is included in the filesystem when Tuning 
Manager is installed. If you are using SNMP management software, you can use the MIB file to 
properly identify the objects monitored by Tuning Manager. 

You can find the MIB file at Installation directory/docs/HTM-NOTIFICATION-MIB.txt. 

The following shows the structure of MIB objects for SNMP traps used by Tuning Manager. 

iso(1).org(3).dod(6).internet(1).private(4).enterprise(1) 

      | 

hitachi(116) 

      | 

systemAP(7) 

      | 

hiCommand (35) 

      | 

tuningMgr(1) 

The contents of the MIB object in Tuning Manager are as follows: 

� Object ID 

.1.3.6.1.4.1.116.5.35.1 

� Contents 

The user-defined message that was specified during the alert definition. 
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6.6 Notes on Alerts 

Metric Rounding and Alert Condition Evaluation 

Throughout Tuning Manager, values are rounded for convenient display. Rounding occurs both 
for integer and real number values. 

Also see the Glossary for Local Filesystems, Filesystem Type, Imported Filesystems and 
Filesystems Over Capacity. 

The Tuning Manager database stores collected values at a higher precision and evaluates alert 
conditions based on those actual values. 

As a result, there are circumstances when a displayed value might lead you to believe that you 
have reached an alert threshold, but Tuning Manager has not actually encountered an alert 
state. 

Example: 

– For a given metric, you have specified an alert value of >= 2.5 for Warning Value or 
Critical Value (see section 6.2.1). 

– The value for that metric is collected and then stored in the database as 2.4999. 

– The displayed value for the metric is 2.5, (as a result of the standard rounding rule). 

Result: No alert is triggered because the actual value (2.4999) has not reached your 
specified threshold value (>= 2.50). 
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Chapter 7 Analyzing a Performance Bottleneck 

This chapter describes how to analyze performance bottlenecks using Tuning Manager reports, 
and it provides an example analysis procedure. 

� Reviewing Key Points for Analyzing Performance Bottlenecks (see section 7.1) 

� Example Analysis Procedure (see section 7.2) 
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7.1 Reviewing Key Points for Analyzing Performance Bottlenecks 

An environment that is integrated by storage consolidation contains many servers and storages, 
which can present challenges when pinpointing performance bottlenecks. For example, it can 
be difficult to determine which servers use particular storage and which ports are shared by 
certain servers. However, by understanding the relationship between the configuration of a 
monitored system, and the analysis procedure and procedure policies, you can successfully use 
Tuning Manager to identify and troubleshoot performance degradation. 

7.1.1 Understanding the Relationship between the System Configuration and the Analysis 

Procedure 

The analysis of performance information can only be accomplished when you understand the 
configuration of the system that you are monitoring. To illustrate, Figure 7.1 provides an 
example system configuration that Tuning Manager is monitoring. 

 

Figure 7.1 Example System Configuration that is Monitored by Tuning Manager 
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Typically, the locations where performance bottlenecks occur fall into two basic categories: 

� Servers (applications and device files) 

� Devices other than a server (switches and storages) 

If a performance bottleneck occurs in one of your applications, analyze the performance 
information in the following order: 

1. Analyze the performance information for the server running the application. 

If you find the cause of the performance bottleneck, the analysis ends. If you do not find 
the cause, you can assume that the cause is a device other than a server. 

2. Analyze the performance information related to the storages that the application uses. 

Analyze each item of storage-related performance information for the storage port and 
array group until you are able to determine the cause of the performance bottleneck. 

For details on key points for analyzing performance bottlenecks and the analysis procedure, 
see Table 7.1. 

7.1.2 Analysis Procedure Considerations 

In performance bottleneck analysis, it is important to determine the order in which resources 
should be analyzed. Figure 7.2 shows the resources to which performance bottleneck analysis 
can be applied. 

 

Figure 7.2 Resources to Which Performance Bottleneck Analysis Can Be Applied 
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Table 7.1 describes performance bottleneck analysis policies and the corresponding analysis 
procedures. 

Table 7.1 Guidelines for Analyzing a Performance Bottleneck 

Guideline Procedure Location 

Check whether the performance bottleneck 
occurs on a server in the following order: 
1. Check the server running the 

application. 
2. Check the resources, other than the 

server, used by the application. 
Also use the I/O performance having the 
most effect on application performance to 
determine the cause. 

1 Display a list of the device files used by 
the server running the application. 

7.2.1.1 Identify the 
Host Name based 
on the Oracle 
Instance 
7.2.1.2 Check the 
I/O Response Time 

 2 Check the I/O performance (especially 
I/O Response Time) for all the device 
files used by the server. 
Determine the condition by checking the 
I/O performance. You can assume that a 
performance bottleneck occurred on a 
server in the following cases: 
� A value has changed rapidly. 
� When viewed relatively, a value is 

extremely high. 

 

I f you do not find any performance 
bottlenecks on the servers, continue your 
check by checking locations other than 
servers. 
Because storage ports shared by multiple 
servers are subject to performance 
bottlenecks, check storage ports. 
For this check, use the I/O performance of 
the shared resources to determine the 
cause. 

3 Check the I/O performance of the 
storage port for a device file. 

7.2.1.3 Check 
Storage Port 
Performance 

 4 If the I/O performance of the server 
running the application is not a problem, 
check whether any other servers access 
the same storage port. 

7.2.1.4 Check 
Connected Server 
Performance 

 5 Check the I/O performance of the other 
servers. 

 

 6 Pinpoint any servers placing a heavy 
load on the storage port. 

 

 7 If the I/O performance of the storage port 
is not a problem, check the I/O 
performance of the array group. 

 

 8 Check whether any other servers access 
the same array group. 

 

 9 Pinpoint any servers that are placing a 
heavy load on the array group. 
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7.2 Example Analysis Procedure 

This section provides an example of a performance bottleneck analysis procedure. The 
example is based on the items described in the previous sections. 

Figure 7.3 shows the configuration of the system to be monitored in the example. 

 

Figure 7.3 Configuration of the System to Be Monitored 
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Table 7.2 lists the components of the system to be monitored in the example. 
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Table 7.2 Components of the System to Be Monitored 

Component Name 

Server � Gateway A  
� Gateway B 
� CQ-6400-4 

Switch Switch 103 

Storage � Lightning 9970V 
� USP 10226 

7.2.1 Analyzing the Performance Bottleneck 

The following procedures are used to analyze the performance bottleneck. 

7.2.1.1 Identify the Host Name based on the Oracle Instance 

1. In the title area of the application area, choose Historical Report Window then specify the 
time period when the system seemed to run stably. 

2. In the title area in the application area, choose Report Window then specify the time 
when the problem occurred. 

3. In the explorer area, choose Resources and then Applications. 

4. In the navigation area, choose Oracle. 

A list of Oracle instances appears in the information area (Sub-resource section). You can 
see that an instance named HTM is running on Gateway B. 

5. In the explorer area, choose Resources and then Hosts. 

7.2.1.2 Check the I/O Response Time 

1. In the navigation area, select Gateway B. 

A list of performance information for the host and array on Gateway B appears in the 
information area (Sub-resource section). 

2. On the Host/Array Correlation tab, select Delta from the host-side header of the 
performance information list. 

The rows are sorted in descending order of the delta values (in descending order of the 
percentage of the Response Time values compared to the Historical Response Time values). 
You can see that the delta value for device file 8 is the largest. 

3. In the information area (Advanced Information), choose Device File Performance. 

The IOPS information for the device file appears in graph form and list form. 

4. To start Performance Reporter, choose Global from the global tasks bar area, then Go. 

5. In the Information frame, choose User Reports. 
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A list of predefined reports appears. 

6. Select I/O Response Time. 

The Show Options window appears. For details on how to define the reports to be displayed 
here, see section 5.11. 

7. In the Show Options window, specify the values shown in Table 7.3. 

Table 7.3 Settings in the Show Options Window for Checking IDs 

Item Settings 

Start Time 

End Time 

To clarify how the performance information changed, 
specify times before and after the deterioration in Oracle 
performance seemed to begin. 

Settings for the report display period 

Report Interval Minute 

ID 8 

Note: Since you found in step 2 that the I/O Response Time 
value for device file 8 was the largest of the device files 
used for Gateway B, specify 8. 

Filter 

Disk Bytes/sec  0 

Note: Main Console and Performance Reporter manage 
different IDs. In this specification, you know that the device 
file ID in Main Console is 8, but do not know the ID in 
Performance Reporter. To display a list of the device file IDs 
managed by Performance Reporter, specify 0 for Disk 
Bytes/sec. 

I/O Response History appears for all device files on Gateway B. 

From the displayed report, check the ID of device file 8. 

This example assumes that the ID of device file 8 (checked above) is 8∆H: (∆ indicates a 
space). 

8. In the Show Options window, specify the values shown in Table 7.4. 

Table 7.4 Settings in the Show Options Window for Checking the I/O Response Time 

Item Settings 

Start Time 

End Time 

To clarify how the performance information changed, specify times before and 
after the deterioration in Oracle performance seemed to begin. 

Settings for the report 
display period 

Report Interval Minute 

ID 8∆H: 
Note: Since you found in step 8 that the ID of device file 8 used for Gateway B 
was 8∆H:, specify 8∆H:. 

Filter 

Disk Bytes/sec  99999999 

Note: To display the I/O Response Time value only for device file 8, specify a 
value that exceeds the maximum possible performance value for the relevant 
environment. 99999999 is specified here.  

I/O Response History appears for device file 8 on Gateway B. You must check if the value 
increase in I/O Response Time was caused by shared resources (ports and array groups). 
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Figure 7.4 I/O Response History for Device File 8 on Gateway B 

7.2.1.3 Check Storage Port Performance 

To check the performance of the storage port: 

1. In Main Console, choose the explorer area then Hosts. 

2. Choose Gateway B. 

Performance information for the host and array appears in the information area 
(Sub-resource section). 

3. Choose the Device File tab. 

A list of the device files appears in the information area (Sub-resource section). 

4. Choose CL4-E, which is the port for device file 8. 

Information about CL4-E appears in the report area. 

5. In the information area (Advanced Information), choose Performance Reporter : RAID 
(Gateway B). 

Performance Reporter starts and the Show Options window appears. 

6. In the Show Options window, specify the values shown in Table 7.5. 
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Table 7.5 Settings in the Show Options Window for Checking the Storage Port Performance 

Item Settings 

Start Time 

End Time 

To clarify how the performance information changed, specify times before and after 
the deterioration in Oracle performance seemed to begin. 

Settings for 
the report 
display period 

Report Interval Minute 

Filter Port Name CL4-E 

Xfer Rate History for CL4-E appears. You need to determine the server that caused the 
value increase in Transfer Rate for CLL4-E. 

 

Figure 7.5 Xfer Rate History for CL4-E 
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7.2.1.4 Check Connected Server Performance 

1. Redisplay the Main Console window. In the information area (Advanced Information), 
choose List Connected Server. 

A list of all servers and device files using CL4-E appears. After sorting data in the Transfer 
column in descending order, you can see that the Transfer value for device file 5 in 
CQ6400-4 is the largest. 

2. In the Navigation frame, choose Windows. 

3. In the Information frame, choose User Reports. 

A list of predefined reports appears. 

4. Select Connected Server Performance. 

The Show Options window appears. For details on how to define the reports to be displayed 
here, see section 5.11. 

5. In the Show Options window, specify the values shown in Table 7.3. 

Note: Specify 5 for the Filter ID. 

Transfer Rate History appears for all device files on CQ6400-4. 

From the displayed report, check the ID of device file 5. 

This example assumes that the ID of device file 5 (checked above) is 5∆G: (∆ indicates a 
space). 

6. In the Show Options window, specify the values shown in Table 7.6. 

Table 7.6 Settings in the Show Options Window for Checking the Transfer Rate History 

Item Settings 

Start Time 

End Time 

To clarify how the performance information changed, specify 
times before and after the deterioration in Oracle performance 
seemed to begin 

Settings for the report display period 

Report Interval Minute 

ID 5∆G: 
Note: Since you found in step 6 that the ID of device 
file 5 used for CQ6400-4 was 5∆G:, specify 5∆G:. 

Filter 

Disk Bytes/sec 99999999 

Note: To display the Transfer Rate History value only for device 
file 5, specify a value that exceeds the maximum possible 
performance value for the relevant environment. 99999999 is 
specified here. 

Transfer Rate History for CQ6400-4 appears. 
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Figure 7.6  Transfer Rate History for CQ6400-4 

You can see that the I/O value for CQ6400-4 rose sharply. 

This means that the performance deterioration on Gateway B was caused by a rapid increase in 
I/O by CQ6400-4, which was using the same port as Gateway B. 
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Appendix A Tuning Manager Metrics and Restrictions 
This appendix describes the metrics that Tuning Manager supports and the restrictions on these 
metrics. 

� Lists of Metrics (see section A.1) 

� Metrics Displayed by Tuning Manager and the Versions of the Agents from which 
Information Is Collected (see section A.2) 

� Agent Restrictions (see section A.3) 

� Technical Support (see section A.4) 
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A.1 Lists of Metrics 

Tables A.1 to A.9 show the correspondence between the metrics displayed by Main Console and 
the field values displayed by Performance Reporter for each agent, and whether alerts can be 
set using the GUI. Use this information when using Performance Reporter to define a report. 

Table A.1 Metrics for Agent for RAID 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Subsystem Cache Memory 
Capacity 

Cache Memory 
Capacity 

Storage Summary(PI) Not supported 

Subsystem Cache Usage Cache Memory Usage Storage Summary(PI) Supported 

Subsystem Side File Capacity Cache Side File Usage Storage Summary(PI) Not supported 

Subsystem Side File Usage Cache Side File 
Usage % 

Storage Summary(PI) Supported 

Subsystem Write Pending Rate Cache Write Pending 
Usage 

Storage Summary(PI) Supported 

Subsystem Write Pending Rate Cache Write Pending 
Usage % 

Storage Summary(PI) Supported 

Subsystem Max Side File Usage Max Cache Side File 
Usage % 

Storage Summary(PI) Supported 

Subsystem Max Write Pending 
Rate 

Max Cache Write 
Pending Usage % 

Storage Summary(PI) Supported 

CLPR Cache Capacity Cache Memory 
Capacity 

CLPR 
Summary(PI_CLPS) 

Supported 

CLPR Not applicable Cache Side File Usage CLPR 
Summary(PI_CLPS) 

Not supported 

CLPR Side File Usage Cache Side File 
Usage % 

CLPR 
Summary(PI_CLPS) 

Supported 

CLPR Not applicable Cache Write Pending 
Usage 

CLPR 
Summary(PI_CLPS) 

Not supported 

CLPR Write Pending Rate Cache Write Pending 
Usage % 

CLPR 
Summary(PI_CLPS) 

Supported 

CLPR Not applicable CLPR_Number CLPR 
Summary(PI_CLPS) 

Not supported 

CLPR Max Side File Usage Max Cache Side File 
Usage % 

CLPR 
Summary(PI_CLPS) 

Supported 

CLPR Max Write Pending 
Rate 

Max Cache Write 
Pending Usage % 

CLPR 
Summary(PI_CLPS) 

Supported 

LDEV Name LDEV Number Logical Device 
Summary(PI_LDS) 

Not supported 



  HiCommand Tuning Manager User's Guide 225 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

LDEV Disk Random IOPS Random Total I/O /sec Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Disk Random Transfer Random Total Xfer 
/sec 

Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Read Hit Ratio Read Hit I/O Count Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Not applicable Read Hit % Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Read Hit Ratio Read I/O Count Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Disk IOPS Read I/O /sec Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Not applicable Read Mbytes Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Read I/O Response 
Time 

Read Response Rate Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Not applicable Read Total Response Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Disk Transfer Read Xfer /sec Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Disk Sequential IOPS  Sequential Total I/O 
/sec 

Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Disk 
SequentialTransfer  

Sequential Total Xfer 
/sec 

Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV I/O Response Time Total Response Rate Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Not applicable Write Xfer /sec Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Write Hit Ratio Write Hit I/O Count Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Not applicable Write Hit % Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Write Hit Ratio Write I/O Count Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Disk IOPS Write I/O /sec Logical Device 
Summary(PI_LDS) 

Supported 

LDEV Not applicable Write Mbytes Logical Device 
Summary(PI_LDS) 

Not supported 

LDEV Write I/O Response 
Time 

Write Response Rate Logical Device 
Summary(PI_LDS) 

Supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

LDEV Not applicable Write Total Response Logical Device 
Summary(PI_LDS) 

Not supported 

Processor(CHP/DKP) Not applicable Adaptor ID Processor 
Summary(PI_PRCS) 

Not supported 

Processor(CHP/DKP) Not applicable Max Processor Busy % Processor 
Summary(PI_PRCS) 

Not supported 

Processor(CHP/DKP) Not applicable Processor Busy % Processor 
Summary(PI_PRCS) 

Not supported 

Processor(CHP/DKP) Not applicable Processor ID Processor 
Summary(PI_PRCS) 

Not supported 

Processor(CHP/DKP) Not applicable Processor Type Processor 
Summary(PI_PRCS) 

Not supported 

Port Port IOPS Avg I/O /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Transfer Avg Xfer /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Max IOPS Max I/O /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Max Transfer Max Xfer /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Min IOPS Min I/O /sec Port 
Summary(PI_PTS) 

Supported 

Port Port Min Transfer Min Xfer /sec Port 
Summary(PI_PTS) 

Supported 

Port Not applicable Port Name Port 
Summary(PI_PTS) 

Not supported 

Port Port number Port Number Port 
Summary(PI_PTS) 

Not supported 

Array Group Usage Busy % RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Max Usage Max Busy % RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Not applicable RAID Group Number RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Disk Random IOPS Random Total I/O /sec RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Disk Random Transfer Random Total Xfer 
/sec 

RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Read Hit Ratio Read Hit I/O Count RAID Group 
Summary(PI_RGS) 

Supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Array Group Not applicable Read Hit % RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Read Hit Ratio Read I/O Count RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Disk IOPS Read I/O /sec RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Not applicable Read Mbytes RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Disk Transfer Read Xfer /sec RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Disk Sequential IOPS  Sequential Total I/O 
/sec 

RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Disk 
SequentialTransfer  

Sequential Total Xfer 
/sec 

RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Not applicable Write Xfer /sec RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Write Hit Ratio Write Hit I/O Count RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Not applicable Write Hit % RAID Group 
Summary(PI_RGS) 

Not supported 

Array Group Write Hit Ratio Write I/O Count RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Disk IOPS Write I/O /sec RAID Group 
Summary(PI_RGS) 

Supported 

Array Group Not applicable Write Mbytes RAID Group 
Summary(PI_RGS) 

Not supported 

Table A.2 Metrics for Agent for SAN Switch 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Fabric Not applicable Device Count System Summary(PI) Not supported 

Fabric Not applicable Node Count System Summary(PI) Not supported 

Fabric Not applicable Port Count System Summary(PI) Not supported 

Fabric Not applicable Port Module Count System Summary(PI) Not supported 

Fabric Switches Switch Count System Summary(PI) Not supported 

Switch port Not applicable Address Errors Count Port Error 
Summary(PI_PTES) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Switch port Not applicable Area ID Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable CRC Error Count Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Delimiter Errors Count Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Encoding Disparity 
Count 

Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Invalid Ordered Set 
Count 

Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Invalid Xmitd Words 
Count 

Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Link Failures Count Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Loss of Signal Count Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Loss of Sync Count Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Port Mode Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Port Module Number Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Port Number Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Port Ops Status Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Port Type Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Port WWN Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Prim Seq Proto Error 
Count 

Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Rcvd Link Reset Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Rcvd Offline Sequence Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Switch WWN Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Too Long Frames 
Count 

Port Error 
Summary(PI_PTES) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Switch port Not applicable Too Short Frames 
Count 

Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Xmitd Link Reset Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Xmitd Offline 
Sequence 

Port Error 
Summary(PI_PTES) 

Not supported 

Switch port Not applicable Area ID Port 
Summary(PI_PTS) 

Not supported 

Switch port Buffer Credit Zero 
State 

Buffer Credit Zero 
State Count 

Port 
Summary(PI_PTS) 

Not supported 

Switch port Input Buffer Full Input Buffers Full 
Count 

Port 
Summary(PI_PTS) 

Supported 

Switch port Not applicable Port Module Number Port 
Summary(PI_PTS) 

Not supported 

Switch port Port number Port Number Port 
Summary(PI_PTS) 

Not supported 

Switch port Not applicable Port Type Port 
Summary(PI_PTS) 

Not supported 

Switch port Not applicable Port WWN Port 
Summary(PI_PTS) 

Not supported 

Switch port Received Bytes Rcvd Bytes / sec Port 
Summary(PI_PTS) 

Supported 

Switch port Not applicable Rcvd Frames Port 
Summary(PI_PTS) 

Not supported 

Switch port Received Frames Rcvd Frames / sec Port 
Summary(PI_PTS) 

Supported 

Switch port Not applicable Rcvd Kbytes Port 
Summary(PI_PTS) 

Not supported 

Switch port Not applicable Rcvd Multicast Frames Port 
Summary(PI_PTS) 

Not supported 

Switch port Not applicable Switch WWN Port 
Summary(PI_PTS) 

Not supported 

Switch port Transferred Bytes Xmitd Bytes / sec Port 
Summary(PI_PTS) 

Supported 

Switch port Not applicable Xmitd Frames Port 
Summary(PI_PTS) 

Not supported 

Switch port Transferred Frames Xmitd Frames / sec Port 
Summary(PI_PTS) 

Supported 

Switch port Not applicable Xmitd Kbytes Port 
Summary(PI_PTS) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Switch port Not applicable Xmitd Multicast 
Frames 

Port 
Summary(PI_PTS) 

Not supported 

Switch Not applicable CRC Error Count Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Domain ID Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Encoding Disparity 
Count 

Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Loss of Signal Count Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Loss of Sync Count Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Model Name Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Switch Mode Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Switch Name Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Switch Ops Status Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Not applicable Switch WWN Switch Error 
Summary(PI_SWES) 

Not supported 

Switch Buffer Credit Zero 
State 

Buffer Credit Zero 
State Count 

Switch 
Summary(PI_SWS) 

Not supported 

Switch Not applicable Domain ID Switch 
Summary(PI_SWS) 

Not supported 

Switch Input Buffer Full Input Buffers Full 
Count 

Switch 
Summary(PI_SWS) 

Supported 

Switch Not applicable Model Name Switch 
Summary(PI_SWS) 

Not supported 

Switch Received Bytes Rcvd Bytes / sec Switch 
Summary(PI_SWS) 

Supported 

Switch Not applicable Rcvd Frames Switch 
Summary(PI_SWS) 

Not supported 

Switch Received Frames Rcvd Frames / sec Switch 
Summary(PI_SWS) 

Supported 

Switch Not applicable Rcvd Kbytes Switch 
Summary(PI_SWS) 

Not supported 

Switch Not applicable Switch Name Switch 
Summary(PI_SWS) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Switch Not applicable Switch WWN Switch 
Summary(PI_SWS) 

Not supported 

Switch Transferred Bytes Xmitd Bytes / sec Switch 
Summary(PI_SWS) 

Supported 

Switch Not applicable Xmitd Frames Switch 
Summary(PI_SWS) 

Not supported 

Switch Transferred Frames Xmitd Frames / sec Switch 
Summary(PI_SWS) 

Supported 

Switch Not applicable Xmitd Kbytes Switch 
Summary(PI_SWS) 

Not supported 

Table A.3 Metrics for Agent for NAS 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Alloc Mem Mbytes System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Alloc Mem % System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Block I/O Ops System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Block Read Ops System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Block Read Ops/sec System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Block Write Ops System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Block Write Ops/sec System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Context Switches System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Context Switches / sec System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable System Up Time System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Processes System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Boot Time System Summary 
Overview(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Users System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable 15-Minute Run Queue 
Avg 

System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable 5-Minute Run Queue 
Avg 

System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Free Memory Mbytes System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Free Memory % System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Host Name System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable ICMP Pkts In System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable ICMP Pkts Out System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Idle % System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Interrupts System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Interrupts/sec System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable IP Pkts In System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable IP Pkts Out System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Kernel CPU % System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable CPU % System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Active CPUs System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable 1-Minute Run Queue 
Avg 

System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Physical I/O Ops System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Physical Read Ops System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Physical Write Ops System Summary 
Overview(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Run Queue System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable TCP Pkts In System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable TCP Pkts Out System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Total Idle Time System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Total Kernel-mode 
Time 

System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Total Physical Memory 
Mbytes 

System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Total Pkts System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Total Pkts In System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Total Pkts Out System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Total User-mode Time System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable UDP Pkts In System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable UDP Pkts Out System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable User CPU % System Summary 
Overview(PI) 

Not supported 

Not applicable Not applicable Device Name Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Host Name Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Mbytes Xferd/sec Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Read Ops Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Read Ops/sec Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Read Ops % Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable I/O Mbytes Device 
Detail(PI_DEVD) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Total I/O Ops Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Total I/O Ops/sec Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Read Mbytes Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Write Mbytes Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Write Ops Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Write Ops/sec Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Write Ops % Device 
Detail(PI_DEVD) 

Not supported 

Not applicable Not applicable Devices Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Host Name Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable I/O Mbytes Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Mbytes Xferd/sec Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Read Mbytes Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Read Ops Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Read Ops % Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Read Ops/sec Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Total I/O Ops Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Total I/O Ops/sec Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Write Mbytes Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Write Ops Device 
Summary(PI_DEVS) 

Not supported 

Not applicable Not applicable Write Ops % Device 
Summary(PI_DEVS) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Write Ops/sec Device 
Summary(PI_DEVS) 

Not supported 

Table A.4 Metrics for Agent for  Platform (Windows) 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (System) Not applicable Alignment Fixups/sec System Overview(PI) Not supported 

Server (File System) Not applicable Async Copy Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Async Data Maps/sec System Overview(PI) Not supported 

Server (File System) Not applicable Async Fast Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Async MDL Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Async Pin Reads/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Available Mbytes System Overview(PI) Not supported 

Server (Network) Not applicable Blocking Reqs 
Rejected 

System Overview(PI) Not supported 

Server (Network) Not applicable Bytes Rcvd/sec System Overview(PI) Not supported 

Server (Network) Not applicable Bytes Total/sec System Overview(PI) Not supported 

Server (Network) Not applicable Bytes Xmitd/sec System Overview(PI) Not supported 

Server (File System) Not applicable Cache Mbytes System Overview(PI) Not supported 

Server (File System) Not applicable Cache Mbytes Peak System Overview(PI) Not supported 

Server (File System) Not applicable Cache Faults/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Commit Limit Mbytes System Overview(PI) Not supported 

Server (Memory) Memory Committed Mbytes System Overview(PI) Not supported 

Server (Network) Not applicable Conns Core System Overview(PI) Not supported 

Server (Network) Not applicable Conns LAN Manager 
2.0 

System Overview(PI) Not supported 

Server (Network) Not applicable Conns LAN Manager 
2.1 

System Overview(PI) Not supported 

Server (Network) Not applicable Conns Windows NT System Overview(PI) Not supported 

Server (System) Not applicable Context Blocks 
Queued/sec 

System Overview(PI) Not supported 

Server (System) Not applicable Context Switches/sec System Overview(PI) Not supported 

Server (File System) Not applicable Copy Read Hits % System Overview(PI) Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (File System) Not applicable Copy Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Current Commands System Overview(PI) Not supported 

Server (Processor) Not applicable Current Processes System Overview(PI) Not supported 

Server (Processor) Not applicable Current Threads System Overview(PI) Not supported 

Server (File System) Not applicable Data Flush Pages/sec System Overview(PI) Not supported 

Server (File System) Not applicable Data Flushes/sec System Overview(PI) Not supported 

Server (File System) Not applicable Data Map Hits % System Overview(PI) Not supported 

Server (File System) Not applicable Data Map Pins/sec System Overview(PI) Not supported 

Server (File System) Not applicable Data Maps/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Demand Zero 
Faults/sec 

System Overview(PI) Not supported 

Server (System) Not applicable Errors Access 
Permissions 

System Overview(PI) Not supported 

Server (System) Not applicable Errors Granted Access System Overview(PI) Not supported 

Server (System) Not applicable Errors Logon System Overview(PI) Not supported 

Server (System) Not applicable Errors System System Overview(PI) Not supported 

Server (System) Not applicable Events System Overview(PI) Not supported 

Server (System) Not applicable Exception 
Dispatches/sec 

System Overview(PI) Not supported 

Server (File System) Not applicable Fast Read Not 
Possibles/sec 

System Overview(PI) Not supported 

Server (File System) Not applicable Fast Read Resource 
Misses/sec 

System Overview(PI) Not supported 

Server (File System) Not applicable Fast Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable File Control Bytes/sec System Overview(PI) Not supported 

Server (File System) Not applicable File Control Ops/sec System Overview(PI) Not supported 

Server (File System) Not applicable File Data Ops/sec System Overview(PI) Not supported 

Server (File System) Not applicable File Directory Searches System Overview(PI) Not supported 

Server (File System) Not applicable File Read Bytes/sec System Overview(PI) Not supported 

Server (File System) Not applicable File Read Ops/sec System Overview(PI) Not supported 

Server (File System) Not applicable File Write Bytes/sec System Overview(PI) Not supported 

Server (File System) Not applicable File Write Ops/sec System Overview(PI) Not supported 

Server (File System) Not applicable Files Open System Overview(PI) Not supported 

Server (File System) Not applicable Files Opened Total System Overview(PI) Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (System) Not applicable Floating 
Emulations/sec 

System Overview(PI) Not supported 

Server (Memory) Not applicable Free System Page 
Table Entries 

System Overview(PI) Not supported 

Server (Memory) Not applicable Lazy Write Flushes/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Lazy Write Pages/sec System Overview(PI) Not supported 

Server (System) Not applicable Logon/sec System Overview(PI) Not supported 

Server (System) Not applicable Logon Total System Overview(PI) Not supported 

Server (File System) Not applicable MDL Read Hits % System Overview(PI) Not supported 

Server (File System) Not applicable MDL Reads/sec System Overview(PI) Not supported 

Server (System) Not applicable Mutexes System Overview(PI) Not supported 

Server (Network) Not applicable Net Errors/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Non Committed 
Mbytes 

System Overview(PI) Not supported 

Server (System) Not applicable Active CPUs System Overview(PI) Not supported 

Server (Network) Not applicable Pkts/sec System Overview(PI) Not supported 

Server (Network) Not applicable Pkts Rcvd/sec System Overview(PI) Not supported 

Server (Network) Not applicable Pkts Xmitd/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Page Faults/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Page Reads/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Page Writes/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Pages Input/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Pages Output/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Pages/sec System Overview(PI) Not supported 

Server (Memory) Not applicable % Committed Bytes in 
Use 

System Overview(PI) Not supported 

Server (Memory) Not applicable % Physical Mem System Overview(PI) Not supported 

Server (System) Not applicable % Registry Quota in 
Use 

System Overview(PI) Not supported 

Server (Processor) Not applicable % Total DPC Time System Overview(PI) Not supported 

Server (Processor) Not applicable % Total Interrupt Time System Overview(PI) Not supported 

Server (Processor) Not applicable Privileged CPU % System Overview(PI) Not supported 

Server (Processor) CPU Usage CPU % System Overview(PI) Not supported 

Server (Processor) Not applicable User CPU % System Overview(PI) Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (File System) Not applicable Pin Read Hits % System Overview(PI) Not supported 

Server (File System) Not applicable Pin Reads/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Nonpaged Allocs System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Nonpaged Bytes System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Nonpaged 
Failures 

System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Nonpaged Peak System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Paged Allocs System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Paged Bytes System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Paged Failures System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Paged Peak System Overview(PI) Not supported 

Server (Memory) Not applicable Pool Paged Resident 
Bytes 

System Overview(PI) Not supported 

Server (System) Not applicable Processes System Overview(PI) Not supported 

Server (System) Not applicable Processor Queue 
Length 

System Overview(PI) Not supported 

Server (File System) Not applicable Read Aheads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Read Bytes Cache/sec System Overview(PI) Not supported 

Server (Network) Not applicable Read Bytes Net/sec System Overview(PI) Not supported 

Server (File System) Not applicable Read Bytes 
Nonpaging/sec 

System Overview(PI) Not supported 

Server (File System) Not applicable Read Bytes Paging/sec System Overview(PI) Not supported 

Server (File System) Not applicable Read Ops Random/sec System Overview(PI) Not supported 

Server (File System) Not applicable Read Pkts/sec System Overview(PI) Not supported 

Server (File System) Not applicable Read Pkts Small/sec System Overview(PI) Not supported 

Server (File System) Not applicable Reads Denied/sec System Overview(PI) Not supported 

Server (File System) Not applicable Reads Large/sec System Overview(PI) Not supported 

Server (File System) Not applicable Redir Bytes Rcvd/sec System Overview(PI) Not supported 

Server (File System) Not applicable Redir Bytes Total/sec System Overview(PI) Not supported 

Server (File System) Not applicable Redir Bytes Xmitd/sec System Overview(PI) Not supported 

Server (File System) Not applicable Redir File Data 
Ops/sec 

System Overview(PI) Not supported 

Server (File System) Not applicable Redir File Read 
Ops/sec 

System Overview(PI) Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (File System) Not applicable Redir File Write 
Ops/sec 

System Overview(PI) Not supported 

Server (System) Not applicable Redir Server Sessions System Overview(PI) Not supported 

Server (Memory) Not applicable Sections System Overview(PI) Not supported 

Server (System) Not applicable Semaphores System Overview(PI) Not supported 

Server (System) Not applicable Server Disconnects System Overview(PI) Not supported 

Server (Memory) Not applicable Server Pool Nonpaged 
Bytes 

System Overview(PI) Not supported 

Server (Memory) Not applicable Server Pool Paged 
Bytes 

System Overview(PI) Not supported 

Server (System) Not applicable Server Reconnects System Overview(PI) Not supported 

Server (System) Not applicable Server Sessions System Overview(PI) Not supported 

Server (System) Not applicable Server Sessions Hung System Overview(PI) Not supported 

Server (System) Not applicable Sessions Errored Out System Overview(PI) Not supported 

Server (System) Not applicable Sessions Forced Off System Overview(PI) Not supported 

Server (System) Not applicable Sessions Logged Off System Overview(PI) Not supported 

Server (System) Not applicable Sessions Timed Out System Overview(PI) Not supported 

Server (File System) Not applicable Sync Copy Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Sync Data Maps/sec System Overview(PI) Not supported 

Server (File System) Not applicable Sync Fast Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Sync MDL Reads/sec System Overview(PI) Not supported 

Server (File System) Not applicable Sync Pin Reads/sec System Overview(PI) Not supported 

Server (Memory) Not applicable System Cache 
Resident Bytes 

System Overview(PI) Not supported 

Server (System) Not applicable System Calls/sec System Overview(PI) Not supported 

Server (Memory) Not applicable System Code Resident 
Bytes 

System Overview(PI) Not supported 

Server (Memory) Not applicable System Code Total 
Bytes 

System Overview(PI) Not supported 

Server (Memory) Not applicable System Driver 
Resident Bytes 

System Overview(PI) Not supported 

Server (Memory) Not applicable System Driver Total 
Bytes 

System Overview(PI) Not supported 

Server (System) Not applicable System Type System Overview(PI) Not supported 

Server (System) Not applicable System Up Time System Overview(PI) Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (System) Not applicable Threads System Overview(PI) Not supported 

Server (System) Not applicable Total APC 
Bypasses/sec 

System Overview(PI) Not supported 

Server (System) Not applicable Total DPC 
Bypasses/sec 

System Overview(PI) Not supported 

Server (System) Not applicable Total DPC Rate System Overview(PI) Not supported 

Server (System) Not applicable Total DPCs 
Queued/sec 

System Overview(PI) Not supported 

Server (System) Not applicable Total Interrupts/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Total Physical Mem 
Mbytes 

System Overview(PI) Not supported 

Server (Memory) Not applicable Trans Pages 
RePurposed/sec 

System Overview(PI) Not supported 

Server (Memory) Not applicable Transition Faults/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Used Physical Mem 
Mbytes 

System Overview(PI) Not supported 

Server (System) Not applicable Work Item Shortages System Overview(PI) Not supported 

Server (File System) Not applicable Write Bytes Cache/sec System Overview(PI) Not supported 

Server (Network) Not applicable Write Bytes Net/sec System Overview(PI) Not supported 

Server (File System) Not applicable Write Bytes 
Nonpaging/sec 

System Overview(PI) Not supported 

Server (File System) Not applicable Write Bytes Paging/sec System Overview(PI) Not supported 

Server (Memory) Not applicable Write Copies/sec System Overview(PI) Not supported 

Server (File System) Not applicable Write Ops Random/sec System Overview(PI) Not supported 

Server (Network) Not applicable Write Pkts/sec System Overview(PI) Not supported 

Server (File System) Not applicable Write Pkts Small/sec System Overview(PI) Not supported 

Server (File System) Not applicable Writes Denied/sec System Overview(PI) Not supported 

Server (File System) Not applicable Writes Large/sec System Overview(PI) Not supported 

Logical Disk Not applicable Avg Disk Bytes/Read Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Bytes/Xfer Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Bytes/Write Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Queue 
Length 

Logical Disk 
Overview(PI_LOGD) 

Not supported 



  HiCommand Tuning Manager User's Guide 241 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Logical Disk Not applicable Avg Disk Read Queue 
Length 

Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Secs/Read Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Secs/Xfer Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Secs/Write Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Avg Disk Write Queue 
Length 

Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Current Disk Queue 
Length 

Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Disk Bytes/sec Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Disk Read Bytes/sec Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Disk Reads/sec Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Disk Xfers/sec Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Disk Write Bytes/sec Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Disk Writes/sec Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Drive Type Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Used Available Space 
Mbytes 

Logical Disk 
Overview(PI_LOGD) 

Supported 

Logical Disk Not applicable Free Mbytes Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable ID Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Page File Size Mbytes Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable % Disk Read Time Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable % Disk Time Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable % Disk Usage Logical Disk 
Overview(PI_LOGD) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Logical Disk Not applicable % Disk Write Time Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable % Free Space Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable % Idle Time Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Not applicable Split IO/Sec Logical Disk 
Overview(PI_LOGD) 

Not supported 

Logical Disk Capacity Total Size Mbytes Logical Disk 
Overview(PI_LOGD) 

Supported 

Processor Not applicable % C1 Time Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable % C2 Time Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable % C3 Time Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable % DPC Time Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable % Idle Time Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable % Interrupt Time Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable APC Bypasses/sec Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable C1 Trans/sec Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable C2 Trans/sec Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable C3 Trans/sec Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable CPU % Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable DPC Bypasses/sec Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable DPC Rate Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable DPCs Queued/sec Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable Instance Processor 
Overview(PI_PCSR) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Processor Not applicable Interrupts/sec Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable Privileged CPU % Processor 
Overview(PI_PCSR) 

Not supported 

Processor Not applicable User CPU % Processor 
Overview(PI_PCSR) 

Not supported 

Device File IO Response Time Avg Disk Secs/Xfer Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Bytes/Read Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Bytes/Xfer Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Bytes/Write Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Queue 
Length 

Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Read Queue 
Length 

Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Secs/Read Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Secs/Write Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Avg Disk Write Queue 
Length 

Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Current Disk Queue 
Length 

Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Transfer Disk Bytes/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Read Transfer Disk Read Bytes/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Read IOPS Disk Reads/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File IOPS Disk Xfers/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Write Transfer Disk Write Bytes/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Write IOPS Disk Writes/sec Physical Disk 
Overview(PI_PHYD) 

Supported 

Device File Not applicable ID Physical Disk 
Overview(PI_PHYD) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Device File Not applicable % Disk Read Time Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable % Disk Time Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable % Disk Write Time Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable % Idle Time Physical Disk 
Overview(PI_PHYD) 

Not supported 

Device File Not applicable Split IO/Sec Physical Disk 
Overview(PI_PHYD) 

Not supported 

System Not applicable Active Threads Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Available Threads Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Available Work Items Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Borrowed Work Items Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Bytes Rcvd/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Bytes Sent/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Bytes Xferd/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Context Blocks 
Queued/sec 

Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Current Clients Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Instance Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Queue Length Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Read Bytes/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Read Ops/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Total Bytes/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Total Ops/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

System Not applicable Work Item Shortages Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Write Bytes/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 

System Not applicable Write Ops/sec Server Work Queues 
Overview(PI_SVRQ) 

Not supported 
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Table A.5 Metrics for Agent for Platform (UNIX) 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (Memory) Memory Alloc Mem Mbytes System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Alloc Mem % System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Alloc Swap Mbytes System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Alloc Swap % System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Block Ops System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Block Reads System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Block Reads/sec System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Block Writes System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Block Writes/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Cache Read % System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Cache Write % System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Context Switches System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Context Switches/sec System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable System Up Time System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Processes System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Boot Time System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Users System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable 15-Minute Run Queue 
Avg 

System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable 5-Minute Run Queue 
Avg 

System Summary 
Overview(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
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 Main Console Performance 
Reporter 

  

Server (Memory) Not applicable Free Mem Mbytes System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Free Mem % System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Free Swap Mbytes System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Free Swap % System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable ICMP Pkts In System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable ICMP Pkts Out System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable Idle % System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Interrupts System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Interrupts/sec System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable IP Pkts In System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable IP Pkts Out System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable Kernel CPU % System Summary 
Overview(PI) 

Not supported 

Server (Processor) CPU Usage CPU % System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Logical I/O Ops System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Logical Read Mbytes System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Logical Reads/sec System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Logical Reads System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Logical Write Mbytes System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Logical Writes/sec System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Logical Writes System Summary 
Overview(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (Memory) Not applicable Major Faults System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Major Faults/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Mem I/O Ops System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Minor Faults System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Minor Faults/sec System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Lookup 
Ops 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Read Ops System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Read 
Ops/sec 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Total Bad 
Ops 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Total Ops System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Ops/sec System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Write Ops System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Client Write 
Ops/sec 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Server Lookup 
Ops 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Server Read Ops System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Server Read 
Ops/sec 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Server Total Bad 
Ops 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Server Total Ops System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Server Ops/sec System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable NFS Server Write Ops System Summary 
Overview(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
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 Main Console Performance 
Reporter 

  

Server (Network) Not applicable NFS Server Write 
Ops/sec 

System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Active CPUs System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable 1-Minute Run Queue 
Avg 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable Other Pkts In System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable Other Pkts Out System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Pages In System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Pages In/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Page-In Ops System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Page-In Ops/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Page Ops/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Pages Out System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Pages Out/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Page-Out Ops System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Page-Out Ops/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Page Reclaims/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Page Scans/sec System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Physical I/O Ops System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Physical Reads System Summary 
Overview(PI) 

Not supported 

Server (I/O) Not applicable Physical Writes System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Processes Ended System Summary 
Overview(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (System) Not applicable Run Queue System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Processes Started System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Software Lock Faults System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Software Lock 
Faults/sec 

System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swapped-In Pages System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swapped-In Pages/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swap-In Ops System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swap-Ins/sec System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swapped-Out Pages System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swapped-Out 
Pages/sec 

System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swap-Out Ops System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Swap-Outs/sec System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable System Calls System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable System Calls/sec System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable TCP Pkts In System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable TCP Pkts Out System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Faults System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Total Faults/sec System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable Total Idle Time System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable Total Kernel-Mode 
Time 

System Summary 
Overview(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Server (Memory) Not applicable Total Physical Mem 
Mbytes 

System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable Total Pkts System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable Total Pkts In System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable Total Pkts Out System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Total Page Ops System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Total Page Reclaims System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Total Page Scans System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Total Swap Mbytes System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Total Swaps System Summary 
Overview(PI) 

Not supported 

Server (Memory) Not applicable Total Swaps/sec System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable Total User-Mode Time System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable Total Wait Time System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Traps System Summary 
Overview(PI) 

Not supported 

Server (System) Not applicable Traps/sec System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable UDP Pkts In System Summary 
Overview(PI) 

Not supported 

Server (Network) Not applicable UDP Pkts Out System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable User CPU % System Summary 
Overview(PI) 

Not supported 

Server (Processor) Not applicable Wait % System Summary 
Overview(PI) 

Not supported 

Processor Not applicable Boot Time CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Context Switches CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Processor Not applicable Context Switches/sec CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable CPU % CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Idle % CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Idle Time CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Interrupts CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Interrupts/sec CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Processor ID CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Status CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Sys Calls/sec CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable System % CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable System Calls CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable System Time CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Traps CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Traps/sec CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Type CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Up Time CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable User % CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable User Time CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Wait % CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 

Processor Not applicable Wait Time CPU - Per Processor 
Detail(PI_CPUP) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Device File IO Response Time Avg Service Time Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Avg Wait Time Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Busy % Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Device Name Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Device Type Device 
Detail(PI_DEVD) 

Not supported 

Device File Transfer Mbytes Xferd/sec Device 
Detail(PI_DEVD) 

Supported 

Device File Not applicable Queue Length Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Read Ops Device 
Detail(PI_DEVD) 

Not supported 

Device File Read IOPS Reads/sec Device 
Detail(PI_DEVD) 

Supported 

Device File Not applicable Read % Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Seek Ops Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Total Busy Time Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable I/O Mbytes Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Total I/O Ops Device 
Detail(PI_DEVD) 

Not supported 

Device File IOPS Total I/O Ops/sec Device 
Detail(PI_DEVD) 

Supported 

Device File Read Transfer Read Mbytes Device 
Detail(PI_DEVD) 

Supported 

Device File Not applicable Total Service Time Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Total Wait Time Device 
Detail(PI_DEVD) 

Not supported 

Device File Write Transfer Write Mbytes Device 
Detail(PI_DEVD) 

Supported 

Device File Not applicable Wait Length Time Device 
Detail(PI_DEVD) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Device File Not applicable Write Ops Device 
Detail(PI_DEVD) 

Not supported 

Device File Write IOPS Writes/sec Device 
Detail(PI_DEVD) 

Supported 

Device File Not applicable Write % Device 
Detail(PI_DEVD) 

Not supported 

Device File Not applicable Avg Service Time/op Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Busy % Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Devices Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Mbytes Xferd/sec Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Queue Length Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Reads/sec Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Read Ops % Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Seek Ops Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Avg Service 
Time/device 

Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Total Busy Time Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable I/O Mbytes Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Total I/O Ops Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Total I/O Ops/sec Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Reads Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Total Service Time Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Total Wait Length Time Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Total Wait Time Device 
Summary(PI_DEVS) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Device File Not applicable Writes Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Wait Length Time Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Wait Time Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Writes/sec Device 
Summary(PI_DEVS) 

Not supported 

Device File Not applicable Write Ops % Device 
Summary(PI_DEVS) 

Not supported 

Workgroup Not applicable Avg I/O Kbytes Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable CPU % Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Context Switches Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Groups Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Major Faults Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Process Count Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Programs Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Reads Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Reads/sec Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Real Mem Kbytes Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Swaps Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable System CPU Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Throughput/sec Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Total I/O Kbytes Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Total I/O Ops Workgroup 
Summary(PI_WGRP) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Workgroup Not applicable Total I/O Ops/sec Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable User CPU Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Users Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Virtual Mem Kbytes Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Workgroup Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Writes Workgroup 
Summary(PI_WGRP) 

Not supported 

Workgroup Not applicable Writes/sec Workgroup 
Summary(PI_WGRP) 

Not supported 

Table A.6 Metrics for Agent for Microsoft Exchange Server 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Database Cache % Hit Database(PI_DB) Not supported 

Not applicable Not applicable Database Cache Size Database(PI_DB) Not supported 

Not applicable Not applicable Database Page Fault 
Stalls/sec 

Database(PI_DB) Not supported 

Not applicable Not applicable Interval Database(PI_DB) Not supported 

Not applicable Not applicable Log Record Stalls/sec Database(PI_DB) Not supported 

Not applicable Not applicable Log Threads Waiting Database(PI_DB) Not supported 

Not applicable Not applicable Record Time Database(PI_DB) Not supported 

Not applicable Not applicable Record Type Database(PI_DB) Not supported 

Not applicable Not applicable Table Open Cache % 
Hit 

Database(PI_DB) Not supported 

Not applicable Not applicable Client Out Queue 
Length 

Epoxy(PI_EPOX) Not supported 

Not applicable Not applicable Interval Epoxy(PI_EPOX) Not supported 

Not applicable Not applicable Protocol Name Epoxy(PI_EPOX) Not supported 

Not applicable Not applicable Record Time Epoxy(PI_EPOX) Not supported 

Not applicable Not applicable Record Type Epoxy(PI_EPOX) Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Store Out Queue 
Length 

Epoxy(PI_EPOX) Not supported 

Not applicable Not applicable Active User Count MSExchangeIS(PI) Not supported 

Not applicable Not applicable Connection Count MSExchangeIS(PI) Not supported 

Not applicable Not applicable Exchmem Additional 
Heaps 

MSExchangeIS(PI) Not supported 

Not applicable Not applicable Exchmem Heaps with 
Memory Errors 

MSExchangeIS(PI) Not supported 

Not applicable Not applicable Exchmem Memory 
Errors 

MSExchangeIS(PI) Not supported 

Not applicable Not applicable Interval MSExchangeIS(PI) Not supported 

Not applicable Not applicable Record Time MSExchangeIS(PI) Not supported 

Not applicable Not applicable Record Type MSExchangeIS(PI) Not supported 

Not applicable Not applicable RPC Averaged 
Latency 

MSExchangeIS(PI) Not supported 

Not applicable Not applicable RPC Operations/sec MSExchangeIS(PI) Not supported 

Not applicable Not applicable RPC Requests MSExchangeIS(PI) Not supported 

Not applicable Not applicable User Count MSExchangeIS(PI) Not supported 

Not applicable Not applicable VM Largest Block Size MSExchangeIS(PI) Not supported 

Not applicable Not applicable VM Total 16 MB Free 
Blocks 

MSExchangeIS(PI) Not supported 

Not applicable Not applicable VM Total Free Blocks MSExchangeIS(PI) Not supported 

Not applicable Not applicable VM Total Large Free 
Block Bytes 

MSExchangeIS(PI) Not supported 

Not applicable Not applicable Average Delivery Time MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Folder Opens/sec MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Interval MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Message Opens/sec MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Messages Submitted MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Messages 
Submitted/min 

MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Message Recipients 
Delivered/min 

MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Record Time MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Record Type MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Send Queue Size MSExchangeIS 
Mailbox(PI_ISM) 

Not supported 

Not applicable Not applicable Average Delivery Time MSExchangeIS 
Public(PI_ISP) 

Not supported 

Not applicable Not applicable Folder Opens/sec MSExchangeIS 
Public(PI_ISP) 

Not supported 

Not applicable Not applicable Interval MSExchangeIS 
Public(PI_ISP) 

Not supported 

Not applicable Not applicable Message Opens/sec MSExchangeIS 
Public(PI_ISP) 

Not supported 

Not applicable Not applicable Message Recipients 
Delivered/min 

MSExchangeIS 
Public(PI_ISP) 

Not supported 

Not applicable Not applicable Record Time MSExchangeIS 
Public(PI_ISP) 

Not supported 

Not applicable Not applicable Record Type MSExchangeIS 
Public(PI_ISP) 

Not supported 

Not applicable Not applicable Send Queue Size MSExchangeIS 
Public(PI_ISP) 

Not supported 

Table A.7 Metrics for Agent for Oracle 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Database Not applicable Archive Change # Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable Blocks Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable Checkpoint Change # Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable Created Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable Datafiles Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable Extents Database 
Interval(PI_PIDB) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Database Not applicable Free Change Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable Free Extents Database 
Interval(PI_PIDB) 

Not supported 

Database Name DB Name Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable DB Files % Database 
Interval(PI_PIDB) 

Not supported 

Database Not applicable Free % Database 
Interval(PI_PIDB) 

Not supported 

Data File Not applicable Blocks Data File 
Interval(PI_PIDF) 

Not supported 

Data File Size Mbytes Data File 
Interval(PI_PIDF) 

Supported 

Data File Not applicable Checkpoint Change # Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Enabled Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable File # Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Free Mbytes Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Free Change Data File 
Interval(PI_PIDF) 

Not supported 

Data File IOPS I/O Ops/sec Data File 
Interval(PI_PIDF) 

Supported 

Data File Name File Name Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Free % Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Physical Blocks Read Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Physical Blocks Written Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Physical Reads Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Physical Writes Data File 
Interval(PI_PIDF) 

Not supported 

Data File Read IOPS Reads/sec Data File 
Interval(PI_PIDF) 

Supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Data File Not applicable Read Time Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Start Time Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Status Data File 
Interval(PI_PIDF) 

Not supported 

Data File Table Space Tablespace Name Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Used Mbytes Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Used Change Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Write % Data File 
Interval(PI_PIDF) 

Not supported 

Data File Not applicable Write Time Data File 
Interval(PI_PIDF) 

Not supported 

Data File Write IOPS Writes/sec Data File 
Interval(PI_PIDF) 

Supported 

Tablespace Not applicable Datafiles Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace IOPS I/O Ops/sec Tablespace 
Interval(PI_PITS) 

Supported 

Tablespace Not applicable Physical Blocks Read Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Not applicable Physical Blocks Written Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Not applicable Physical Reads Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Not applicable Physical Writes Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Read IOPS Reads/sec Tablespace 
Interval(PI_PITS) 

Supported 

Tablespace Rollback segments Rollback Segments Tablespace 
Interval(PI_PITS) 

Supported 

Tablespace Not applicable Rollback Segments Hit 
% 

Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Not applicable Rollback Segments 
Trans 

Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Sort segments Sort Segments Tablespace 
Interval(PI_PITS) 

Supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Tablespace Not applicable Sorting Users Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Not applicable Start Time Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Not applicable Tablespace Name Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Not applicable Write % Tablespace 
Interval(PI_PITS) 

Not supported 

Tablespace Write IOPS Writes/sec Tablespace 
Interval(PI_PITS) 

Supported 

Table A.8 Metrics for Agent for Microsoft SQL Server 

Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Availability Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable DB Name Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable DB Owner Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable DBID Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Data Growth % Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Index Growth % Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Log Growth % Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Options Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Record Time Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Record Type Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Start Time Database 
Interval(PI_DI) 

Not supported 

Not applicable Not applicable Tran Log Dumps Database 
Interval(PI_DI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Cache Avg Scan Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Conns Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable CPU % Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable CPU Time Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable CPU Timeticks Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable I/O % Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable I/O Time Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable I/O Timeticks Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Idle % Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Idle Time Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Idle Timeticks Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Lazy Writes/sec Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Log Writes/sec Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Net Queue Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Net Reads/sec Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Net Writes/sec Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Pkt Errors Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Pkts Rcvd Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Pkts Sent Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Reads Pending Global Server 
Summary(PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Record Time Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Record Type Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Start Time Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Timeticks Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Total Errors Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Total Reads Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Total Writes Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Trans/sec Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable Writes Pending Global Server 
Summary(PI) 

Not supported 

Not applicable Not applicable DB Name Replication Published 
Database 
Overview(PI_RPDB) 

Not supported 

Not applicable Not applicable Record Time Replication Published 
Database 
Overview(PI_RPDB) 

Not supported 

Not applicable Not applicable Record Type Replication Published 
Database 
Overview(PI_RPDB) 

Not supported 

Not applicable Not applicable Replicated Trans Replication Published 
Database 
Overview(PI_RPDB) 

Not supported 

Not applicable Not applicable Replicated Trans/sec Replication Published 
Database 
Overview(PI_RPDB) 

Not supported 

Not applicable Not applicable Replication Latency Replication Published 
Database 
Overview(PI_RPDB) 

Not supported 

Not applicable Not applicable Start Time Replication Published 
Database 
Overview(PI_RPDB) 

Not supported 

Not applicable Not applicable Avg Cache Scan Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Cache Buffers Free Server 
Overview(PI_SERV) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Cache Hit % Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Command Queue 
Length 

Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Lazy Writes/sec Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Log Writes/sec Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Max Cache Scan Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Max Tempdb Space 
Used Mbytes 

Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Max Users Conn'd Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Net Reads/sec Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Net Writes/sec Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Page Reads/sec Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Page Writes/sec Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable RA Pages Fetched into 
Cache/sec 

Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable RA Pages Found in 
Cache/sec 

Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable RA Physical Reads/sec Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable RA Slots Used Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Reads Pending Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Record Time Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Record Type Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Start Time Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Trans/sec Server 
Overview(PI_SERV) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable User Conns Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Writes Pending Server 
Overview(PI_SERV) 

Not supported 

Not applicable Not applicable Data Mbytes Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable DB Size Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Free % Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Free Mbytes Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Index Mbytes Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Log Mbytes Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Record Time Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Record Type Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Rsvd Mbytes Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Start Time Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Unused % Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable Unused Mbytes Server Space 
Interval(PI_SI) 

Not supported 

Not applicable Not applicable DB Name Transaction Log 
Overview(PI_TLOG) 

Not supported 

Not applicable Not applicable Log Size Mbytes Transaction Log 
Overview(PI_TLOG) 

Not supported 

Not applicable Not applicable Log Space Used % Transaction Log 
Overview(PI_TLOG) 

Not supported 

Not applicable Not applicable Max Log Space 
Used % 

Transaction Log 
Overview(PI_TLOG) 

Not supported 

Not applicable Not applicable Max Log Space Used 
Mbytes 

Transaction Log 
Overview(PI_TLOG) 

Not supported 

Not applicable Not applicable Record Time Transaction Log 
Overview(PI_TLOG) 

Not supported 
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Resource Metrics Record ID Whether alerts can be 
set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Record Type Transaction Log 
Overview(PI_TLOG) 

Not supported 

Not applicable Not applicable Start Time Transaction Log 
Overview(PI_TLOG) 

Not supported 

Not applicable Not applicable Record Time User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable Record Type User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 1 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 2 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 3 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 4 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 5 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 6 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 7 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 8 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 9 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable SQL User Counter 10 User-Defined Counter 
Overview(PI_UCTR) 

Not supported 

Not applicable Not applicable Start Time User-Defined Counter 
Overview(PI_UCTR) 

Not supported 
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Table A.9 Metrics for Agent for DB2 

Resource Metrics Record ID Whether alerts can 
be set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Agents Created Empty 
Pool 

Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Agents Created Pool 
Rate 

Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Agents From Pool Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Agents Registered Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Agents Registered Top Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Agents Waiting On 
Token 

Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Agents Waiting Top Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Comm Private Mem Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Cons In Exec Total Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Cons Total Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable DB2 Status Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Interval Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Local Cons Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Local Cons In Exec Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 
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Resource Metrics Record ID Whether alerts can 
be set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Post Threshold Hash 
Joins 

Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Product Name Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Record Time Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Record Type Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Rem Cons In Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Rem Cons In Exec Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Service Level Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Sort Heap Allocated Basic Information on 
Database Manager 
Interval(PI_PI) 

Not supported 

Not applicable Not applicable Interval Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Data 
Reads 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Data 
Reads Rate 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Data 
Writes 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Data 
Writes Rate 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Index 
Reads 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Index 
Reads Rate 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 
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Resource Metrics Record ID Whether alerts can 
be set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Pool Async Index 
Writes 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Index 
Writes Rate 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Read Time Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Read Time 
Avg 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Total 
Reads 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Total 
Writes 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Write Time Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Async Write Time 
Avg 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Data From Estore Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Data Hit Rate Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Data L Reads Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Data P Reads Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Data To Estore Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Data Writes Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Drty PG Steal 
Clns 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 
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Resource Metrics Record ID Whether alerts can 
be set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Pool Drty PG Steal 
Clns Rate 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Drty PG Thrsh 
Clns 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Index From 
Estore 

Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Index Hit Rate Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Index L Reads Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Index P Reads Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Index To Estore Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Index Writes Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Lsn Gap Clns Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Read Time Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Read Time Avg Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Total Hit Rate Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Total Writes Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Write Time Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Pool Write Time Avg Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 
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Resource Metrics Record ID Whether alerts can 
be set using the GUI 

 Main Console Performance 
Reporter 

  

Not applicable Not applicable Record Time Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Record Type Bufferpool Stat on 
Database 
Interval(PI_DBPI) 

Not supported 

Not applicable Not applicable Cat Cache Inserts Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Cat Cache Lookups Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Cat Cache Needed 
Minisize 

Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Cat Cache Overflows Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Cat Cache Size Top Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Catcache Hit Rate Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Interval Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Pkg Cache Hit Rate Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Pkg Cache Inserts Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Pkg Cache Lookups Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Pkg Cache Needed 
Minisize 

Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Pkg Cache Num 
Overflows 

Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Pkg Cache Size Top Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Record Time Cache on Database 
Interval(PI_DCAI) 

Not supported 

Not applicable Not applicable Record Type Cache on Database 
Interval(PI_DCAI) 

Not supported 
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A.2 Metrics Displayed by Tuning Manager and the Versions of Agents from which Information is 

Collected 

This appendix describes the correspondence between the metrics displayed by Tuning Manager 
and the versions of the Agents from which information is collected. 

A.2.1 Storage Resources and the Versions of Agents from which Information is Collected 

Tables A.10 through A.12 contain information about storage resources and the versions of the 
Agents from which the information is collected. 

Table A.10 Storage Resources and the Versions of Agents from which Information is Collected (Thunder 
series) 

Resource Metrics Agent 
versionsNote 1 

Thunder 9200 Thunder 9500V 
series 

Storage Basic 
Information 

Name   Supported Supported 

 Configuration 
Information 

Subsystems   Supported Supported 

 Performance 
Information 

Port Transfer   Not Supported 
(Always 0) 

Supported 

  Disk Transfer   Not Supported 
(Always 0) 

Supported 

  Port IOPS   Not Supported 
(Always 0) 

Supported 

  Disk IOPS   Supported Supported 

Subsystem Basic 
Information 

Name All versions of 
Agent for RAID 

Supported Supported 

  Serial Number  All versions of 
Agent for RAID 

Supported Supported 

  Vendor All versions of 
Agent for RAID 

Supported Supported 

  Product All versions of 
Agent for RAID 

Supported Supported 

 Configuration 
Information 

Ports   Supported Supported 

  Array Groups   Supported Supported 

  Logical Disks All versions of 
Agent for RAID 

Supported Supported 

 Performance 
Information 

Port IOPS   Not Supported 
(Always 0) 

Supported 

  Port Transfer   Not Supported 
(Always 0) 

Supported 
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Resource Metrics Agent 
versionsNote 1 

Thunder 9200 Thunder 9500V 
series 

  Port Min IOPS   Not Supported 
(Always 0) 

Supported 

  Port Min Transfer   Not Supported 
(Always 0) 

Supported 

  Port  Max IOPS   Not Supported 
(Always 0) 

Supported 

  Port Max Transfer   Not Supported 
(Always 0) 

Supported 

  Installed Memory 
Capacity 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Cache Capacity All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Cache Usage All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Cache % All versions of 
Agent for RAID 

Not Supported 
(Always n/a) 

Supported 

  Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Supported 

  Max Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Supported 

  Side File Usage Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Max Side File 
Usage 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Disk IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Read IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Write IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Transfer All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Disk Read 
Transfer 

All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Disk Write Transfer All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

SLPR Basic 
Information 

Name Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  SLPR Number Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Configuration 
Information 

Array Groups   Not Applicable Not Applicable 

  Ports   Not Applicable Not Applicable 
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Resource Metrics Agent 
versionsNote 1 

Thunder 9200 Thunder 9500V 
series 

  Logical Disks   Not Applicable Not Applicable 

  Cache Capacity   Not Applicable Not Applicable 

Port Basic 
Information 

Name All versions of 
Agent for RAID 

Supported Supported 

  Port Speed Agent for RAID 
v4.0 or later 

Supported Supported 

  Port Role Agent for RAID 
v5.0 or later 

Not Supported 
(Always n/a) 

Not Supported 
(Always n/a) 

  WWN Port Agent for RAID 
v3.5 or later 

Supported Supported 

  Port number All versions of 
Agent for RAID 

Supported Supported 

 Configuration 
Information 

Port IOPS All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Port Max IOPS All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Port Min IOPS All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Port Transfer All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Port Max Transfer All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Port Min Transfer All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

LDEV Basic 
Information 

Name Agent for RAID 
v3.0 

Supported Supported 

   Agent for RAID 
v3.5 or later 

Supported Supported 

  Model Agent for RAID 
v3.5 or later 

Not Supported 
(Always n/a) 

Not Supported 
(Always n/a) 

 Configuration 
Information 

Array Group All versions of 
Agent for RAID 

Supported Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Supported Supported 

    Agent for RAID 
v3.0 

Supported Supported 

  CLPR Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  External Storage Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  External Array 
Group 

  Not Applicable Not Applicable 
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Resource Metrics Agent 
versionsNote 1 

Thunder 9200 Thunder 9500V 
series 

  External Logical 
Disk 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Performance 
Information 

Read Hit Ratio All versions of 
Agent for RAID 

Supported Supported 

  Write Hit Ratio All versions of 
Agent for RAID 

Supported Supported 

  Disk IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Read IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Write IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Random 
IOPS 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk Sequential 
IOPS 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk Transfer All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Disk Read 
Transfer 

All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Disk Write Transfer All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Disk Random 
Transfer 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk 
SequentialTransfer 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  I/O Response 
Time 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Historical 
Response Time 

 Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Delta  Not Supported 
(Always n/a) 

Not Supported 
(Always n/a) 

  Read I/O 
Response Time 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Write I/O 
Response Time 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

Internal 
LDEVNote 3 

Basic 
Information 

Name Agent for RAID 
v3.5 or later 

Supported Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Supported Supported 

 Configuration 
Information 

Main LDEV Agent for RAID 
v3.5 or later 

Supported Supported 
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Resource Metrics Agent 
versionsNote 1 

Thunder 9200 Thunder 9500V 
series 

  Array Group Agent for RAID 
v3.5 or later 

Supported Supported 

  External Storage Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  External Array 
Group 

  Not Applicable Not Applicable 

  External Logical 
Disk 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

Array Group Basic 
Information 

Name Agent for RAID 
v3.5 or later 

Supported Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Supported Supported 

 Configuration 
Information 

CLPR Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Performance 
Information 

Usage Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Max Usage Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk IOPS Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Read IOPS Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Write IOPS Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Random 
IOPS 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk Sequential 
IOPS 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk Transfer Agent for RAID 
v3.5 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk Read 
Transfer 

Agent for RAID 
v3.5 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk Write Transfer Agent for RAID 
v3.5 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk Random 
Transfer 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk 
SequentialTransfer 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Read Hit Ratio Agent for RAID 
v3.5 or later 

Supported Supported 

  Write Hit Ratio Agent for RAID 
v3.5 or later 

Supported Supported 
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Resource Metrics Agent 
versionsNote 1 

Thunder 9200 Thunder 9500V 
series 

CLPR Basic 
Information 

Name Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  CLPR Number Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Performance 
Information 

Cache Capacity Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Max Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Side File Usage Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Max Side File 
Usage 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

Table A.11 Storage Resources and the Versions of Agents from which Information is Collected (Lightning 
series) 

Resource Metrics Agent 
versionsNote 1 

Lightning 9900 
series 

Lighting 9900V 
series 

Storage Basic 
Information 

Name   Supported Supported 

 Configuration 
Information 

Subsystems   Supported Supported 

 Performance 
Information 

Port Transfer   Supported Supported 

  Disk Transfer   Supported Supported 

  Port IOPS   Supported Supported 

  Disk IOPS   Supported Supported 

Subsystem Basic 
Information 

Name All versions of 
Agent for RAID 

Supported Supported 

  Serial Number All versions of 
Agent for RAID 

Supported Supported 

  Vendor All versions of 
Agent for RAID 

Supported Supported 

  Product All versions of 
Agent for RAID 

Supported Supported 

 Configuration 
Information 

Ports   Supported Supported 

  Array Groups   Not Supported 
(Always 0)  

Supported 

  Logical Disks All versions of 
Agent for RAID 

Supported Supported 
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Resource Metrics Agent 
versionsNote 1 

Lightning 9900 
series 

Lighting 9900V 
series 

 Performance 
Information 

Port IOPS   Supported Supported 

  Port Transfer   Supported Supported 

  Port Min IOPS   Supported Supported 

  Port Min Transfer   Supported Supported 

  Port  Max IOPS   Supported Supported 

  Port Max Transfer   Supported Supported 

  Installed Memory 
Capacity 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Cache Capacity All versions of 
Agent for RAID 

Supported Supported 

  Cache Usage All versions of 
Agent for RAID 

Supported Supported 

  Cache % All versions of 
Agent for RAID 

Supported Supported 

  Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Max Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Side File Usage Agent for RAID 
v4.0 or later 

Supported Supported 

  Max Side File 
Usage 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Disk IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Read IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Write IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Transfer All versions of 
Agent for RAID 

Supported Supported 

  Disk Read 
Transfer 

All versions of 
Agent for RAID 

Supported Supported 

  Disk Write Transfer All versions of 
Agent for RAID 

Supported Supported 

SLPR Basic 
Information 

Name Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  SLPR Number Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Configuration 
Information 

Array Groups   Not Applicable Not Applicable 

  Ports   Not Applicable Not Applicable 
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Resource Metrics Agent 
versionsNote 1 

Lightning 9900 
series 

Lighting 9900V 
series 

  Logical Disks   Not Applicable Not Applicable 

  Cache Capacity   Not Applicable Not Applicable 

Port Basic 
Information 

Name All versions of 
Agent for RAID 

Supported Supported 

  Port Speed Agent for RAID 
v4.0 or later 

Not Supported 
(Always n/a) 

Supported 

  Port Role Agent for RAID 
v5.0 or later 

Supported Supported 

  WWN Port Agent for RAID 
v3.5 or later 

Supported Supported 

  Port number All versions of 
Agent for RAID 

Supported Supported 

 Configuration 
Information 

Port IOPS All versions of 
Agent for RAID 

Supported Supported 

  Port Max IOPS All versions of 
Agent for RAID 

Supported Supported 

  Port Min IOPS All versions of 
Agent for RAID 

Supported Supported 

  Port Transfer All versions of 
Agent for RAID 

Supported Supported 

  Port Max Transfer All versions of 
Agent for RAID 

Supported Supported 

  Port Min Transfer All versions of 
Agent for RAID 

Supported Supported 

LDEV Basic 
Information 

Name Agent for RAID 
v3.0 

Supported Supported 

   Agent for RAID 
v3.5 or later 

Supported Supported 

  Model Agent for RAID 
v3.5 or later 

Not Supported 
(Always n/a) 

Supported 

 Configuration 
Information 

Array Group All versions of 
Agent for RAID 

Not Supported 
(Always n/a) 

Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Not Supported 
(Always n/a) 

Supported 

    Agent for RAID 
v3.0 

Not Supported 
(Always n/a) 

Supported 

  CLPR Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  External Storage Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  External Array 
Group 

  Not Applicable Not Applicable 
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Resource Metrics Agent 
versionsNote 1 

Lightning 9900 
series 

Lighting 9900V 
series 

  External Logical 
Disk 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Performance 
Information 

Read Hit Ratio All versions of 
Agent for RAID 

Supported Supported 

  Write Hit Ratio All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Disk IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Read IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Write IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Random 
IOPS 

Agent for RAID 
v5.0 or later 

Supported Supported 

  Disk Sequential 
IOPS 

Agent for RAID 
v5.0 or later 

Supported Supported 

  Disk Transfer All versions of 
Agent for RAID 

Supported Supported 

  Disk Read 
Transfer 

All versions of 
Agent for RAID 

Supported Supported 

  Disk Write Transfer All versions of 
Agent for RAID 

Supported Supported 

  Disk Random 
Transfer 

Agent for RAID 
v5.0 or later 

Supported Supported 

  Disk 
SequentialTransfer 

Agent for RAID 
v5.0 or later 

Supported Supported 

  I/O Response 
Time 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Supported 

  Historical 
Response Time 

 Not Supported 
(Always 0) 

Supported 

  Delta  Not Supported 
(Always n/a) 

Supported 

  Read I/O 
Response Time 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Supported 

  Write I/O 
Response Time 

Agent for RAID 
v4.0 or later 

Not Supported 
(Always 0) 

Supported 

Internal 
LDEVNote 3 

Basic 
Information 

Name Agent for RAID 
v3.5 or later 

Supported Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Not Supported 
(Always n/a) 

Supported 

 Configuration 
Information 

Main LDEV Agent for RAID 
v3.5 or later 

Supported Supported 
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Resource Metrics Agent 
versionsNote 1 

Lightning 9900 
series 

Lighting 9900V 
series 

  Array Group Agent for RAID 
v3.5 or later 

Not Supported 
(Always n/a) 

Supported 

  External Storage Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  External Array 
Group 

  Not Applicable Not Applicable 

  External Logical 
Disk 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

Array Group Basic 
Information 

Name Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

 Configuration 
Information 

CLPR Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Performance 
Information 

Usage Agent for RAID 
v4.0 or later 

Not Supported 
Note 4 

Supported 

  Max Usage Agent for RAID 
v4.0 or later 

Not Supported 
Note 4 

Supported 

  Disk IOPS Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  Disk Read IOPS Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  Disk Write IOPS Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  Disk Random 
IOPS 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Supported 

  Disk Sequential 
IOPS 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Supported 

  Disk Transfer Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  Disk Read 
Transfer 

Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  Disk Write Transfer Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  Disk Random 
Transfer 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Supported 

  Disk 
SequentialTransfer 

Agent for RAID 
v5.0 or later 

Not Supported 
(Always 0) 

Supported 

  Read Hit Ratio Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Supported 

  Write Hit Ratio Agent for RAID 
v3.5 or later 

Not Supported 
Note 4 

Not Supported 
(Always 0) 



282  Appendix A Tuning Manager Metrics and Restrictions 

Resource Metrics Agent 
versionsNote 1 

Lightning 9900 
series 

Lighting 9900V 
series 

CLPR Basic 
Information 

Name Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  CLPR Number Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

 Performance 
Information 

Cache Capacity Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Max Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Side File Usage Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

  Max Side File 
Usage 

Agent for RAID 
v4.0 or later 

Not Applicable Not Applicable 

Table A.12 Storage Resources and the Versions of Agents from which Information is Collected 
(TagmaStore) 

Resource Metrics Agent 
versionsNote 1 

TagmaStore 
USP 

TagmaStore 
AMS 

Storage Basic 
Information 

Name   Supported Supported 

 Configuration 
Information 

Subsystems   Supported Supported 

 Performance 
Information 

Port Transfer   Supported Supported 

  Disk Transfer   Supported Supported 

  Port IOPS   Supported Supported 

  Disk IOPS   Supported Supported 

Subsystem Basic 
Information 

Name All versions of 
Agent for RAID 

Supported Supported 

  Serial Number All versions of 
Agent for RAID 

Supported Supported 

  Vendor All versions of 
Agent for RAID 

Supported Supported 

  Product All versions of 
Agent for RAID 

Supported Supported 

 Configuration 
Information 

Ports   Supported Supported 

  Array Groups   Supported Supported 

  Logical Disks All versions of 
Agent for RAID 

Supported Supported 
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Resource Metrics Agent 
versionsNote 1 

TagmaStore 
USP 

TagmaStore 
AMS 

 Performance 
Information 

Port IOPS   Supported Supported 

  Port Transfer   Supported Supported 

  Port Min IOPS   Supported Supported 

  Port Min Transfer   Supported Supported 

  Port  Max IOPS   Supported Supported 

  Port Max Transfer   Supported Supported 

  Installed Memory 
Capacity 

Agent for RAID 
v4.0 or later 

Not Applicable Supported 

  Cache Capacity All versions of 
Agent for RAID 

Supported Supported 

  Cache Usage All versions of 
Agent for RAID 

Supported Note 2 Supported 

  Cache % All versions of 
Agent for RAID 

Supported Note 2 Supported 

  Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Max Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Side File Usage Agent for RAID 
v4.0 or later 

Supported Supported 

  Max Side File 
Usage 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Disk IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Read IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Write IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Transfer All versions of 
Agent for RAID 

Supported Supported 

  Disk Read 
Transfer 

All versions of 
Agent for RAID 

Supported Supported 

  Disk Write Transfer All versions of 
Agent for RAID 

Supported Supported 

SLPR Basic 
Information 

Name Agent for RAID 
v4.0 or later 

Supported Not Applicable 

  SLPR Number Agent for RAID 
v4.0 or later 

Supported Not Applicable 

 Configuration 
Information 

Array Groups   Supported Not Applicable 

  Ports   Supported Not Applicable 
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Resource Metrics Agent 
versionsNote 1 

TagmaStore 
USP 

TagmaStore 
AMS 

  Logical Disks   Supported Not Applicable 

  Cache Capacity   Supported Not Applicable 

Port Basic 
Information 

Name All versions of 
Agent for RAID 

Supported Supported 

  Port Speed Agent for RAID 
v4.0 or later 

Supported Supported 

  Port Role Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always n/a) 

  WWN Port Agent for RAID 
v3.5 or later 

Supported Supported 

  Port number All versions of 
Agent for RAID 

Supported Supported 

 Configuration 
Information 

Port IOPS All versions of 
Agent for RAID 

Supported Supported 

  Port Max IOPS All versions of 
Agent for RAID 

Supported Supported 

  Port Min IOPS All versions of 
Agent for RAID 

Supported Supported 

  Port Transfer All versions of 
Agent for RAID 

Supported Supported 

  Port Max Transfer All versions of 
Agent for RAID 

Supported Supported 

  Port Min Transfer All versions of 
Agent for RAID 

Supported Supported 

LDEV Basic 
Information 

Name Agent for RAID 
v3.0 

Not Applicable Not Applicable 

   Agent for RAID 
v3.5 or later 

Supported Supported 

  Model Agent for RAID 
v3.5 or later 

Supported Not Supported 
(Always n/a) 

 Configuration 
Information 

Array Group All versions of 
Agent for RAID 

Supported Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Supported Not Applicable 

    Agent for RAID 
v3.0 

Not Applicable Supported 

  CLPR Agent for RAID 
v4.0 or later 

Not Supported Supported 

  External Storage Agent for RAID 
v4.0 or later 

Supported Not Applicable 

  External Array 
Group 

  Supported Not Applicable 
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Resource Metrics Agent 
versionsNote 1 

TagmaStore 
USP 

TagmaStore 
AMS 

  External Logical 
Disk 

Agent for RAID 
v4.0 or later 

Supported Not Applicable 

 Performance 
Information 

Read Hit Ratio All versions of 
Agent for RAID 

Supported Supported 

  Write Hit Ratio All versions of 
Agent for RAID 

Not Supported 
(Always 0) 

Supported 

  Disk IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Read IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Write IOPS All versions of 
Agent for RAID 

Supported Supported 

  Disk Random 
IOPS 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  Disk Sequential 
IOPS 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  Disk Transfer All versions of 
Agent for RAID 

Supported Supported 

  Disk Read 
Transfer 

All versions of 
Agent for RAID 

Supported Supported 

  Disk Write Transfer All versions of 
Agent for RAID 

Supported Supported 

  Disk Random 
Transfer 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  Disk 
SequentialTransfer 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  I/O Response 
Time 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Historical 
Response Time 

 Supported Supported 

  Delta  Supported Supported 

  Read I/O 
Response Time 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Write I/O 
Response Time 

Agent for RAID 
v4.0 or later 

Supported Supported 

Internal 
LDEVNote 3 

Basic 
Information 

Name Agent for RAID 
v3.5 or later 

Supported Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Supported Supported 

 Configuration 
Information 

Main LDEV Agent for RAID 
v3.5 or later 

Supported Supported 

  Array Group Agent for RAID 
v3.5 or later 

Supported Supported 
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Resource Metrics Agent 
versionsNote 1 

TagmaStore 
USP 

TagmaStore 
AMS 

  External Storage Agent for RAID 
v4.0 or later 

Supported Not Applicable 

  External Array 
Group 

  Supported Not Applicable 

  External Logical 
Disk 

Agent for RAID 
v4.0 or later 

Supported Not Applicable 

Array Group Basic 
Information 

Name Agent for RAID 
v3.5 or later 

Supported Supported 

  RAID LEVEL Agent for RAID 
v3.5 or later 

Supported Supported 

 Configuration 
Information 

CLPR Agent for RAID 
v4.0 or later 

Supported Not Applicable 

 Performance 
Information 

Usage Agent for RAID 
v4.0 or later 

Supported Not Supported 
(Always 0) 

  Max Usage Agent for RAID 
v4.0 or later 

Supported Not Supported 
(Always 0) 

  Disk IOPS Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Read IOPS Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Write IOPS Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Random 
IOPS 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  Disk Sequential 
IOPS 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  Disk Transfer Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Read 
Transfer 

Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Write Transfer Agent for RAID 
v3.5 or later 

Supported Supported 

  Disk Random 
Transfer 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  Disk 
SequentialTransfer 

Agent for RAID 
v5.0 or later 

Supported Not Supported 
(Always 0) 

  Read Hit Ratio Agent for RAID 
v3.5 or later 

Supported Supported 

  Write Hit Ratio Agent for RAID 
v3.5 or later 

Not Supported 
(Always 0) 

Supported 

CLPR Basic 
Information 

Name Agent for RAID 
v4.0 or later 

Supported Supported 
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Resource Metrics Agent 
versionsNote 1 

TagmaStore 
USP 

TagmaStore 
AMS 

  CLPR Number Agent for RAID 
v4.0 or later 

Supported Supported 

 Performance 
Information 

Cache Capacity Agent for RAID 
v4.0 or later 

Supported Supported 

  Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Max Write Pending 
Rate 

Agent for RAID 
v4.0 or later 

Supported Supported 

  Side File Usage Agent for RAID 
v4.0 or later 

Supported Supported 

  Max Side File 
Usage 

Agent for RAID 
v4.0 or later 

Supported Supported 

Notes: 

1: In blank columns, Tuning Manager displays calculation results or the result of setting fixed 
values. 

2:If CLPRs have been created, Tuning Manager displays zero values for Cache Usage and Cache 
% because Agent for RAID cannot collect the cache usage metrics for each CLPR. 

3:Here Internal LDEV means each logical device contained in an LUSE volume. An LUSE 
configuration is displayed only when Agent for RAID v5.0 or later is used to monitor the 
storage. 

4:When the Lightning 9900 Series is monitored, Tuning Manager does not display metrics for 
Array Group in Resource Tree. 
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A.2.2 Server Resources and the Versions of Agents from which Information is Collected 

Tables A.13 through A.15 contain information about server resources and the versions of the 
Agents from which the information is collected. 

Table A.13 Server Resources and the Versions of Agents from which Information is Collected (Windows) 

Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

Wholenet Basic 
Information 

Name   Supported Supported 

 Configuration 
Information 

Servers   Supported Supported 

  Local 
Filesystems 

  Supported Supported 

  Device Files   Supported Supported 

 Performance 
Information 

IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 
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Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Used All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free% All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Growth Rate All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

Sub Network Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported 

  Subnet Mask All versions of 
Agent for RAID 
Map 

Supported Supported 

 Configuration 
Information 

Servers   Supported Supported 

  Local 
Filesystems 

  Supported Supported 

  Device Files   Supported Supported 
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Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

 Performance 
Information 

IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Used All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 
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Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

  Free All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free% All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Growth Rate All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

Server Basic 
Information 

Name All versions of 
Agent for Platform 
(Windows), All 
versions of Agent 
for Platform (Unix) 

Supported Supported 

  OS All versions of 
Agent for RAID 
Map 

Supported Supported 

  IP Address All versions of 
Agent for RAID 
Map 

Supported Supported 

 Configuration 
Information 

Local 
FileSystems 

  Supported Supported 

  Imported 
FileSystems 

  Not Supported 
(Always 0) 

Not Supported 
(Always 0) 

  Device Files   Supported Supported 

 Performance 
Information 

CPU Usage All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Memory All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 



292  Appendix A Tuning Manager Metrics and Restrictions 

Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

  IOPS  All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Used All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 



  HiCommand Tuning Manager User's Guide 293 

Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

  Free All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free% All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Growth rate All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Filesystem 
Over Capacity 

  Supported Supported 

Local 
FileSystem 

Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported 

  Filesystem 
Type 

  Supported 
(Always Win) 

Supported 
(Always Win) 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

 Configuration 
Information 

inodes All versions of 
Agent for Platform 
(Unix) 

Not Supported 
(Always n/a) 

Not Supported 
(Always n/a) 

  Volume All versions of 
Agent for Platform 
(Unix) 

Not Supported 
(Always n/a) 

Not Supported 
(Always n/a) 

  Disk Group All versions of 
Agent for RAID 
Map 

Supported Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Used All versions of 
Agent for Platform 
(Windows) 

Supported Supported 
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Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free%  All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Growth rate All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Over Capacity All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

Remote 
Filesystem 

Basic 
Information 

Name All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Type All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Used All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Free% All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Growth rate All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 
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Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

  Over Capacity   Not Applicable Not Applicable 

Device File Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported 

  Target All versions of 
Agent for RAID 
Map 

Supported Supported 

  LUN All versions of 
Agent for RAID 
Map 

Supported Supported 

  WWN Node All versions of 
Agent for RAID 
Map 

Supported Supported 

  WWN Port All versions of 
Agent for RAID 
Map 

Supported Supported 

 Configuration 
Information 

Filesystem All versions of 
Agent for RAID 
Map 

Supported Supported 

  Disk Group All versions of 
Agent for RAID 
Map 

Supported Supported 

  Product All versions of 
Agent for RAID 
Map 

Supported Supported 

  Vendor All versions of 
Agent for RAID 
Map 

Supported Supported 

  Serial Number All versions of 
Agent for RAID 
Map 

Supported Supported 

  Model All versions of 
Agent for RAID 
Map 

Supported Supported 

  Port All versions of 
Agent for RAID 
Map 

Supported Supported 

  Logical Disk All versions of 
Agent for RAID 
Map 

Supported Supported 

  RAID Level All versions of 
Agent for RAID 
Map 

Supported Supported 

  Array Group All versions of 
Agent for RAID 
Map 

Supported Supported 
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Resource Metrics Agent 
versionsNote  

Windows Windows IPF 

 Performance 
Information 

IO Response 
Time 

All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Historical 
Response 
Time 

 Supported Supported 

  Delta  Supported Supported 

  IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Supported Supported 

   All versions of 
Agent for Platform 
(Unix) 

Not Applicable Not Applicable 
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Table A.14 Server Resources and the Versions of Agents from which Information is Collected (HP-UX and 
Solaris) 

Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

Wholenet Basic 
Information 

Name   Supported Supported Supported 

 Configuration 
Information 

Servers   Supported Supported Supported 

  Local 
Filesystems 

  Supported Supported Supported 

  Device Files   Supported Supported Supported 

 Performance 
Information 

IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 
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Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free% All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth Rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

Sub Network Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Subnet Mask All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Configuration 
Information 

Servers   Supported Supported Supported 

  Local 
Filesystems 

  Supported Supported Supported 

  Device Files   Supported Supported Supported 

 Performance 
Information 

IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 



300  Appendix A Tuning Manager Metrics and Restrictions 

Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

  Free% All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth Rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

Server Basic 
Information 

Name All versions of 
Agent for Platform 
(Windows), All 
versions of Agent 
for Platform (Unix) 

Supported Supported Supported 

  OS All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  IP Address All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Configuration 
Information 

Local 
FileSystems 

  Supported Supported Supported 

  Imported 
FileSystems 

  Supported Supported Supported 

  Device Files   Supported Supported Supported 

 Performance 
Information 

CPU Usage All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Memory All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  IOPS  All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

  Free% All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Filesystem 
Over Capacity 

  Supported Supported Supported 

Local 
FileSystem 

Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Filesystem 
Type 

  Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

 Configuration 
Information 

inodes All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Volume All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Disk Group All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 
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Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free%  All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Over Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

Remote 
Filesystem 

Basic 
Information 

Name All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Type All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free% All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth rate All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Over Capacity   Supported Supported Supported 

Device File Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

  Target All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  LUN All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  WWN Node All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  WWN Port All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Configuration 
Information 

Filesystem All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Disk Group All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Product All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Vendor All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Serial Number All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Model All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Port All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Logical Disk All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  RAID Level All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Array Group All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Performance 
Information 

IO Response 
Time 

All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

HP-UX HP-UX IPF Solaris 

  Historical 
Response 
Time 

 Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

  Delta  Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

  IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Not 
Supported 
(Always 0) 

Supported 

Note: In blank columns, Tuning Manager displays calculation results or the result of setting 
fixed values. 
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Table A.15 Server Resources and the Versions of Agents from which Information is Collected (AIX and 
Linux) 

Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

Wholenet Basic 
Information 

Name   Supported Supported Supported 

 Configuration 
Information 

Servers   Supported Supported Supported 

  Local 
Filesystems 

  Supported Supported Supported 

  Device Files   Supported Supported Supported 

 Performance 
Information 

IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 



  HiCommand Tuning Manager User's Guide 307 

Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free% All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth Rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

Sub Network Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Subnet Mask All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Configuration 
Information 

Servers   Supported Supported Supported 

  Local 
Filesystems 

  Supported Supported Supported 

  Device Files   Supported Supported Supported 

 Performance 
Information 

IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

  Free% All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth Rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

Server Basic 
Information 

Name All versions of 
Agent for Platform 
(Windows), All 
versions of Agent 
for Platform (Unix) 

Supported Supported Supported 

  OS All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  IP Address All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Configuration 
Information 

Local 
FileSystems 

  Supported Supported Supported 

  Imported 
FileSystems 

  Supported Supported Supported 

  Device Files   Supported Supported Supported 

 Performance 
Information 

CPU Usage All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Memory All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  IOPS  All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

  Free% All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Filesystem 
Over Capacity 

  Supported Supported Supported 

Local 
FileSystem 

Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Filesystem 
Type 

  Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

 Configuration 
Information 

inodes All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Volume All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Disk Group All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 
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Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free%  All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth rate All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Over Capacity All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

Remote 
Filesystem 

Basic 
Information 

Name All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Type All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

 Capacity 
Information 

Capacity All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Used All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Free% All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Growth rate All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Over Capacity   Supported Supported Supported 

Device File Basic 
Information 

Name All versions of 
Agent for RAID 
Map 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

  Target All versions of 
Agent for RAID 
Map 

Not 
Supported 
(Always 0) 

Supported Supported 

  LUN All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  WWN Node All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  WWN Port All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Configuration 
Information 

Filesystem All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Disk Group All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Product All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Vendor All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Serial Number All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Model All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Port All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Logical Disk All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  RAID Level All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

  Array Group All versions of 
Agent for RAID 
Map 

Supported Supported Supported 

 Performance 
Information 

IO Response 
Time 

All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 
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Resource Metrics Agent 
versionsNote  

AIX Linux Linux IPF 

  Historical 
Response 
Time 

 Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

  Delta  Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

  IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Read IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Read Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

  Write IOPS All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Not 
Supported 
(Always 0) 

Supported Supported 

  Write Transfer All versions of 
Agent for Platform 
(Windows) 

Not 
Applicable 

Not 
Applicable 

Not 
Applicable 

   All versions of 
Agent for Platform 
(Unix) 

Supported Supported Supported 

Note: In blank columns, Tuning Manager displays calculation results or the result of setting 
fixed values. 
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A.2.3 Fabric Resources and the Versions of Agents from which Information is Collected 

Table A.16 describes the information about fabric resources and the versions of the Agents 
from which the information is collected. 

Table A.16 Fabric Resources and the Versions of Agents from which Information is Collected 

Resource Metrics Agent 
versionsNote  

Brocade® McDATA® 

Fabric Basic Information Name  Supported Supported 

 Configuration 
Information 

Fabrics 
 

Supported Supported 

  Switches  Supported Supported 

 Performance 
Information 

Received Bytes 
 

Supported Supported 

  Transferred 
Bytes  

Supported Supported 

  Received 
Frames  

Supported Supported 

  Transferred 
Frames  

Supported Supported 

Fabric instance Basic Information Name All versions of  
Agent for Switch 

Supported Supported 

 Configuration 
Information 

Switches All versions of  
Agent for Switch 

Supported Supported 

  Principal Switch All versions of  
Agent for Switch 

Supported Supported 

  Ports  Supported Supported 

 Performance 
Information 

Received Bytes 
 

Supported Supported 

  Transferred 
Bytes  

Supported Supported 

  Received 
Frames  

Supported Supported 

  Transferred 
Frames  

Supported Supported 

  Input Buffer Full  Supported Supported 

  Buffer Credit 
Zero State  

Supported Supported 

Switch Basic Information Name All versions of  
Agent for Switch 

Supported Supported 

  Model All versions of  
Agent for Switch 

Supported Supported 

  Vendor All versions of  
Agent for Switch 

Supported Supported 
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Resource Metrics Agent 
versionsNote  

Brocade® McDATA® 

  WWN All versions of  
Agent for Switch 

Supported Supported 

  Domain ID All versions of  
Agent for Switch 

Supported Supported 

 Configuration 
Information 

Ports All versions of  
Agent for Switch 

Supported Supported 

  Port Modules All versions of  
Agent for Switch 

Supported Supported 

 Performance 
Information 

Received Bytes All versions of  
Agent for Switch 

Supported Supported 

  Transferred 
Bytes 

All versions of  
Agent for Switch 

Supported Supported 

  Received 
Frames 

All versions of  
Agent for Switch 

Supported Supported 

  Transferred 
Frames 

All versions of  
Agent for Switch 

Supported Supported 

  Input Buffer Full All versions of  
Agent for Switch 

Supported Supported 

  Buffer Credit 
Zero State 

All versions of  
Agent for Switch 

Supported Supported 

Switch port Basic Information Display Name All versions of  
Agent for Switch 

Supported Supported 

  Port Module All versions of  
Agent for Switch 

Supported Supported 

  Parent Switch All versions of  
Agent for Switch 

Supported Supported 

  Port Number All versions of  
Agent for Switch 

Supported Supported 

  Port Type All versions of  
Agent for Switch 

Supported Supported 

  Port Speed All versions of  
Agent for Switch 

Supported Supported 

  Port WWN All versions of  
Agent for Switch 

Supported Supported 

 Performance 
Information 

Received Bytes All versions of  
Agent for Switch 

Supported Supported 

  Transferred 
Bytes 

All versions of  
Agent for Switch 

Supported Supported 

  Received 
Frames 

All versions of  
Agent for Switch 

Supported Supported 

  Transferred 
Frames 

All versions of  
Agent for Switch 

Supported Supported 
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Resource Metrics Agent 
versionsNote  

Brocade® McDATA® 

  Input Buffer Full All versions of  
Agent for Switch 

Supported Supported 

  Buffer Credit 
Zero State 

All versions of  
Agent for Switch 

Supported Supported 

Note :In blank columns, Tuning Manager displays calculation results or the result of setting 
fixed values. 

A.2.4 Oracle Resources and the Versions of Agents from which Information is Collected 

Table A.17 describes the information about Oracle resources and the versions of the Agents 
from which the information is collected. 

Table A.17 Oracle Resources and the Versions of Agents from which Information is Collected 

Resource Metrics Agent versionsNote  

Oracle instance Basic Information Name All versions of Agent for 
Oracle 

  Version All versions of  Agent for 
Oracle 

  Service ID All versions of  Agent for 
Oracle 

 Configuration Information Host All versions of  Agent for 
Oracle 

  Table Spaces  

  Data Files  

 Performance Information IOPS  

  Read IOPS  

  Write IOPS  

 Capacity Information Capacity  

  Used  

  Free  

  Free%  

  Growth rate  

TableSpace Basic Information Name All versions of  Agent for 
Oracle 

 Configuration Information Data Files  

  Rollback segments All versions of  Agent for 
Oracle 
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Resource Metrics Agent versionsNote  

  Sort segments All versions of  Agent for 
Oracle 

 Performance Information IOPS  

  Read IOPS  

  Write IOPS  

 Capacity Information Capacity All versions of  Agent for 
Oracle 

  Used All versions of  Agent for 
Oracle 

  Free All versions of  Agent for 
Oracle 

  Free%  

  Growth rate  

Data File Basic Information Name All versions of  Agent for 
Oracle 

 Performance Information IOPS All versions of  Agent for 
Oracle 

  Read IOPS All versions of  Agent for 
Oracle 

  Write IOPS All versions of  Agent for 
Oracle 

 Capacity Information Size All versions of  Agent for 
Oracle 

Note: In blank columns, Tuning Manager displays calculation results or the result of setting 
fixed values. 
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A.3 Agent Restrictions 

This section describes restrictions which apply to Agents when using Main Console. 

A.3.1 Managing Agents 

You cannot add, delete, or update Agents during Tuning Manager polling. Perform these 
operations after the polling has finished. 

Consult the system administrator for the polling schedule, interval, and period. 

A.3.2 Restrictions Regarding the Combination of Agents 

Depending on the combinations and versions of agents to be monitored, Tuning Manager might 
not be able to display parts of the information. Before operating Tuning Manager, see 
Appendix A.2 Metrics Displayed by Tuning Manager and the Versions of the Agents from Which 
Information Is Collected to check the restrictions regarding the combination of agents. 

A.3.3 When Agent for RAID Map and Agent for Platform Do Not Monitor the Server 

The following agents must be installed so that Tuning Manager can display server information: 

� Agent for RAID Map 

� Agent for Platform 

When Agent for RAID Map and Agent for Platform do not monitor the server, the following 
restrictions are applied to Tuning Manager: 

– In the Resource Tree, the network resources (Whole Network, Subnetwork, Server, 
Filesystems, and Device Files) are not displayed. 

– No information is displayed in List Connected Server in the Advanced Information 
section. 

– No information is displayed in the list of servers displayed by selecting Agent and 
Monitored Logical Disks in the Administrator view window. 
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A.3.4 When Agent for RAID (Earlier Than 4.1) Monitors Storage Subsystems 

Restrictions when Agent for RAID (earlier than 4.1) monitors storage subsystems: 

If TagmaStore AMS is monitored, Tuning Manager displays SLPR0 only. The ports, logical 
disks, and array groups that are included in TagmaStore AMS are displayed as child 
resources of SLPR0. In such a case, Tuning Manager does not display CLPR. 

Restrictions when Agent for RAID (earlier than 4.0) monitors storage subsystems: 

Tuning Manager displays n/a for the following information: 

– Port Speed (for storage subsystems) 

– I/O Response Time, Read I/O Response Time, and Write I/O Response Time (for logical 
disks) 

– I/O Usage and Max I/O Usage (for array groups) 

– Cache Memory Installed Size, Write Pending Rate, Max Write Pending Rate, Side File 
Usage, and Max Side File Usage (for subsystems) 

Restrictions when Agent for RAID (earlier than 3.5) monitors storage subsystems: 

– If TagmaStore USP is monitored, Tuning Manager displays SLPR0 only. The ports, 
logical disks, and array groups that are included in TagmaStore USP are displayed as 
child resources of SLPR0. In such a case, Tuning Manager does not display CLPR. 

Restrictions when Agent for RAID (earlier than 3.2) monitors storage subsystems: 

– The array group resources are not displayed under Subsystem in the Resource Tree. 

– The LUSE configuration information is not displayed. 

A.3.5 Monitoring of LDEVs Whose Logical Paths Are Not Set 

Main Console can display the information of LDEVs whose logical paths are not set only when (i) 
the version of Agent for RAID is 5.1 or later, and (ii) the settings for acquiring such information 
were specified during setup of the instance environment. 

For details on how to set up the instance environment of Agent for RAID, see the HiCommand 
Tuning Manager Installation Guide. 

A.3.6 Disk Performance Metrics Collected by Agent for Platform 

In a Windows 2000 environment where Agent for Platform is operating, the disk performance 
metrics for the disks whose disk names begin with Harddisk on the Windows 2000 
Performance Monitor are displayed as n/a on the Tuning Manager window. 
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A.4 Technical Support 

If you require support, please contact your administrator, first. Tuning Manager records 
extensive information in server-based logs. Your administrator may be able to identify further 
information related to your problem. 

If you are unable to obtain answers your questions or require further support, gather the 
following related information before contacting the Support Center: 

� Error code(s) and message(s) displayed in your browser 

� When possible capture relevant screens 

� Keep a record of actions leading to the error or unexpected event 
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Acronyms and Abbreviations 

ASCII American Standard Code for Information Interchange 

CLI Command Line Interface 
CLPR Cache Logical PaRtition 
CPU Central Processing Unit 
CRC Cyclic Redundancy Check 
CSV Comma Separated Values 

DDL Data Definition Language 

GUI Graphical User Interface 

HA High Availability 
HDU Hard Disk Unit 
HTM HiCommand Tuning Manager 
HTTP HyperText Transfer Protocol 

I/O Input/Output 
ICMP Internet Control Message Protocol 
ID identifier, identification 
IP Internet Protocol 
IPF Itanium® Processor Family 

LAN Local Area Network 
LDEV Logical Device Unit 
LUN logical unit number 
LUSE Logical Unit Size Expansion 

MB megabyte 
MIB Management Information Base 

NAS Network Attached Storage 
NFS Network File System 

OS Operating System 

RAID redundant array of inexpensive disks 

SAN Storage Area Network 
SLPR Storage Logical PaRtition 
SMTP Simple Mail Transfer Protocol 
SNMP Simple Network Management Protocol 
SQL structured query language 
SSO Single Sign On 
SVP SerVice Processor 

TCP transmission control protocol 
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UDP User Datagram Protocol 

WWN World Wide Name 
WWW World Wide Web 
XML Extensible Markup Language 
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Glossary 

Agent One of the Tuning Manager product programs. Agents collect and record 
information about system performance and system configuration. Agents 
are available to suit the system being monitored (for example, HTM Agent, 
Agent for RAID, and Agent for Oracle). 

Alarm The definition of system behavior when data reaches the threshold value 
Always Evaluated Alerts using this setting will continuously be monitoring the conditions you 

specify. 
Array Group RAID array. 
Array Groups RAID arrays. 
Average IOPS The mean value of all IOPS measures for the time period specified in the 

Report Window Setting window. 
Average Transfer The mean value of all Transfer measures for the time period specified in 

the Report Window Setting window. 

Bookmark A bookmark that you can use to register reports with specified report 
definitions, report display conditions, and target agents. You can use a 
bookmark to display reports in fewer steps and to simultaneously display 
reports for different agents and reports with different report definitions. 

Bookmarks Named links kept in Tuning Manager which you save for easy access to pages 
throughout the software. 

Buffer Credit Zero State Indicates that the receiving switch port is busy as a result of consuming all 
available buffer credits. Tuning Manager increments the count for each 
occurrence of this condition. 

Cache % The portion of cache capacity used. Presented as a percentage. (Cache 
Usage / Cache Capacity) * 100 

Cache Capacity The full size of the cache. 
Cache Free The portion of unused cache capacity. 
Cache Memory Installed 
Size 

The total amount of cache memory installed in the Thunder 9500V Series. 

Cache Usage The portion of cache capacity used. 
Capacity Total storage space. (This value is aggregated for all sub-resources below 

the level you have selected in Resource Tree.) 
Capacity Forecast Predicted future storage free space and usage. A Forecast uses historical 

data as a sample to anticipate future values. (This value is aggregated for 
all sub-resources below the level you have selected in Resource Tree.) 

Capacity History Total storage space over your specified time span. (This value is aggregated 
for all sub-resources below the level you have selected in Resource Tree.) 

CLPR CLPR (cache logical partition) functionality enables partitioning (splitting) 
of a cache. This functionality partitions (that is, splits) the cache by array 
groups in the storage subsystem, so that other array groups do not affect 
cache performance. 

CLPR Number A number assigned to the CLPR selected in the Resource Tree. 
Cluster system A cluster system links multiple server systems together and operates them 

as one system. In this manual, the term cluster system means an HA cluster 
system. 



326  Glossary 

Collection Interval Tuning Manager stores metrics values for these intervals: hourly (every 
hour), daily (every day), monthly (every month) and yearly (every year). 

Confidence Level The confidence level you select for a forecast determines how broad a 
charted region will be drawn between likely upper and lower bounds. At a 
0.95 confidence level, there is a 95% likelihood that the forecasted values 
will appear between the upper and lower error margins. (If you specify a 
0.99 confidence level, the resulting chart presents a broader region 
between the upper and lower error margins.) 

CPU Usage Percentage of total CPU capacity used. (This value is aggregated for all 
sub-resources below the level you have selected in Resource Tree.) 

Damping A technique to avoid excessive alerts. Tuning Manager only triggers an alert 
when a specified number of occurrences (Damping Occurrences) within the 
specified number of samples (Damping Interval). 

Damping Interval When you enable damping in alert monitoring, this value determines how 
many samples will be evaluated. If your specified number of Damping 
Occurrences is reached within the damping interval, an alert will be issued. 

Damping Occurrences If damping is enabled, the number of times an alert condition must be met 
before an alert is issued. These occurrences must all be contained within 
your specified Damping Interval. 

Data File A collection of data stored on media as a unit within the filesystem. 
Data Files Collections of data stored on media as a unit within the filesystem. (This 

value is aggregated for all sub-resources below the level you have selected 
in Resource Tree.) 

Data Point A value for a specific metric at a specific point in time. 
Data model Collective name for the records and fields of each Agent. The data model is 

managed by the version. 
Date The Record Time for the data currently displayed. 
Delimiter A character or symbol indicating the delimitation of data. 
Delta Displaying the difference between the values of the previously collected 

data and currently collected data for the performance data of a field is 
called delta. The data source of the field is the information which is 
managed as cumulative values. 
For example, suppose a field whose data source is a counter for I/O 
processing, where the counter value obtained during the first collection is 3 
and the counter value obtained during the second collection is 7. The 
output value of this field at the second collection is 7 (the counter value at 
the second collection) if the delta attribute is not applied to the field, or 4 
(the difference between the first value and the second value) if the delta 
attribute is applied to the field. 

DKCMAIN The version of microcode running on a 9900 or 9900V subsystem.  
Device File On systems running the UNIX operating system, a file with specifications for 

a physical device. A device file indicates the location, type and method of 
access to a physical device. 

Device Files The quantity of device files at this level of the resource tree. 
Disk Group A group of disks representing a single logical storage resource. 
Disk IOPS Input/Output operations per second at the disk level. 
Disk Random IOPS Random operations per second at the disk level. 
Disk Random Transfer Random transfer rate at the disk level. 
Disk Read IOPS Read operations per second at the disk level. 
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Disk Read Transfer The speed of data movement for read operations at the disk level. 
Disk Sequential IOPS Sequential operations per second at the disk level. 
Disk Sequential Transfer Sequential transfer rate at the disk level 
Disk Transfer The rate at which data is moved at the disk level. 
Disk Write IOPS Write operations per second at the disk level. 
Disk Write Transfer The rate of write data movement at the disk level. 
Domain ID A unique integer identifier distinguishing the pool of resources which can be 

accessed by a given switch. Each switch uses the Domain ID in combination 
with the WWN addresses of the various attached devices to properly route 
data across the entire storage area network. 

Drilldown report A report that is associated with another report or a field in a report. You 
use a drilldown report to display detailed or related information about a 
report. 

Executing node A logical (or “active”) node that is executing tasks in the server systems 
making up a cluster system. 

External Array Group An Array Group to which the Logical Disk, allocated to the TagmaStore USP 
as a Virtual Logical Disk, belongs. 

External Logical Disk A Logical Disk allocated to the TagmaStore USP as a Virtual Logical Disk. 
External Storage The name of a storage subsystem externally connected to the TagmaStore 

USP. The External Storage contains Logical Disks allocated to the 
TagmaStore USP as Virtual Logical Disks. 

Fabric A network of interconnected fibre channel switches and cabling ensuring 
that one or more switches can transmit data between any two ports. The 
typical fabric includes at least two switches to provide fault tolerance. 

Fabrics Multiple networks of interconnected fibre channel switches and cabling. 
Each fabric maintains independent routing of data. 

Failover The transfer of processing of the server executing tasks from the executing 
node to a standby node if a failure occurs in a cluster system. 

Field A performance data item; multiple fields constitute a record. 
Filesystem The name of a filesystem. A filesystem is the scheme defining logical 

structures and software routines used to control access to the storage on a 
hard disk system. (This value is aggregated for all sub-resources below the 
level you have selected in Resource Tree and averaged over the chosen 
time period. The result is displayed as an integer value. 

Filesystem Type The method used for storing and organizing data within a given operating 
system. (This value is aggregated for all sub-resources below the level you 
have selected in Resource Tree and averaged over the chosen time period. 
The result is displayed as an integer value. 

Filesystems The number of filesystems. A filesystem is the scheme defining logical 
structures and software routines used to control access to the storage on a 
hard disk system. (This value is aggregated for all sub-resources below the 
level you have selected in Resource Tree and averaged over the chosen 
time period. The result is displayed as an integer value. 

Filesystems Over Capacity Filesystems where usage exceeds a predetermined percentage threshold of 
used capacity. You set this threshold in the Profile section. (This value is 
aggregated for all sub-resources below the level you have selected in 
Resource Tree and averaged over the chosen time period. The result is 
displayed as an integer value. 
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Forecast Forecast reports depict linear and non-linear trends in time series and 
allow you to project (forecast) those data in to the future. The collection of 
data points used to make a forecast. At least 6 data points should be in the 
history to ensure meaningful forecasts. 

Forecast Horizon The number of data points to be forecasted, or the time span to be 
forecasted e.g.: 3 months, 5 days. The forecast horizon should not span 
more than 20% to 25% of the forecast history. (e.g.: If you have 12 monthly 
data points in your history, then your forecast horizon should be set no 
higher than 3 monthly data points. The data period is always the same for 
history and horizon. (If the history is made up of daily data points, then the 
periods used in the forecast are also daily.) 

Forecast Interval See Forecast Period. 
Forecast Period Defines the time between two forecasted data points. (e.g.: monthly, 

weekly, daily) 
Frame A packet of bytes sent to or received by a SAN switch port. (Typically 2048 

bytes.) 
Free The total available capacity. (This value is aggregated for all sub-resources 

below the level you have selected in Resource Tree.) 
Free % The percentage of free capacity as a percentage of all capacity. (This value 

is aggregated for all sub-resources below the level you have selected in 
Resource Tree.) 

Growth Rate The growth rate compares the current and previous capacity usage values 
within the collection interval currently set in your Report Window Setting 
window. (If the Time Interval setting in the Report Window Setting window 
is set to Hourly, the base value will be the Used measured in the previously 
collected hour. This will be compared to the current usage measure. 
Assuming that the current Time Interval setting in the Report Window 
Setting window is set to Hourly, the growth rate reported by Tuning 
Manager is the result of this formula: Assuming that the current Time 
Interval setting in the Report Window Setting window is set to Hourly, the 
growth rate reported by Tuning Manager is the result of this formula: 
(Current Hour Capacity - Previous Hour Capacity) / Previous Hour Capacity 
(This value is aggregated for all sub-resources below the level you have 
selected in Resource Tree.) 

HA cluster system A cluster system designed to provide high availability. The purpose of this 
system is to continue operation even if a failure occurs. If a failure occurs in 
the server executing tasks, a standby server immediately takes over and 
continues operation processes. This prevents operation interruption in case 
of a failure and thus ensures high availability. 

In this manual, the term “cluster system” means an HA cluster system. 
Historical report A report indicating the status of a program being monitored from a time in 

the recent past to the current time. Performance Reporter can display two 
types of historical reports: Historical report (single agent), Historical report 
(multi-agent). 

Historical Report Setting 
window 

Used to specify the date and time necessary for making a comparison with 
the I/O Response Time of the host and array, and a comparison with the 
average of past I/O Response Times. 

Historical Response Time The average I/O Response Time value. 
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Hit Ratio The number of cache hits transactions divided by the number of 
transactions.  

Host A TCP/IP-accessible computer (or entity) to which one or more storage 
subsystems are attached. In addition to its TCP/IP address, each host also 
has a name or alias. 

Host and array 
performance analysis 

A method of analyzing (based on the I/O Response Time) whether system 
performance deterioration is being caused by the host or by the array. 

Hosts Including its subnetworks and storage-related servers, the entire scope of 
resources available to Tuning Manager. 

Hosts Capacity Including its subnetworks and storage-related servers, the total storage 
space for all resources available to Tuning Manager. 

I/O Response Time The average response time for an I/O request. 
I/O Usage The percentage of time during which I/O occurred. 
Imported Filesystems The number of external filesystems mounted on a UNIX host or made 

accessible to a Windows operating systems via sharing. (This feature is not 
currently available when reporting on Windows hosts.) HiCommand Tuning 
Manager will display na. (This value is aggregated for all sub-resources 
below the level you have selected in Resource Tree and averaged over the 
chosen time period. The result is displayed as an integer value.) 

Information Frame The area in the Tuning Manager web client displaying data about the level 
you have chosen in Resource Tree. 

Inodes In UNIX filesystems, inodes contain critical information about a file's user 
and group ownership and access permissions. To find the inode number for 
a given UNIX file, use the command: ls -i. To determine the inode 
information for a given UNIX file, use the command: ls -l. (This value is 
aggregated for all sub-resources below the level you have selected in 
Resource Tree.) 

Input Buffer Full Indicates that a buffer for a switch port is full. Tuning Manager increments 
the count for each occurrence of this condition. 

Instance An allocated memory area known as the SystemGlobalArea and one or more 
Oracle processes. Every Oracle database must be associated with one 
Oracle instance. 

Instances See Oracle Instances. 
IOPS Input/Output operations per second. (This value is aggregated for all 

sub-resources below the level you have selected in Resource Tree.) Also see 
Read IOPS and Write IOPS. 

IP Address Internet Protocol. A multi segment address delimited by dots used to 
uniquely identify devices and hosts on a network. 

Last Record The date and time for the most recent polling period which is now saved in 
the application database. The last record time may not be the last polling 
period because processing is not complete. Polling may still be in progress, 
aggregation and updates may still be pending. 

LDEV A numbered component using a logical or physical connection to a host. 
Also see Logical Device. 

Local Filesystems The number of filesystems directly connected to a host computer. This 
value is aggregated for all sub-resources below the level you have selected 
in Resource Tree and averaged over the chosen time period. The result is 
displayed as an integer value. 
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Logical Device A numbered component using a logical or physical connection to a host. 
Each logical device has its own set of resources. (Also referred to as a 
Logical Disk.) 

Logical Devices Numbered components each using a logical or physical connection to a 
host. Each logical device has its own set of resources. (Also referred to as 
Logical Disks.) 

Logical Disk A series of drives (or drive partitions) linked in such a way that the 
operating system views the entirety as a single storage device. RAID 
controllers provide one form of managing logical disks while providing 
benefits in the form of improved reliability, data availability and 
performance. (Also known as: logical devices, logical drives, volumes, 
volume sets, logical storage units, logical units, units, and LUNS.) 

Logical Disks The quantity of logical disks in this subsystem. 
Logical host A logical server that provides an execution environment when Performance 

Reporter is running in a cluster system. If a failure occurs, the system 
switches over on a per-logical host basis. Logical hosts maintain a dedicated 
IP address. At failover, the new logical host continues operation by 
inheriting the same IP address. Therefore, even if the physical server 
changes due to a failure, clients can still access the new server using the 
same IP address, as if a single server were always running. 

Lower Error Margin Lower range of possible values within the current forecast Confidence 
Level. 

LUN Or Logical Unit. See Logical Disk 
LUSE Logical unit size expansion. 

Main Console One of the programs constituting the Tuning Manager products. The Main 
Console accumulates performance data collected by agents and enables 
the data to be displayed and analyzed with a Web browser. 

Margin Amount of deviation from the mean predicted value. 
Max I/O Usage The highest value of I/O Usage within the time period specified in the 

Report Window Setting window. (See Note) 
Max Side File Usage The highest value of Side File Usage within the time period specified in the 

Report Window Setting window. (See Note) 
Max Write Pending Rate The highest value of Write Pending Rate within the time period specified in 

the Report Window Setting window. (See Note) 
Maximum IOPS The highest value of all IOPS measures for the time period specified in the 

Report Window Setting window. 
Maximum Transfer The highest value of all Transfer measures for the time period specified in 

the Report Window Setting window. 
Memory Random Access Memory. 
MIB Management information base. A management information base is a 

description of network objects managed using the Simple Network 
Management Protocol. (Also see SNMP.) 

Minimum IOPS The minimum value of all IOPS measures for the time period specified in the 
Report Window Setting window. 

Minimum Transfer The minimum value of all Transfer measures for the time period specified 
in the Report Window Setting window. 

Model Product model number. 



  HiCommand Tuning Manager User's Guide 331 

Mountpoint Before a device is accessible (mounted) by UNIX, a directory must be 
specified as the logical location for that device. The mountpoint is a 
directory used for that purpose. Tuning Manager reports the number of 
mountpoints on the monitored whole network and its resources. (This value 
is aggregated for all sub-resources below the level you have selected in 
Resource Tree.) 

Navigation Frame The area in the Tuning Manager web client where you control what kinds of 
data will be displayed. The Navigation Frame includes Resource Tree and 
choices for editing your Profile and setting Bookmarks. 

Network The entire scope of resources available on Tuning Manager, including its 
subnetworks and storage-related servers. 

Node Each computer that belongs to a cluster system. 

Operating System The controlling software managing a computer's routing of storage, 
memory, display and peripheral devices. 

Oracle The relational database management system from Oracle Corporation. 
Oracle Capacity The total storage capacity allocated to Oracle. 
Oracle Instance An Oracle process. Every Oracle database must be associated with one 

Oracle instance. 
Oracle Instances One or more Oracle processes. Every Oracle database must be associated 

with one Oracle instance. 
Over Capacity See Filesystems Over Capacity. 

Performance The efficiency of input/output operations. 
Period Of Watching You set the daily time period when the alert conditions are being 

monitored. For the remainder of the day, that alert remains dormant. 
Port  (Storage) A logical connection to a disk array allowing multiple 

simultaneous read and write transactions. (Fabric) A logical connection to a 
Switch. 

Port IOPS Input/Output operations per second at the port, for the time period 
specified in the Report Window Setting window. 

Port Max IOPS The maximum value of all IOPS measures at the port, for the time period 
specified in the Report Window Setting window. (See Note) 

Port Max Transfer The maximum value of all Transfer measures at the port, for the time 
period specified in the Report Window Setting window. (See Note) 

Port Min IOPS The minimum value of all IOPS measures at the port, for the time period 
specified in the Report Window Setting window. (See Note) 

Port Min Transfer The minimum value of all Transfer measures at the port, for the time 
period specified in the Report Window Setting window. (See Note) 

Port Module Port module on the SAN switch. 
Port Modules Number of SAN switch port modules at the current resource level. 
Port Number Vendor's assigned identifier for the SAN switch port. 
Port Role Specified port type for the disk array device. 
Port Speed SAN switch port speed. (Normally 1 or 2 gigabit.) 
Port Transfer The rate at which data is moved at the port. 
Port Type Code for port type. (Typical values: E, F, G, H) 
Port WWN The unique address of a SAN switch port. 
Ports The number of logical connections to a subsystem. 
Principal Switch Every fabric contains one principal switch. 
Product The storage subsystem hosting the filesystem. 
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Product Detail record A type of record that stores performance data indicating the system status 
at a specific time, such as detailed information about currently active 
processes. You use PD records to obtain the system status at a specific 
time, such as operating status of the system or size of the file system 
currently in use. 

Product ID A byte identifier that indicates a Tuning Manager product; part of the 
service ID. 

Product Interval record A type of record that stores performance data taken at specific intervals, 
such as the number of processes per minute. You use PI records to analyze 
changes to or trends in the system status over time, such as: Change in the 
number of system calls issued over a specific period of time, Change in the 
size of the file system being used 

Product Log record A type of record that stores log information about the application or 
database being executed on an agent’s Solaris system. 

Profile Your user identity for Tuning Manager, login, email account. 

RAID Redundant Array of Independent Disks. An assemblage of two or more disk 
drives to improve fault tolerance and/or performance. 

RAID Group A logical volume consisting of an array of disk drives that uses ports in one 
or more multiples of 4 channels. Normally this array makes use of striping. 
This provides good load balancing with a high degree of data availability 

RAID Level Level of functionality for a RAID subsystem: Level 0: provides data striping 
(placing blocks of each file across multiple drives). This provides 
performance benefits but no redundancy. Level 1: provides mirroring 
where duplicate data is written redundantly to more than one drive. Level 
3: provides striping plus error correction. One drive is dedicated to storing 
error correction data. Level 5: provides byte-level data striping and also 
stripe error correction. 

Raw Devices Devices not allocated to a filesystem. 
Read Hit Ratio The number of transaction hits in the cache within the read transactions, 

divided by the number of read transactions. (When presented as a 
percentage, the resulting value is multiplied by 100.) 

Read I/O Response Time The average response time for a read request. 
Read IOPS Read operations per second. (This value is aggregated for all sub-resources 

below the level you have selected in Resource Tree.) 
Read Transfer The speed of data movement for read operations. 
Real-time report A report indicating the current status of a program being monitored. 
Received Bytes The quantity of bytes successfully passing through the receiving switch 

port. 
Received Frames The quantity of frames successfully passing through the receiving switch 

port. (Also see Frame). 
Record ID An ID used to identify each record of the Tuning Manager products. The 

record ID is used to specify a record in commands that are executed 
internally by the Tuning Manager. 

Record Taken The date and time for polling period currently display. 
Report Definitions for displaying performance data collected by an agent in a 

graphical format. A report is based mainly on definitions of the records to 
be displayed in the report, the performance data items to be displayed, and 
the performance data display format (such as table or graph). 
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Report Window Setting 
window 

Window to specify your time frame and interval: Time, Time interval. The 
settings specified in the Report Window Setting window yield data in Tuning 
Manager based upon: A point in time, Specify Last Record (default), or a 
date/time combination of your choice, and a specific reporting time 
interval. Your choices are hourly (default), daily, weekly, monthly, yearly. 

Resource Tree A hierarchical presentation of the storage-related and application-related 
resources monitored by Tuning Manager. Resource Tree appears within the 
Navigation Frame. 

Response Time The I/O Response Time for the time period specified in the Report Window 
Setting window. 

Rollback Segments The number of rollback segments within the tablespace(s). (This value is 
aggregated for all sub-resources below the level you have selected in 
Resource Tree.) 

Serial Number Identification code for hardware subsystem. 
Server Servers are storage-oriented hosts on a given network or subnetworks. The 

Servers metric displays the number of storage hosts at the level you have 
selected in Resource Tree. (This value is aggregated for all sub-resources 
below the level you have selected in Resource Tree and averaged over the 
chosen time period. The result is displayed as an integer value.) 

Servers Servers are storage-oriented hosts on a given network or subnetworks. The 
Servers metric displays the number of storage hosts at the level you have 
selected in Resource Tree. (This value is aggregated for all sub-resources 
below the level you have selected in Resource Tree and averaged over the 
chosen time period. The result is displayed as an integer value.) 

Service ID An ID that uniquely identifies each program of the Tuning Manager 
products. The service ID is used to specify a server in commands that are 
executed internally by the Tuning Manager. With Performance Reporter, 
the ID of an agent is specified in the command argument to display 
information relevant to that agent. For information about the service ID, 
see the applicable Agent manual. 

Session The period of interaction with the software beginning after each new login 
and ending when you logout. 

Side File The area that is temporarily allocated in the cache to store record sets 
generated during the asynchronous copying process. 

Side File Usage The percentage of data being used as a Side File in the cache. 
Single instance A record that contains only one instance that is to be evaluated. 
Size A measurement of disk capacity or disk space used by the listed resource. 

(Displayed data indicates the unit of measure employed.) 
SLPR SLPR (storage logical partition) functionality enables partitioning (splitting) 

of a storage subsystem. The functionality is supported by the TagmaStore 
USP. This functionality splits the resources (ports, CLPR, and volumes) in 
the storage subsystem, so that the user can manage each resource 
independently. 

SNMP Simple Network Management Protocol. A standard protocol with interfaces 
for managing and monitoring network resources. 

SNMP trap An event notification issued by an SNMP agent. 
Solution set A predefined report format provided for agents. Solution sets simplify the 

display of performance data collected by agents because they can be used 
without having to specify complex definitions. 
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Sort Segments The number of sort segments within the tablespace(s). (This value is 
aggregated for all sub-resources below the level you have selected in 
Resource Tree.) 

Standby node A node associated with each server system making up a cluster system that 
stands by to take over tasks if a failure occurs in the executing node. 

Storage Subsystem A physical device containing an array of disk drives acting as a single unit 
for the purposes of data storage and retrieval. 

Store database A database in which performance data collected by an agent is stored. 
There is one Store database for each agent. 

Subnet The name and/or IP range for a subnetwork (a subset of a larger network 
with its own IP range). 

Subnet Capacity Total storage capacity for a subnetwork. 
Subnet Capacity History Total storage capacity for a subnetwork for the time frame you specify. 
Subnet Mask A mask value used to obtain the network address of a subnet from an IP 

address. 
Subnetwork A subset of a larger network with its own IP range. 
Subsystem The storage subsystem monitored by Tuning Manager. 
Subsystems The number of storage subsystems monitored by Tuning Manager. 
Switch Vendor's identifier for the SAN switch. 
Switch WWN The unique address for a given switch. 
Switches The number of SAN switches at the current resource level. 

Tablespace A logical allocation of Oracle capacity dedicated to storing table data. 
Target The resource for which information is requested or has been gathered. 
Trace log Log information that is collected in case of an error to obtain the details of 

the error and the duration of the processing event. 
Transfer The rate at which data is moved. Also see Read Transfer and Write 

Transfer. 
Transferred Bytes The quantity of bytes successfully sent from a switch port. 
Transferred Frames The quantity of frames successfully sent from a switch port. (Also see 

Frame). 

Upper Error Margin Upper range of possible values within the current forecast Confidence 
Level. 

URL Uniform Resource Locator: the global address scheme for documents and 
other resources on the World Wide Web. 

Used The portion of capacity consumed. 

Vendor The manufacturer/source of the subsystem. 
Virtual Disk See Logical Disk 
Virtual Logical Disk A function that connects separate storage subsystems to the TagmaStore 

USP, in order to logically use their Logical Disks as the Logical Disk of the 
TagmaStore USP. This function manages Logical Disks in multiple storage 
subsystems as the Logical Disk that exists logically in a single storage 
subsystem. 

Volume Storage organized as either a subset of a single disk or spanning multiple 
disks. 

Whole Fabric Highest resource level in Tuning Manager depicting all fabrics in the SAN. 
(Equivalent to SAN Fabric.) Also see Fabric. 
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Write Hit Ratio The number of transaction hits in the cache within the write transactions, 
divided by the number of write transactions. (When presented as a 
percentage, the resulting value is multiplied by 100.) 

Write I/O Response Time The average response time for a write request. 
Write IOPS Write operations per second. (This value is aggregated for all sub-resources 

below the level you have selected in Resource Tree.) 
Write Pending Rate The percentage of data in the cache that is waiting to be written. 
Write Transfer The speed of data movement for write operations. 
WWN A 64-bit hexadecimal address (comprising 16 hexadecimal numbers) 

uniquely identifying devices on a storage area network. 
WWN Node A resource addressable by at least one unique WWN address. 
WWN Port A port on a WWN Node. 

Xfer Transfer rate 

Note: When HiCommand Tuning Manager presents maximum/minimum value for metrics of 
daily, weekly, monthly, quarterly, and yearly periods, the resultant values are the average of 
the total value (aggregate value) of hourly data. 
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